
Online Card Management Administration Guide 
 December 2017 

  



Contents 
Contents .......................................................................................................................................... 1 

About This Guide ......................................................................................................................... 10 

What is Online Card Management? ........................................................................................................... 10 
Using this guide with your Online Card Management application .............................................................. 10 
Who should read this guide? ..................................................................................................................... 10 
How this guide is organized ....................................................................................................................... 11 

Conventions used in this guide ............................................................................................... 11 
What is an administrator? .......................................................................................................................... 12 
Using online help to find information .......................................................................................................... 13 

Web browser requirements ..................................................................................................... 13 
To configure the Internet Explorer browser.......................................................................... 14 

Getting product support ........................................................................................................... 15 

Logging On and Self-Registering................................................................................................ 17 

To log on to Online Card Management ................................................................................... 17 
To change your password ................................................................................................... 18 
To edit your personal information ........................................................................................ 19 

Registering to use Online Card Management ......................................................................... 21 
To self-register your account ............................................................................................... 21 

To unlock your account or reset your password ...................................................................... 25 

Setting Up and Maintaining Sites ................................................................................................ 32 

Understanding real-time functionality ......................................................................................................... 32 
Searching for a site .................................................................................................................................... 33 

To search for a site .............................................................................................................. 33 
Maintaining a site ....................................................................................................................................... 34 

To access the Site Setup page ............................................................................................ 35 
To set site status ................................................................................................................. 35 
To specify general site information ...................................................................................... 35 
To manage Alerts for a site ................................................................................................. 37 
To manage account status codes for a site ......................................................................... 39 
To specify notification options.............................................................................................. 40 

Setting Self-Registration options for your site ......................................................................... 41 
To specify self-registration options for account holders ....................................................... 41 
To specify self-registration options for organization administrators ..................................... 42 

Selecting application modules ................................................................................................................... 43 

1 

 



Accounts module ................................................................................................................. 44 
Reports module ................................................................................................................... 46 
To manage individual bank retention settings...................................................................... 47 
Statements module .............................................................................................................. 48 
Expenses module ................................................................................................................ 50 
To specify country information ............................................................................................. 52 
To enable ACE option sets .................................................................................................. 53 
To enable account authorization option sets ....................................................................... 54 
To enable MCC groups ....................................................................................................... 55 
To specify Logon rules ........................................................................................................ 56 
To specify Logon PIN rules ................................................................................................. 58 
IP Validation ........................................................................................................................ 58 

Working with site templates .................................................................................................... 59 
Creating a new site template ............................................................................................... 59 
Creating a template from an existing site ............................................................................ 68 
Using a site template to create a site ................................................................................... 69 

Managing cycles for a site ....................................................................................................... 69 
To create a new cycle .......................................................................................................... 70 
To edit a cycle ..................................................................................................................... 71 

Working with user security profiles ............................................................................................................ 72 
Bank Administrator default privileges ...................................................................................... 73 
Bank Support User default privileges ...................................................................................... 77 
Organization Administrator default privileges .......................................................................... 80 
Organization Manager default privileges ................................................................................. 83 
Account Holder default privileges ............................................................................................ 85 
My Profile Access user default privileges ................................................................................ 87 
Defining custom security profiles ............................................................................................. 87 

To define a custom security profile ...................................................................................... 87 
To modify an existing security profile ................................................................................... 90 

Working with approval profiles ................................................................................................................... 92 
To create an approval profile ............................................................................................... 92 
To edit an approval profile ................................................................................................... 94 
To delete an approval profile ............................................................................................... 95 

Maintaining Home page message for a site ............................................................................................... 95 
To maintain site messages .................................................................................................. 96 
To work with existing messages .......................................................................................... 97 

Customizing and branding the site interface .............................................................................................. 98 
To customize the Online Card Management interface ......................................................... 98 

Working with email templates .................................................................................................................. 101 

2 

 



Understanding data tags ................................................................................................... 101 
To edit an email template .................................................................................................. 102 

Setting Up Allocation ................................................................................................................. 107 

Understanding system allocation ............................................................................................................. 107 
Setting up site allocation rules ................................................................................................................. 108 

To create a new allocation scheme ................................................................................... 108 
Defining fields and setting properties ....................................................................................................... 109 

To position fields and create labels ................................................................................... 109 
To select fields for display ................................................................................................. 112 
To assign properties .......................................................................................................... 113 

Creating and assigning valid codes ......................................................................................................... 115 
To create and edit valid codes ........................................................................................... 116 

Configuring allocation validation............................................................................................ 118 
To configure validation for a single account or unit ............................................................ 118 
To configure validation for multiple accounts or units ........................................................ 120 
To import valid codes from an external file ........................................................................ 121 

Working with default code import files ................................................................................... 124 
Formatting import files for account default allocation codes .............................................. 125 
Formatting import files for MCC default allocation codes................................................... 126 
Formatting import files for Point of Sales default allocation codes ..................................... 127 

Setting default allocations ........................................................................................................................ 128 
To establish default types .................................................................................................. 128 
To match types with fields ................................................................................................. 129 
To assign default field values ............................................................................................ 130 

Resuming the allocation setup process ................................................................................. 133 

Creating and Modifying Users ................................................................................................... 135 

Creating a user ........................................................................................................................................ 135 
Step 1: Enter basic information .......................................................................................... 136 
Step 2: Specify Location and Branding information ........................................................... 137 
Step 3: Create a valid user ID and password .................................................................... 138 
Step 4: Assign expense report approvers to the user ........................................................ 139 
Step 5: Specify user access permissions .......................................................................... 140 

Working with user access permissions .................................................................................................... 142 
To tailor individual permissions .......................................................................................... 143 
To add or modify access permissions ............................................................................... 145 

Searching for existing users ..................................................................................................................... 147 

3 

 



To search for a user .......................................................................................................... 147 
To use the Search Results list ........................................................................................... 148 
To emulate a user .............................................................................................................. 149 

Modifying a user ...................................................................................................................................... 149 
To modify user information ................................................................................................ 150 
To reset the user password and security questions ........................................................... 152 
To export user information from the Search Results list .................................................... 152 

Importing multiple users ........................................................................................................................... 152 
To import users into online card management ................................................................... 152 

Understanding user import files............................................................................................. 155 
Required fields for Cardholder import file .......................................................................... 156 
Required fields for Expense Approver import file ............................................................... 157 
Required fields for Organization Manager import file ......................................................... 158 

Using Online Statements ........................................................................................................... 161 

Managing your account............................................................................................................................ 161 
Viewing an account summary ............................................................................................... 161 

To view an account summary as an administrator ............................................................. 161 
To view the account summary for your account ................................................................ 162 

Viewing a transaction list ....................................................................................................... 163 
To view the transaction list as an administrator ................................................................. 163 
To view the transaction list as an account holder .............................................................. 164 

Viewing account statements .................................................................................................................... 165 
To select an account  to view statements .......................................................................... 166 
To search for statements ................................................................................................... 168 
To view, print, and download the statement ...................................................................... 170 

Viewing authorizations and declines ........................................................................................................ 171 
Searching  for authorizations and declines ........................................................................ 171 

Managing Accounts ................................................................................................................... 175 

Searching for accounts ............................................................................................................................ 175 
Searching without the wildcard character .......................................................................... 175 
To search for accounts ...................................................................................................... 177 
To export search results to a file ........................................................................................ 179 

Creating a new account or modifying account information ...................................................................... 180 
To create a new account ................................................................................................... 180 
To modify existing account information, or specify new account information ..................... 181 

Working with Temporary Credit Limit controls ......................................................................................... 193 

4 

 



Understanding Temporary Credit Limit status ....................................................................... 193 
Creating Temporary Credit Limit controls .............................................................................. 194 

To select an account for a new Temporary Credit Limit .................................................... 194 
To set Temporary Credit Limit controls for the selected account ....................................... 195 

Managing Temporary Credit Limit controls ........................................................................... 198 
To search for a Temporary Credit Limit control ................................................................. 198 
To resolve Temporary Credit Limit control problems ......................................................... 199 

Managing account transfers .................................................................................................. 200 
To transfer accounts between units ................................................................................... 201 

Managing program change requests ....................................................................................................... 204 
Program change requests and real-time update ................................................................... 205 
Searching for requests .......................................................................................................... 205 

To search for requests ....................................................................................................... 205 
Working with requests ........................................................................................................... 207 

To work with requests ........................................................................................................ 207 
To view notes and flag notes ............................................................................................. 211 

Maintaining Card Models ......................................................................................................................... 211 
To create a new card model .............................................................................................. 212 
To delete a card model ...................................................................................................... 213 
To change a card model's active status ............................................................................. 214 

Working with account alerts ..................................................................................................................... 214 
To activate alerts for accounts ........................................................................................... 214 
To select units for alerts .................................................................................................... 215 
To select accounts for alerts .............................................................................................. 216 

Using Reports ............................................................................................................................. 217 

Processor reports..................................................................................................................................... 217 
Understanding processor reports .......................................................................................... 217 
Searching for processor reports ............................................................................................ 217 

To search for reports ......................................................................................................... 218 
To view or download the full report .................................................................................... 220 
To view or print a specific page in the report ..................................................................... 220 

Maintaining report profiles for bank users ............................................................................. 221 
To create or modify a report profile .................................................................................... 221 
To assign reports to a report profile ................................................................................... 222 
To assign users to a report profile ..................................................................................... 223 
To assign report profiles to a user ..................................................................................... 224 

Managing reports as an administrator ................................................................................... 226 
Standard reports ...................................................................................................................................... 226 

5 

 



Understanding Standard Reports .......................................................................................... 226 
To select a report ............................................................................................................... 227 

Saving and downloading reports .............................................................................................................. 227 
To save a custom report .................................................................................................... 228 

Working with Mappers ............................................................................................................... 235 

Creating Mappers .................................................................................................................................... 235 
Creating mappers using the Data Mapping Tool ................................................................... 235 

To copy settings from an existing mapper ......................................................................... 236 
To enter general information for a new mapper ................................................................. 237 
To define a delimited mapper format ................................................................................. 240 
To define a fixed-length mapper format ............................................................................. 241 
To select mapper record type ............................................................................................ 242 
To define columns for mapper output file records .............................................................. 242 

Using Mappers in Online Card Management ........................................................................................... 244 
To run a mapper ................................................................................................................ 244 
To edit a mapper ............................................................................................................... 247 
To delete a mapper ........................................................................................................... 247 
To insert a field into a mapper ........................................................................................... 248 
To edit a field in a record ................................................................................................... 249 

Managing mappers as a bank administrator ............................................................................................ 251 
To create a mapper bundle ............................................................................................... 251 
To assign mappers to a bundle ......................................................................................... 253 
Assigning bundles to organizations ................................................................................... 254 
To assign individual mappers to organizations .................................................................. 257 
To view bundle and bank mapper assignment information ................................................ 258 

Scheduling Tasks ....................................................................................................................... 261 

Scheduling a report .................................................................................................................................. 261 
Creating a scheduled report in the Scheduler ....................................................................... 261 

To schedule a report in the Scheduler ............................................................................... 262 
Scheduling a saved or standard report ................................................................................. 265 

To schedule a report as you enter the report criteria ......................................................... 266 
Scheduling a mapper ............................................................................................................................... 267 

To schedule a mapper ....................................................................................................... 267 
Viewing scheduled task information ......................................................................................................... 272 

6 

 



To view the scheduled task calendar ................................................................................. 272 
Editing a scheduled report .................................................................................................... 272 

To modify a task schedule ................................................................................................. 273 
To delete a scheduled report ............................................................................................. 273 
To change task criteria for a scheduled task ..................................................................... 273 

Making payments online ............................................................................................................ 275 

Maintaining paying accounts .................................................................................................................... 275 
To create paying accounts ................................................................................................ 275 
To edit an existing paying account .................................................................................... 278 

Making a payment towards your account balance ................................................................................... 278 
To make a payment on your account ................................................................................ 279 
To make a payment on multiple accounts ......................................................................... 283 
Reviewing payment history ................................................................................................ 288 

Managing Transactions ............................................................................................................. 291 

Searching for transactions ....................................................................................................................... 291 
Selecting accounts or units ................................................................................................... 291 

Completing an advanced transaction search ..................................................................... 295 
MCC/Expense Type .......................................................................................................... 297 
Merchant Information ......................................................................................................... 298 
Amount .............................................................................................................................. 298 
Addendum Information ...................................................................................................... 299 
Allocation Information ........................................................................................................ 299 
Mapped Status .................................................................................................................. 300 

Working with transaction display formats ................................................................................................. 301 
To edit or create a display format ...................................................................................... 301 

Editing transactions.................................................................................................................................. 305 
To view transaction detail .................................................................................................. 305 

Working with automated allocation tasks ................................................................................................. 306 
Processor allocation .............................................................................................................. 306 
Online card management system allocation ......................................................................... 306 

Working with manual allocation tasks ...................................................................................................... 307 
To allocate a transaction ................................................................................................... 308 
To change allocation codes from the Search for Transactions page ................................. 308 
To lock or unlock a transaction .......................................................................................... 309 
To flag a transaction as disputed ....................................................................................... 310 
To change the status of a transaction ................................................................................ 311 

Splitting a Transaction ............................................................................................................................. 313 

7 

 



To split a transaction by amount ........................................................................................ 314 
To split a transaction by percent ........................................................................................ 315 
To split multiple transactions (completing a batch split) ..................................................... 316 
To split a single transaction by line item detail................................................................... 317 
To edit split information ..................................................................................................... 318 

Exporting transactions ............................................................................................................................. 319 
To export transactions ....................................................................................................... 319 

Using the Output Log ............................................................................................................................... 320 
To work with the Output Log .............................................................................................. 320 
To unmap transactions ...................................................................................................... 321 

Managing Expense Reports and Out-of-Pocket Transactions ............................................... 323 

Working with expense reports .................................................................................................................. 323 
Using the Home page to manage your expense reports ....................................................... 323 

Understanding the expense report approval process .............................................................................. 324 
Expense report status ........................................................................................................... 324 
Creating an expense report ................................................................................................... 325 

Step 1: Enter general expense report information ............................................................. 325 
Step 2: Attach transactions to an expense report .............................................................. 327 
Step 3: Create Out-of-Pocket transactions for the expense report .................................... 328 
Step 4: Attach Receipts ..................................................................................................... 330 
Step 5: Finalize the expense report ................................................................................... 332 

Managing expense reports .................................................................................................... 333 
Expense Reports tab ............................................................................................................. 333 

Expense Reports Tab – Unassigned section ..................................................................... 334 
Expense Reports Tab – In Progress section ..................................................................... 335 
To submit or delete multiple expense reports: ................................................................... 335 
Expense Report tab - Recently Approved section ............................................................. 335 
Expense Report tab - For Your Approval section (Approvers only) ................................... 336 

Unattached Transactions Tab ............................................................................................... 336 
To search for unattached transactions: ............................................................................. 336 

Working with Out-of-Pocket transactions ................................................................................................. 338 
Entering an Out-of-Pocket transaction .................................................................................. 338 

To select an account for an Out-of-Pocket transaction ...................................................... 338 
To create a Lodging, Transportation, and Other Out-of-Pocket transaction ...................... 341 
To create a Meal Out-of-Pocket transaction ...................................................................... 341 
To create a Personal Mileage Out-of-Pocket transaction .................................................. 342 

Understanding the Hierarchy .................................................................................................... 343 

Sample hierarchy ..................................................................................................................................... 343 

8 

 



Using the Online Card Management hierarchy ........................................................................................ 344 
Understanding hierarchy terminology ...................................................................................................... 345 

Index ............................................................................................................................................ 347 

9 

 



About This Guide 
This guide is intended for Bank Administrators. This guide describes card management features and provides 
procedures for setting up and managing accounts, users, sites, and system settings. 
 

What is Online Card Management? 
Online Card Management provides you and your account holders with a high level of self-service, flexibility, and 
convenience for managing commercial card data. Your system centralizes commercial card administration in a single 
easy-to-use browser-based application. This allows your users and card account holders to use their Web browsers to 
check statements, view account statements, submit expense reports, update personal information, and make 
payments toward their card balance. 
As the Online Card Management administrator, you are the person responsible for many of Online Card 
Management's core functions. Administrators can manage individual user accounts, individual credit card accounts, 
and site administration and options. Online Card Management also includes a variety sophisticated financial 
management tools, such as diversion accounts, custom mapper creation tools, and a variety of standard reports. 
 

Using this guide with your Online Card Management application 
Online Card Management is modular and customizable. This means that the options available to you may vary 
depending on which functional modules are have activated, the way your site receives data, and the customizations 
made to your site. As a result, the figures and data provided in this guide will not match exactly the pages you see 
when you work in Online Card Management and may include instructions for functionality that is not available to your 
users.  
 

Who should read this guide? 
This guide is intended for system users that perform administrative tasks. Administrators perform many different tasks 
ranging from system-specific duties such as maintaining user information to setting up accounting practices such as 
allocation or setting up account cycles. This guide is written for system users that are familiar with the use of Internet 
browser-based applications, as well as procedures for their individual organizations. 
The card management system lets users assign specific responsibilities to administration personnel for custom 
management. Online Card Management contains default administrator types, each with a list of specific tasks and 
permissions. Administrator types are described in detail in "Working with user security profiles (see topic on page 72). 
All tasks for the different types of administrators are discussed in this guide. The default administrator security profiles 
can also be customized to include or exclude specific tasks and permissions according to the needs of the 
organization. 
Often administrators are also Online Card Management cardholders. When administrators perform cardholder tasks, 
they should refer to the Online Help rather than this document. The Online Help contains specific step-by-step 
instructions for all system tasks for administrators and cardholders. 
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How this guide is organized 

This guide includes the following sections: 

• Logging On and Self-Registering (see topic on page 17) 
• Setting Up and Maintaining Sites (see topic on page 27)  
• Setting Up Allocation (see topic on page 106)  
• Creating and Modifying Users (see topic on page 135) 
• Using Online Statements (see topic on page 161) 
• Managing Accounts (see topic on page 175) 
• Using Reports (see topic on page 217) 
• Working with Mappers (see topic on page 235) 
• Scheduling Tasks (see topic on page 261)  
• Making Payments Online (see topic on page 275) 
• Managing Transactions (see topic on page 290) 
• Managing Expense Reports and Out of Pocket Transactions (see topic on page 323) 
• Understanding the Hierarchy (see topic on page 343) 

The guide also includes an index. 

Conventions used in this guide 
The following typographical conventions are used in this guide. Learning these conventions will help increase your 
understanding of the information provided. 

Convention Purpose Examples 

Bold type Indicates the name of a 
button or a field. 

• Click the Go button. 

• Enter your first and last name in 
the Full Name field. 

Italic type Indicates the name of a 
menu or menu item. 

From the Reports menu, select Output 
Log. 

Right angle bracket (>) Indicates a menu and sub-
menu selection sequence. 

From the menu, select Accounts > 
Manage Temporary Credit Limits. 

Bold & Italic type Indicates custom text on 
the application that is 
specific to a site, 
organization, or user. This 
customization means the 
document does not reflect 
the exact text of the 
application. The 
placeholder text is inside 

• The Maintain Messages for [Site 
Name] page displays. 

• A message displays saying 'The 
report will be saved for [N] days' 
(Where N is the number of days 
you specified in the Report Options 
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Convention Purpose Examples 
square brackets [ ] to 
further indicate that it is 
representative of a different 
actual value. 
When the value of the 
placeholder text is not 
clear, an explanation will 
follow the example. 

settings) 

ALL CAPITAL 
LETTERS 

Indicates text that you 
should enter exactly as 
displayed 

Enter 'WWW.TSYSISOLUTIONS.COM' 
in the Address field. 

 
 

What is an administrator? 
Online Card Management requires you to maintain two categories of administrator duties, both of which play critical 
roles in the success of Online Card Management deployment and use. The same person can fill both administrative 
roles, or you can split the administrative duties between different Online Card Management users. 
System Administrator 
The first function of an administrator is as a system administrator. Online Card Management is easy enough to use 
that the system administrator does not need any technical skills beyond the ability to use Internet Explorer and basic 
computer use skills. This includes the following tasks: 

• Setting up and maintaining your site or sites 
• Creating, editing, and importing basic user information and user logon IDs 
• Managing the user import process 
• Maintaining security profiles and individual permissions 
• Customizing the look and feel of the Online Card Management interface 
• Managing the organizational hierarchy 
• Maintaining messages posted to the users on the Online Card Management Home page 

Tip: You can delegate these duties across more than one administrator. 
Account Administrator 
The second category of administrator is more concerned with financial accounting than the day to day operation of 
Online Card Management. This administrator may or may not be the same person as the system administrator. This 
administrator should be familiar with an organization's accounting system, allocation procedures, card accounts, 
expense report approval procedures, and the organization hierarchy. The duties of this administrator include but are 
not limited to the following: 

• Setting up allocation rules 
• Creating custom reports 
• Scheduling reports 

12 

 



• Creating mappers to export data to your accounting system 
• Managing the organization hierarchy 
• Setting up approval process for expense reports 

 

Using online help to find information 
Online Card Management contains a complete help system. The online help is the best place to quickly locate and 
find information about the application. The help is available to all users who have logged on to Online Card 
Management. There is also help for users attempting to log on to the application. 
To access online help, select Help On This Page from the Help menu. Information relevant to the page you are 
currently using displays, as well as the Table of Contents, an Index, and a Search function to help you find information 
in the Help topics. 
Note: The online help documents all of the possible functionality, which may include functionality that is unavailable to 
you and your users. 
In addition the step-by-step instructions provided in the online help, there are Information icons throughout Online 
Card Management. For brief information about the field or button next to the icon, hover your cursor over the icon for a 
moment, and the information displays. You do not have to click the icon to view the text. Information icons display on 
the page, next to fields, buttons or page banners. 

Information icons are indicated by the  icon. 
 

Web browser requirements 
Online Card Management is designed for use with Microsoft® Internet Explorer version 11, Firefox 410, and Google 
Chrome 45. 
To function properly, Online Card Management requires specific browser Security and Advanced/Java settings. 
Security settings are required for ActiveX controls and scripting. Advanced/Java settings are required for the Java 
virtual machine. 
The following topic describes how to configure your Internet Explorer browser. 
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To configure the Internet Explorer browser 
1. From the Internet Explorer Tools menu, choose Internet Options. The Internet Options tab sheet displays. 

 
Figure 1: Internet Options tab sheet 

2. Click the Security tab. 

3. In the Select a Web content zones section, click the  icon. 
4. In the Security Level for this Zone section, click Custom Level.... The Security Settings  

dialog displays. 
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Figure 2: Internet Explorer Security Settings dialog 

5. For ActiveX controls and plug-ins settings, verify that: 
• The Download Signed ActiveX Controls option is set to Prompt. 
• The Run ActiveX Controls and Plug-ins option is set to Enable. 
• The Script ActiveX Controls Marked Safe for Scripting option is set to Enable. 

6. Scroll down and locate the Scripting settings in the list, and verify that: 
• The Active Scripting option is set to Enable. 
• The Allows Paste Operations Via Scripting option is set to Enable. 
• The Scripting of Java Applets option is set to Enable. 

7. Click OK to return to the Internet Options dialog. 
8. Click OK to return to the browser page. 
9. When you have returned to your browser page, press F12 (function key 12) on your keyboard. The F12 tools 

section displays at the bottom of your browser page. 

 
10. Click the Browser Mode selection on the toolbar and verify that Internet Explorer is not in Compatibility View. 

 
11. Press F12 to exit F12 tools. 

 

Getting product support 
If you need support to complete your card management tasks, you can contact your administrator by email. From the 
Help menu, select Product Support. The Product Support page displays providing contact information for product 
support. 
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Logging On and Self-Registering 
The Home page displays when you first logon to Online Card Management. Unless otherwise noted, all tasks 
described in this guide begin from the Home page. Access the Logon page using your organization URL address, 
enter your user ID and password, and the Home page displays. See your administrator for the URL address you use 
for the Logon page, as well as for information about your user ID and password. 
Because this is an Internet browser-based application, you must have Internet Explorer installed on your computer. 
You use the browser to access the Home page and all card management functions. 
This chapter describes the following tasks: 

• Logging on to Online Card Management (see topic on page 17) 
• Self-registering to use Online Card Management as an account holder (see topic on page 21) 
• Self-registering to use Online Card Management as an organization administrator (see topic on page 25) 
• Adding an account after logging on (see topic on page 25) 
• Retrieving a forgotten password (see topic on page 25) 
• Changing your password (see topic on page 18) 
• Editing your user profile (see topic on page 19) 
• Unlocking or resetting your password (see topic on page 25) 

 

To log on to Online Card Management 
From your organization Logon page, you can log on to Online Card Management, self-register to use the application 
(if allowed for your organization), or have your password hint emailed to you. 

1. Open your browser 
2. Enter the logon URL for your organization in the Address field and press Enter. The Logon page displays in 

the browser page. 

 
Figure 3: Logon page 

Tip: Create a favorite or bookmark shortcut in your browser so that you can access the logon page without 
entering the URL. 
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3. Enter your user ID and password in the appropriate fields. 
Note: If you forgot your User ID, click the Forgot your User ID link, specify your email address and answer the 

security question in subsequent pages, and a link to your User ID will be emailed to you. 
4. Click Log on. One of the following occurs: 

• The Home page displays— 
The Home page displays after entering your user ID and password and the security software has not 
flagged your logon attempt as a risk. 

• The Additional Security Information page displays— 
The Additional Security Information page displays if you have not specified your additional security 
information. This occurs when you are logging on to Online Card Management for the first time. 

• The Verification page displays— 
The Verification page displays if you have specified your additional security questions and the security 
software has determined that your logon attempt constitutes a risk. 

 
Figure 4: Home page 

To change your password 
You can change your user password from the Home page. Click the arrow icon ( ) next to your username in the 
upper right corner of the Home page to display a drop-down list. 
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Figure 5: Home page with Edit Password link 

1. From the Home page, click the Edit Password. The Edit Password page displays. 

 
Figure 6: Edit Password page 

2. In the Old Password field, enter your existing password. 
3. In the New Password field, enter the new password you want to use according to the password 

requirements for your organization. Passwords are case-sensitive. 

Important: Your password is subject to certain restrictions which are set by your organization. Hover your 
cursor over the information icon ( ) to see these restrictions. 

4. In the Confirm New Password field, enter the password exactly as in the 
New Password field. 
Note: If there is any difference between the New Password and Confirm New Password fields, including 
capitalization differences, you must re-enter the new password information. 

5. In the Password Hint field, enter a hint that will help you remember your password. You can request to 
receive this hint in an email if you forget your password.  
Important: The system will not allow you to embed your password in the Password Hint field. 

6. Click Save. Online Card Management activates your new password. Use your new password the next time 
you log on to the application. 

 

To edit your personal information 
You can change your personal information from the Home page. Click the arrow icon ( ) next to your username in 
the upper right corner of the Home page to display a drop-down list. 
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Figure 7: Home page with Edit Personal Information link 

1. From the Home page, click the Edit Personal Information link. The Edit Personal Information page displays, 
showing your existing personal information. 
. 

 
Figure 8: Edit Personal Information page 
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2. Type your first and last name in the corresponding First name and Last name fields.  
3. Enter the email address or addresses to which you want notifications sent. You can enter multiple email 

addresses if you separate each addresses with a semicolon (;). 
For example: 
jdoe@bigcompany.com;john_doe@myhome.org 

4. Enter the CC email address if desired. Notifications will also be sent to this email address. This field is not 
required. 

5. Click Save to save your new profile information. A confirmation page displays informing you of the change. 
 

Registering to use Online Card Management 
To use Online Card Management, you must have a user profile set up or you can self-register if you are the account 
holder. You can click the Not Registered link on the Logon page to self-register. If you are a new user, see your 
administrator about setting up a user profile. 
There are two different self-registration procedures. Account holders should use the account self-registration process. 
Organization administrators who are in charge of managing accounts should use the organization administrator self-
registration process. 
 

To self-register your account 
You may already have a card account, but not yet be registered to manage your account through Online Card 
Management. In this case, you can self-register by supplying personal and card information and creating a user ID 
and password. 

1. Open your browser and access your organization's Logon page.  
 

 
Figure 9: Click the Not Registered? link 
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2. Click the Not registered? link on the log on page. The Provide Account Number page displays. 
 

 
Figure 10: Provide Account Number 

3. Type the 16 digit account number embossed on your card and click Next. The Create a user ID and 
password page displays. 
Note: If the account number you enter in step 3 is a corporate account, you will be self-registered as an 
organization administrator. 

 

 
Figure 11: Account Holder self-registration 

3. Complete the following fields in the Registration page: 
Create a user ID and password 
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• Your email address 
Enter your email address in the Your email address field. Email notification messages are sent to this 
address. You can specify more than one address. Separate multiple addresses with semicolons, for 
example: jdoe@bigcompany.com;john_doe@myhome.org 

• Confirm your email address 
Enter your email address a second time exactly as you entered it in the Your email address field. If 
there is a difference between the Your email address and the Confirm your email address fields 
(including capitalization), an error message displays and you have to re-enter the addresses. 

• First name 
Enter your first name, without punctuation, in the First Name field. 

• Last name 
Enter your last name, without punctuation, in the Last Name field. 

• Create a user ID 
Create a user ID for yourself according to the user ID requirements for your organization.  
Tip: Hold your cursor over the  icon to see the user ID rules for your site. 

• Enter a password 
Create a password for yourself according to the password requirements for your organization.  
Tip: Hold your cursor over the  icon to see the password rules for your site. 

• Re-enter password 
Enter the password a second time exactly as you entered it in the previous password field. If there is a 
difference between the Enter a password field and the Re-enter a Password field (including 
capitalization), an error message displays and you have to re-enter the password. 

• Your password hint 
Enter a hint that helps you remember your password. If your organization is set up for email notification, 
this hint can be sent to you in an email message when you forget your password. 

4. Click Next. The Register Account page displays. 
Register an existing account 

• Account number 
Enter the 16-digit number of your existing account. This number is embossed on your card. 

• Name on account 
Enter the name on your account, as it displays on the card. 

• Other fields 
Your organization may require you to supply other card account information, such as card expiration 
date, birth date, employee ID, or Social Security or other identifying number. 
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5. Click Next. A confirmation page displays.. 

 
Figure 12: Account registration confirmation 

6. Select your statement delivery preference from the list. Depemding on your organization set up, this control 
may not display. 

7. Click Next. The Setup Security Information page displays. 
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Figure 13: Personal security questions 

 
8. Select a question from the first list, then enter and re-enter your answer. The answers should be known only 

to you. During subsequent logon verifications, one or more of these questions could be asked. You verify 
your identity by providing the personal answer. When you have completed all question/answer sets, click 
Submit. The End User License Agreement (EULA) page displays. 

9. After reading the EULA, scroll to the bottom of the license agreement, and click Agree, Disagree, or Print. 
When you click Agree, your organization's Home page displays, and you can perform your online account 
management tasks. The End User License agreement page does not display again after you click Agree. 

 

 

To unlock your account or reset your password 
If three consecutive, unsuccessful attempts are made to log on to the card management system, your account is 
locked. You can unlock your user record and also reset your password using the following procedures. 
Unlocking your account 

1. Access the logon page. 

 
Figure 14: Logon page 

 
2. Click the Reset Logon credentials? link. The Confirm your account information page displays. 

 
Figure 15: Confirm your account information 
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3. Type your user name and email address in the appropriate fields. Once your account information is 
confirmed, you will receive an instructional email at the email address on file for your user ID. Follow the link 
to complete the rest process. 

4. Answer the pre-set security questions. Click Continue. 

 
Figure 16: Security Questions 

5. Create a new passworrd and password hint. Click Save. 

 
Figure 17: Password and Password Hint 

6. A confirmaion message will display verifying your password has been changed. Click OK to be taken to the 
CentreSuite home page. 

 
Figure 18: Password Confirmation 

Forgot your password? 
1. Access the logon page 
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Figure 19: Logon page 

2. Click either of the Forgot your password? links. The Confirm your account information page displays. 

 
Figure 20: Forgot your password page 

3. Type your user name and email address in the appropriate fields. Once your account information is 
confirmed, you will receive an instructional email at the email address on file for your user ID. Follow the link 
to complete the rest process. 

4. Answer the pre-set security questions. Click Continue. 

 
Figure 21: Security Questions 

5. Create a new password and password hint. Click Save. 

 
Figure 22: Password and Password Hint 
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6. A confirmaion message will display verifying your password has been changed. Click OK to be taken to the 
CentreSuite home page. 

 
Figure 23: Password Confirmation 

 

To view or change your PIN 

If the View Personal Identification Number (PIN) functionality is activated for your site you see a Manage PIN link in 
the View Account Details section. You click this link and supply additional security information to view or change your 
PIN online. Use the following procedure to view or change your PIN. 

 

Figure 24: View Account Details 

1. Click on Manage PIN to expand options. Depending on the options enabled by their organization, you may 
see View PIN, Change PIN, or both, based on the options enabled by the organization.  
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Figure 25: View Account Details 

a. Click Change PIN to customize the PIN for the account.  
• You will be prompted to answer security questions. You will have the opportunity to enter 

the correct answer three times before being locked out of the site. Click Continue. 
 

 

Figure 26: Additional Security Information 

• Enter your full 16 digit account number in the Account Number field. 
• Enter your account name in the Name on Account field. 
• Select the account expiration month and year from the Expiration Date drop-down lists. 

The page displays four masked fields. 
• Click Continue. 
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Figure 27: Maintain Pin Authorization 

•  Enter 4-digit PIN in the New PIN field, then re-enter the same 4-digit PIN in the Re-Type 
PIN field.  

 
Figure 28: Maintain pin Authorization, page 2 

• Click Save to return to your Home page. 

 
Figure 29: Confirmation message on the Home Page 

b. Click the View PIN link. An additional security information page displays. 
• Two of your security questions display. Type the answers to these questions and click 

Continue. The View PIN Authorization page displays. 
• Enter your full 16 digit account number in the Account Number field. 
• Enter your account name in the Name on Account field. 
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• Select the account expiration month and year from the Expiration Date drop-down lists. 
The page displays four masked fields. 

Important: You must enter the correct information. The system will automatically log you off after three failed 
attempts. 

• Click each field. That PIN digit displays for a brief time. You can view only one PIN digit at 
a time. 

• When you have viewed all four PIN digits click Done to return to your Home page. 
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Setting Up and Maintaining Sites 
A site is a bank or an organization under the bank in the hierarchy. Each sites is assigned to the hierarchy. The site's 
position on the hierarchy determines who has administrative control of a site. Site administrators can work with site 
data for site at or below their hierarchy assignment. The hierarchy is described in "Understanding the hierarchy (See 
"Understanding hierarchy terminology" on page 345). Bank administrators set up organization sites under the bank so 
that the organization administrator or other users can use online functions. 
You can maintain the news and information messages that are displayed on the Home page for the site.You can also 
customize the Home page and the site interface. 
This section includes the following topics: 

• Understanding real-time functionality (see topic on page 32) 
• Searching for a site (see topic on page 33) 
• Maintaining a site (see topic on page 34) 
• Working with site templates (see topic on page 59) 
• Managing cycles for a site (see topic on page 69) 
• Working with user security profiles (see topic on page 72) 
• Working with approval profiles (see topic on page 92) 
• Uploading accounts to a site (see topic on page 92) 
• Maintaining site Home page messages (see topic on page 95) 
• Customizing and branding the site interface (see topic on page 98) 
• Working with email templates (see topic on page 101) 

 

Understanding real-time functionality 
The online card management application behaves differently depending on whether or not you choose to activate real-
time processing. As the name suggests, if you activate real-time processing Online Card Management shows 
transactions, account modifications and other activities as they occur. This feature enhances your reporting capability 
and gives you immediate control over account information. 
Real-time data processing is activated at the site level. You can turn real-time processing on or off for different 
modules in Online Card Management. For example, you can use real-time processing for accounts but not for 
transactions. If a site uses real-time processing, the site's users can view changes to account information they occur. 
If you choose not to activate real-time functionality, transactions, account modifications, and other types of information 
are updated during the nightly data imports. 
Online Card Management indicates when a field is updateable in real-time by shading the field in yellow. 

 
Figure 30: Real-time field example 
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Searching for a site 
Administrators with access to more than one site, must select the site they want to work with before they can change a 
site's settings. The Online Card Management security only allows administrators to search for sites attached to their 
user IDs.  
If you only have access to a single site, you do not need to select a site to perform any  
administration procedure.proca 
 

To search for a site 
Note: If your user ID is only associated with a single site, you do not have to select a site to change the site 
information and the Search for Site page does not display. 

1. Select Administration >Set Up Sites from the menu. The Search for Site page displays. 

 
Figure 31: Search for Site page 

2. Select a search option from the Search using list: 
• Site Name: Search by the name of the site. 
• Site Number: Search by the site number (bank number or corporate ID number). 
• Bank Number: Search by the bank number of the bank that this site is associated with. 

3. In the Search for field, enter the search value to match the search option you selected, or leave the field 
blank to list all sites: 

• Name: Enter all or part of the site name for which you are searching. You can use an asterisk (*) as a 
leading or trailing wild card character in partial searches. 

• Site Number or Bank Number: Enter all or part of the bank number, or all or part of the corporate ID 
number. Asterisks as leading or trailing wildcard characters are allowed. 

Tip: To view a list of all sites available to your user ID, leave the Search for field blank. 
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4. Click Search. A Search Results list containing a list of sites matching the search criteria displays and sorts 
the results by bank number. 

 
Figure 32: Search for Site- results 

By default, the search results sort by bank number. You can choose to sort the search results by any column 
in the table by clicking the column heading. 

Note: The sample search shown above includes only two sites in the Search Results list. Searches may 
return many sites. 

5. Click the link in the Site Name column for the site you want to edit. 
 

Maintaining a site 
As an administrator for a site or multiple sites, you can enable or disable the site and set options for the site. Only 
users who have security permissions to set up banks or organizations can perform these tasks. To access the site 
maintenance utilities, open the Administration menu, select Set Up Sites > Set Up Site. 
Organization site settings depend on the options selected for the bank with which the organization is associated. Each 
organization site inherits its bank's settings. You can maintain site news and information, and customize the site 
interface. For information about these tasks, see "Maintaining site Home page messages (See "To maintain site 
messages" on page 96), and "Customizing and branding the site interface (See "To customize the Online Card 
Management interface" on page 98). 
The following options are available for you to maintain your site: 

• Status (see topic on page 35) 
• General site information (see topic on page 35) 
• Modules (see topic on page 43) 
 Accounts (see topic on page 43) 
 Reports (see topic on page 46) 
 Statements (see topic on page 48) 
 Expenses (see topic on page 50) 

• Countries (see topic on page 52) 
• ACE Option Sets (see topic on page 53) 
• Account authorization option sets (see topic on page 53) 
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• MCC groups (see topic on page 55) 
• Logon rules (see topic on page 56) 
• Logon PIN rules (see topic on page 58) 
• Notification options (see topic on page 59) 
• Self-registration options (see topic on page 41) 

Note: Your site may not include all of these modules, depending on Online Card Management's site configurations 
you inherit from your hierarchy. 
Important: Click Save before leaving the Site Setup page if you want to keep the changes you made. If you click 
Select Different Site before saving changes, the changes will be lost. 
 

To access the Site Setup page 
The Site Setup page contains settings for the sites you maintain. To access the Site Setup page: 

1. Search for the site (see topic on page 33) you want to maintain. 
2. Click the link with the site name in the Search Results list. The Site Setup page for the selected site displays. 

 
 

To set site status 
You can activate or deactivate a site and site logons from the Status section of the Site Setup page. 

 
Figure 33: Site Setup- Status options 

 
Select any of the following options: 
Activate 

• Site 
Select to enable this site. Clear the box to stop data processing and prevent user access to this site. The 
Modified value is updated to show the date this option was last changed. 

• Logons 
Select to let users log on to this site. Clear the box to prevent all users from accessing Online Card 
Management. 

• Real-time Processing 
Select to enable real-time processing for the site. See “Understanding real-time functionality on page 32. 

To specify general site information  
In the General Information section of the Site Setup page, set up the general site options. 
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Note: Depending on how your organization is set up, not all fields may display on your page. 

 
Figure 34: Site Setup- General Information settings 

 
• Support contacts 
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 Support Email 
Enter the email address to which this site's users can send support questions. This is the email 
address shown when the user chooses Email Support from the Help menu. Online Card 
Management validates the address to make sure it is in a correct email format (for example, 
someone@somewhere.com). 
Note: This field allows only one email address. 

 Support phone 
Enter the phone number for this site's support help desk. 
 

• URL extension 
Enter the URL extension that creates a custom URL for this site. The extension is appended to the 
following address: https://www.centresuite.com/centre?[extension]  
Just enter the extension in this field, do not the entire address. Talk to your administrator for information 
about the extension. 

• Notification Email 
Enter the email address which will function as the “From” email when an email notification is sent from 
the Online Card Management system.  
 

• File Date Format 
Select the format you want to use throughout Online Card Management. For example, if you select 
English (United States) all dates will follow the mm/dd/yyyy format. 
 

• Multifactor Authentication 
Select the level of multifactor authentication for the site UK only). US sites are Level 1 by default.  

• Settlement Currency 
From the drop down list, choose which currency by which statements will be settled. 

 
• Manage Alerts 

Select the Active Alerts to select alerts available for the site and specify trigger parameters for certain 
alerts  
 

To manage Alerts for a site 
Alerts notify site users by email when specified events occur. You can enable or disable specific alerts for a site from 
the Site Settings page. When you choose to enable an alert, this allows users to choose to receive the alert. Enabling 
the alert does not activate the alert, the account holder must choose to subscribe to the alert. Use the following 
procedure to work with alerts. 
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1. From the General Information section of the Site Setup page (see topic on page 35), click the Manage Alerts 
link. The Manage Alerts page displays. 

 
Figure 35: Manage Alerts page 

2. Select the Activate Alerts check box to enable alerts for this site. 
3. Select one or more options from the Account past due check box. The user will receive an email alert when 

the account is past due for any of the selected times.  
4. Select the Payment due check box to send an email when a payment on the account is due in ten days 
5. Select the Current balance approaching credit limit check box if you want Online Card Management to 

alert account holders when their account balances near their account credit limits. The Calculate by fields 
activate. 
Set the criteria you want to use to trigger the credit limit alert by selecting one of the following Calculate by 
options: 

• If you want to use a specific amount to trigger this alert, select the Amount within option and enter the 
amount in the field provided.  
For example, if you want the alert to trigger when an account holder has $500 remaining under his or her 
line of credit select this option and enter '500' in the field provided. 

• If you want to use a percentage of the credit limit to trigger this alert, select the Percentage within 
option and enter the desired percentage in the field provided.  
For example, if you want the alert to trigger when an account holder is within 5% of his or her line of 
credit select this option and enter '5' in the field provided. 

38 

 



 

6. Select the Exceeds credit limit check box if you want Online Card Management to alert account holders 
when they have exceeded their account limits. 

7. Select the Transaction equal to or above amount check box to send an email when a transaction is posted 
that equals or exceeds the single transaction amount specified for the account. 

8. Selections will be saved when you click Save on the General Information tab of the Site Setup page. 
 
Manage Client Product Codes (link) 
Click this link to open the Manage Client Product Codes page. You enable and set the default client product codes for 
the site here. (TS2 only) 
 
Manage Account Status Codes (link) 
Click this link to open the Manage Account Status Codes page. You specify which account codes prevent logons and 
self-registrations here. 

To manage account status codes for a site 
As part of the site setup, you can choose which account status codes you want to use for this site. You can also 
specify certain account status codes you want to prevent from logging on or registering to use the site. 
Complete the following to configure the account status codes for your site. 

1. From the General Information section of the Site Setup page (see topic on page 35), click the Manage 
Account Status Codes link. The Manage Account Status Codes page displays. 

 
Figure 36: Manage Account Status Codes page 
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2. Select Enable for the account status codes you want to use. Yes will display if the status code is enabled 
and No will display if the status code is not enabled. 

3. In the Description field, enter a brief explanation of the status code and it's purpose. 
4. Select Inactive to mark the code as inactive. This is useful for limiting the number of codes returned from 

searches. The status change will take effect after the next nightly processing. Yes will display if the status 
code is inactive and No will display i the status code is not inactive. 

5. Select Prevent Logon to prevent accounts with this status code from logging on to the system.   
6. Select Prevent Self-registration to prevent accounts with this status code from self-registering.  
7. Click Save. Online Card Management saves the alert settings. 
Note: For TS1 clients only, when enabling an inactive account, the account status change will require overnight 
processing. Otherwise, account status code changes occur in real-time. 
8. When you have configured the account status codes for this site, click Back to Site Setup to continue the 

site setup process.  
 

To specify notification options 
Informational email messages can be sent to users in response to a password hint request, new user creation, or 
password change. Use the email notification options to choose the events that cause Online Card Management to 
send email notifications to users. A user's email address is specified in the user profile. See "Modifying a user (on 
page 149) for more information. 

 
Figure 37: Site Setup- Notifications options 

Select the appropriate check boxes to choose an event that will send an informational email to the user from the 
following options: 
• Password hint- When a user requests a password hint 
• New User Information- When a user is added to Online Card Management with the user import functionality 
• Passwords that have been reset- When a user's password is reset 
• Logon PIN's that have been reset- When a user's PIN is reset 

If you do not select any check boxes, no email notifications are sent to users for this site. 
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Setting Self-Registration options for your site 
If you have a custom URL set up, individual account holders and organization administrators for a site can to self-
register. That is, users can create their own user records and gain access to Online Card Management. You can 
require users who self-register to supply up to three information items (in addition to account number), or none of the 
items From the Site Setup page, you can specify the information that you want to require of both account holders and 
organization administrators when they create their own Online Card Management users.  
 

To specify self-registration options for account holders 
The Cardholder Registration options for self-registration let you specify the information that you require for a 
successful account holder self-registration.  

 
Figure 38: Site setup- Self-registration options 

Select the Activate self-registration lockout to prevent users from self-registering if they enter incorrect information 
on three attempts to self-register. 
In the Required Fields option, select the options you require people to enter as they self-register to use the site: 
• Account number: The user's actual account number that he or she wants to track with Online Card 

Management 
Note: This is a required field. All self-registering users must enter a valid account number. 

• Expiration date: The user's account expiration date 
• Name on account: The user's name, as it displays on the card 
• Employee ID: The user's employee ID 
• Employee ID custom label: The label that displays on the self-registration page for the Employee ID field 

Note: This field is optional. If this field is empty and you select the Employee ID check box, the field displays as 
"Employee ID" on the self-registration page. 
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• Social Security Number: The user's Social Security Number or other ID number used when registering or 
adding  
an account 

The following self-registration options are also available: 
• Custom label (optional): Custom field label (for example, "ID Number") that displays in the system wherever 

the Social Security Number field displays 
Note: This field is available only if you also select the Social Security Number check box. 

• Date of Birth: Require the account holder to enter his birth date to self-register 
• Credit Limit: Require the account holder to enter the credit limit for his account to self-register 
• Security profile: Default security profile to assign to users when they self-register and when a new user is 

created for the site 
 

To specify self-registration options for organization administrators 
The Administrator Registration options for self-registration let you specify the information that you require for a 
successful organization administrator self-registration. You can specify as many as eight different criteria. It is 
recommended that you specify at least three. 

 
Figure 39: Administrator Registration options 

Select the Activate checkbox to allow organization administrators to register for the site. 
In the Required Fields option, select the options you require people to enter as they self-register to use the site: 
• Corporate account number 

The user's actual account number that he or she wants to track with Online Card Management. 
Note: This is a required field. All self-registering organization administrators must enter a valid corporate 
account number. 
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• Corporate ID: The corporate ID number provided to the administrator by his or her customer  
service representative. 

• Name on Account: The name listed on the organization administrator's account. 
• Postal\Zip Code: The organization administrator's mailing zip or postal code as listed his or her account. 
• Corporate employee ID: The label that displays on the self-registration page for the Employee ID field. 
• Corporate employee ID custom label: This field lets you customize the label for the Corporate employee ID 

field on the self-registration. This field is optional but using it could eliminate confusion during the self-
registration process if the organization refers to the Employee ID by a different name, such as "Member 
Number". 

• Corporate phone number: The organization administrator's phone number. 
• Security profile: Default security profile to assign to organization administrators when they self-register and 

when a new user is created for the site. 

 
 

Selecting application modules 
Module options display in the Modules tab of the Site Setup page. Use these options to activate the individual 
modules for a site. Bank-level administrators can set these options only for sites under their bank. They cannot 
change option for their own banks. To activate bank-level modules, contact an administrator with the rights to activate 
these site options. 
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Accounts module 
From the Accounts module section of the Set Up Site page, select the Activate check box to allow the site's 
users to access the account creation and maintenance features. 
 

 
Figure 40: Site setup- Account module options 

9. Select the Accounts module options that apply to the site: 
Note: The options that display in the Accounts module activation settings depend on the data source used by 
your site. The Accounts module options may look different from the one in the example provided in this 
document. 

Some or all of the following options display in Account module activation settings: 

Data retention (mos.) 
Specify a whole number greater than zero to show the number of months that program change request (PCR) data 
continues to be available. Retention period is typically six months. 
Real-time access 
• View: View most recent account information. 
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• Update: View and update most recent account information. 
• None: Prevent real-time access to account information. Account information displayed may be up to 24 hours 

old. 

Real-time new cards 
Select Yes to allow the organization to create new cards in real time 
 
Enable Real-Time Temporary credit limit controls 
Select Yes to allow the organization change credit limits for specified time periods in real time. 

• Change account status during TCL: The default is Yes. When the option is No, the system will not 
change the account status when a TCL is requested. 
 

View authorizations requests 
Select Yes to view authorization and decline information. 
 
Enable Transfer Accounts 
Select Yes to allow transfers between accounts. 
 
Allow account status search 
Select Yes to allow users to search for accounts using account status as search criteria. 
 
Enable Temporary Suspend Status 
Select Yes to allow administrators to temporarily suspend an account. 
 
Manage Account Status Codes 
Click this link to open the Manage Account Status Codes page. You specify which account codes prevent logons 
and self-registrations here. 
Enable Rush Card 
Select Yes to allow users to request a card to be sent rush delivery. 
 
PIN Management 
Allow accountholder to view PIN online 
Select Yes to allow users retrieve their PIN online. 
Allow accountholder to maintain PIN online 
Select Yes to allow users retrieve their PIN online. 
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Using real-time functionality for accounts 
Activating real-time functionality for accounts lets you use Online Card Management to view account information, card 
information, and temporary credit limits in real-time. You can enable or disable site access to these real-time functions 
individually. 
 

Reports module 
1. From the Reports module section, select the Activate check box to give this site's users access to processor 

reports. 

 
Figure 41: Site Setup- Report module options 

2. Select the Reports options that apply to this site. 
Note: The options that display in the Reports module activation settings depend on the data source used by 
your site. The Reports module options may look different from the one in the example provided in this 
document.  
Some or all of the following options display in Reports module activation settings: 

 

Enable Bank  reports 
Select Yes to access processor reports for the site. 
 
Data retention (mos.) 
Enter a whole number greater than zero to show the number of months that processor report data continues to be 
available. This is a required field. Retention period is typically six months. 
 
Report retention and archive settings 
Click the Manage individual bank report retention settings link to set the bank report retention times. 
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Archival for bank reports 
Enter a whole number. This represents the number of megabytes of archive storage available under the terms of the 
license agreement. 

To manage individual bank retention settings 
You set data archive retention times for reports and mappers on this page. If you access this page at the bank level, 
you set the retention times for bank (TBR) reports. If you access this page at the site level, you set the retention times 
for that site's standard reports and mappers. 
 
If you want to change the default settings for bank reports, type a whole number between 1 and 84 in the Retention 
Times field and click Save. This is the number of months you want that report be retained in the archive. If you want to 
set the retention time for all reports, type a number in the Data retention field located in the page header and click Set 
All and then Save. The retention time is set for all reports. 
 
If you want to change the retention time settings for a site's standard reports and mappers, type a whole number 
between 1 and 84 in the Retention Times field and click Save. If you want to set the retention time for all reports and 
mappers, type a number in the Data retention field located in the page header and click Set All and then Save. The 
retention time is set for all reports and mappers. 
 

 
Figure 42: Setup Report Archive Settings page 
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Statements module 
1. From the Statements module section, select the Activate check box to provide the site's users access to 

processor-generated statements and real-time transactions. 

 
Figure 43: Site Setup- Statements module option 

2. Select the following Statements options: 
Note: The options that display in the Statements module activation settings depend on the data source used 
by your site. The Statements module options may look different from the one in the example provided in this 
document. 

Some or all of the following options display in Statements module activation settings: 
 

Enable Real-Time Transactions 
Select Yes to allow users to view real time transactions for this site. 
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Enable Available to Spend with Pad 
 
 
Select Yes to allow users to spend with pad. 
 
Make payments 
Unavailable if Bank Payment in the Status section is not selected. 
Select Yes to allow users to submit payments online. 
 
Payment options 
Select to pay through checking/savings account or debit card. You can require 3D Secure registeration by selecting 
Yes under the option. 
 
Online payment options displayed. You must select at least one payment type. These options are all unavailable if you 
choose to disable the Make Payments statement option. Select one type as the Default. 
• Statement balance: Users can choose to pay the full statement balance. 
• Minimum balance: Users can choose pay the statement minimum payment. 
• Current balance: Users can choose to pay the current statement balance. 
• Other amount: Users can choose to pay an amount of their choice, as long as it is more than the minimum 

balance. 

Email notification 
Events that cause an email notification to be sent to user email address in the user profile. Select Yes to enable 
statement availability and send an email when a new statement is available online. 
 
Data retention (mos.) 
Enter a whole number greater than zero to show the number of months that statement data continues to be available. 
Retention period is typically six months. This is a required field. 
 
View authorization requests 
Select Yes to include authorization and decline information in statements. 
 
Statement Options 
You can choose the statement delivery options for your site users. Seet one of the following options: 

• Set account to receive electronic statements - all electronic statements are sent to the account. 

• Allow user to select statement options - the user can set which statements to receive. If you select 
Allow user to select statement options, the new users can choose their statement delivery method 
when they self-register. See "Registering to use Online Card Management (on page 21) for more 
information on self-registering. 
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• No change (from bank level settings)  
 

Expenses module 
From the Expenses module select the Activate check box, to provide the site's users access to transaction module 
options. 

 
Figure 44: Site Setup- Expense module options 

Note: The options that display in the Expenses module activation settings depend on the data source used by your 
site. The Expenses module options may look different from the one in the example provided in this document. Some 
or all of the following options display in Expenses module activation settings: 
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Allocation Values 
Select one of the options for handling allocation when transactions are imported: 
• Always use processor default allocation: When transactions are imported, the default allocations assigned 

by the processor are retained. 
• Start with processor default allocation: When transactions are imported, site allocations are applied after 

default allocations assigned by the processor. 
• Ignore processor default allocation: When transactions are imported, the processor-assigned allocations are 

ignored and site allocations are applied. 

 
Enable Edit Transactions 
Select Yes to allow users to split transactions and edit allocation codes. The following option will activate after 
enabling: 

• Enable Validation – Select this option to allow users to route expense reports for approval. 
• Require Transaction Description - Select this option to require users to enter a brief explanation for all 

transactions. 
If you select No, the site allows users to search and view transactions.  
 
Enable Expense Routing 
Select Yes to activate Expense Routing for this site. The following activates: 
Require Out-of-Pocket Notes 
Select this check box to require users to enter a description and other information regarding out-of-pocket expenses. 
Choose Out-of-pocket post date option.  

• Set post date to system date when transaction created 

• Set post dateequal to date occurred 
Required fields for meal expenses 
• Attendees: Select this check box to require users to list the attendees for meal  

out-of-pocket expenses. 
• Purpose: Select this to require users to enter an explanation of meal out-of-pocket  

expenses' purpose. 
Enable Receipts: Select to enable receipts to be added to expense reports. 

 
Maintain mileage reimbursements rates (link) 

 
Email Notification 
Select Yes to allow email notification to approvers that expense reports that require their attention have been 
submitted. Expense report originators will receive email notification of closed and rejected expense reports. 
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Maintain mileage reimbursement rates 
Click this link to work with the site's mileage reimbursement rates in the Maintain Mileage Rates page. 
 
Report Bar Code 
Select Yes to print a bar code on the site's expense report PDF files. This option lets you scan the bar code on the 
printed expense report. 
 
Data retention (mos.) 
Enter a whole number greater than zero to show the number of months that travel and entertainment data continues to 
be available. Retention period is typically six months. This field is unavailable if you did not enable Travel and 
Entertainment expenses. 
 

Account Reference Tables modules 
 
 

To specify country information 
Bank administrators use this section to enable country values for each site. This controls which countries users can 
work with as they manage accounts in the card management application. 

 
Figure 45: Site Setup- Country code options 

To enable a country for this site, select the box in the Enable column. You must designate one of the countries as the 
default country for this site in the Default column. The codes for the United States, Canada and the United Kingdom 
display at the top of the list. The rest of the country codes are listed alphabetically. 
Tip: Enter a code in the Go to code field and click the Go button to find a country in the Country Codes list. 
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To enable ACE option sets 
The Bank Administrator uses this section to enable Account Credit Evaluation (ACE) Option Set codes for each site. 
ACE Option Sets set credit parameters for cards. They act as a model for a card's credit limit rules. You assign ACE 
Option set codes to new cards, and the cards take on the credit limits associated with that option set. From the Site 
Setup page, you can enable Ace Option Set codes and select one as ACE Option Set as the default for new cards. 
Note: This section only displays on the Site Setup page if your site's data source is TS2. If your site uses TS1 data 
source, card specify each credit parameter individually. 

 
Figure 46: Site Setup- Ace Option Sets 

To enable an ACE Option Set code for this site, select the check box in the Enable column, and supply a short 
description of the code in the Description column. You can select an ACE Option Set as the default for the site by 
selecting the Default option. 
Tip: Enter the a code in the Go to code field and click the Go button to find a country in the Ace Option Sets list. 
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To enable account authorization option sets 
The Bank Administrator uses this section to enable account authorization option sets for each site, and supply a 
description of each option set. This section is only displayed when the site's data source is TS2 and the Accounts 
module is enabled. 
 

 
Figure 47: Account authorization option sets 

To enable an option set for this site, select the check box in the Enable column, and supply a short description of the 
option set in the Description column. You can specify one of the option sets to be the default, in the Default column. 
Use the Go to code field and Go button to search for an option set in the Account Authorization Option Set Codes list. 
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To enable MCC groups 
The bank administrator uses this section to enable MCC groups for each site, and to supply a description of each 
MCC group. 
 

 
Figure 48: Site Setup- MCC Group codes 

To enable an MCC group for this site, select the check box in the Enable column, and supply a short description of the 
MCC group in the Description column. 
Tip: Enter the a code in the Go to code field and click the Go button to find a country in the MCC Groups list. 
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To specify Logon rules 
If you have a custom URL set up, you can set rules for all user IDs and user passwords. You can designate the 
minimum and maximum user ID length. To increase security, you can require users IDs and passwords to have at 
least one lowercase letter, uppercase letter, numeral, or special character.  

 
Figure 49: Site Setup- Logon rules 

Specify the following user ID options: 
• Minimum length 

Minimum number of characters allowed in a user ID. Select a value from 6-25. 
• Maximum length 

Maximum number of characters allowed in a user ID. Select a value from 6-25. The maximum length must be 
equal to or greater than the minimum length. 

• Must contain 
Select the check boxes to require that the user ID to contain at least one of the  
following characters: 
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• Lowercase letter 
• Uppercase letter 
• Numeral (0-9) 
• Special character (non-alphanumeric) 

Note: User IDs cannot contain single quotes ', double quotes ", slashes \, back slashes /, pound signs #, 
percent signs %, asterisks *, brackets [  ], or spaces. 

In the Password section of the Site Setup page, specify the following options: 
• Expiration (days)  

Enter the number of days a password is valid before the user must enter a new password to reset it. 
Note: This value can be up to 365, if the site uses Logon PINs. 

• Notification (days)  
Enter the number of days before the password expires to begin notifying the user that his or her password is 
expiring. Enter 0 (zero) if you do not want to notify the user. 

• Minimum length 
Minimum number of characters allowed in a password. Select a value between 7 and 25 from this list. 

• Maximum length 
Maximum number of characters allowed in a password. Select a value between 7 and 25 from this list.  
Note: The value selected in the Maximum Length list must be equal to or greater than the value you selected 
in the Minimum Length list. 

• Must contain 
Select at least three of the following check boxes to require that passwords contain at least one of the following: 

Lowercase letter 
Uppercase letter 
Numeral (0-9) 
Special character (non-alphanumeric) 

Note: Passwords cannot contain single quotes ', double quotes ", slashes \, back slashes /, pound signs #, 
percent signs %, asterisks *, brackets [  ], or spaces. 
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To specify Logon PIN rules 
If you have a custom URL, you can require users to specify a PIN when they logon to Online Card Management. You 
also have the ability to choose characteristics of the PIN. 

 
Figure 50: Site Setup- Logon PIN options 

In the Logon PIN rules section of the Site Setup page, specify the following options: 
• Require a Logon PIN entry 

Select this check box if you want the site to use Logon PINs in addition to User ID and Password to enhance 
logon security. 

Note: If you select this check box, you can extend the user password expiration period can to 365 days. 

• Logon PIN length 
From this list, select the number of digits that. 

• Enforce random digit selection 
Select this check box if you want the site to require users to enter random digits to log on to Online Card 
Management. 

• Number of random digits 
From this list, select the number of digits from their PIN that you want the users to enter. 

 

IP Validation 
Bank level only - Select IP Validation and then specify an IP range in the text field below (for example: 10.20.30.100-
10.20.30.150).  All bank level and corporate level administrators with IP addresses within this range will be allowed to 
log on to the system. 
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Figure 51: Site Setup- IP validations 
 
 
 

Working with site templates 
Site templates let you quickly create new sites with pre-specified site settings. The settings saved in the site templates 
are applied to the sites you create using the template. Once you have created the site, you can change the site 
settings without making changes to the template. You can create multiple templates if you need to create several 
different styles of sites.  
The following procedures explain how you can create a site template and how to create new sites from a template. 
 

Creating a new site template 
Use the Manage Site Templates page to create new site templates. The Template Details are divided into seven 
different tabs which break the site settings into logical groups. If your organization does not use all of the Online Card 
Management modules, you will only see the tabs that apply to the modules you have activated. Complete the following 
procedure to create a new site template. 

1. Select Administration>Set Up Sites > Manage Templates from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site (See "To search for a site" on page 33) for which you are creating site templates. Click the Edit link 
to view the Manage Site Templates page. 

• If you have access to only one site, the Manage Site Template page displays. 

 
Figure 52: Manage Site Templates page 
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2. Click Create Site Template. The Template Details section displays the  
General Info tab. 

 
Figure 53: Site Template- General Info tab 
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3. Enter the basic site information for this template on the General Info tab. See "To specify general site 
information (See "To specify general site information (bank)" on page 35) for detailed information on these 
fields. 

4. Click the Logon Info tab. 
 

 
Figure 54: Site Template- Logon Info tab 
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5. Enter the user ID and password rules for this template on the Logon Info tab. See "To specify user ID rules 
(See "To specify Logon rules" on page 56) and "To specify password rules" for detailed information on these 
fields. 

6. Click the Modules tab. Four card management modules (or applications) are available: Module options are 
displayed on the Modules tab of the Site Setup page. Use these options to activate the individual modules for 
this site. Bank-level administrators can set these options only for their organizations, and not for their own 
banks. Contact an administrator to activate bank-level modules.  

7. Expand the Accounts module section. 
Note: This tab is only available if your bank has activated the Accounts module. 

 
Figure 55: Site Template- Modules tab, Accounts module 
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8. Enter the Accounts module options for this template on the Accounts tab. See "Accounts Module (on page 
42) for detailed information on these fields. 

9. Expand the Reports module section.  
Note: This tab is only available if your bank has activated the Reports module.

 
Figure 56: Site Template- Modules tab, Report Module 

63 

 



 

10. Enter the Reports module options for the template on the Reports tab. See "Reports Module (on page 46) for 
detailed information on these fields. 

11. Expand the Statements module section. 
Note: This tab is only available if your bank has activated the Statements module. 

 
Figure 57: Site template- Modules tab, Statements module 
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12. Enter the Statements module options for this template on the Statements tab. See "Statements Module (on 
page 48) for detailed information on these fields. 

13. Click the Expenses tab. 
Note: This tab is only available if your bank has activated the Expenses module.

 
Figure 58: Site template- Modules tab, Expense module 
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14. Enter the Expenses module options for the template on the Expenses tab. See "Expenses module (on page 
50) for detailed information on these fields. 

15. Click the Archive Reports tab. 

 
Figure 59: Site template- Archive Reports 
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16. Set data archive retention times for reports and mappers on this page. 
17. Click the Account Reference Tables tab. 

 
Figure 60: Site template- Account Reference Tables 
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18. In the Country Codes section of the Account Reference Tables tab, specify the country information for the 
site template. See "To specify country information (on page 52) for detailed information on country codes. 

19. In the Account Status Codes section of the Account Reference Tables tab, specify the Account Status Code 
options for the site template. See "To manage account status codes for a site” on page 39 for detailed 
information on account status codes. 

20. In the MCC Groups section of the Account Reference Tables tab, specify the MCC Group information for the 
site template. See "To enable MCC groups (on page 55) for detailed information on account status codes. 

21. Click Save to save the new site template.  

 
Figure 61: Save Site Template dialog 

 
22. In the Template name field, enter a unique name for the new template. This is a required field. 
23. In the Template description field, enter a brief explanation of the site template's purpose. 
24. Click Save. The new site template displays in the Manage Site Templates page.  

 

Creating a template from an existing site 
If you have already created a site that you want to use as a model for other sites, you do not need to create a new 
template as described in "Creating a new site template (on page 59). Instead, you can take the settings from an 
existing site and save those settings as a template. Complete the following to turn an existing site into a new site 
template. 

68 

 



 

1. Find the site (See "To search for a site" on page 33) you want to use as a template. 
2. Click Save Site Template. The Save Site Template dialog displays. 

 
Figure 62: Save Site Template dialog 

3. In the Template name field, enter a unique name for the new template. This is a required field. 
4. In the Template description field, enter a brief explanation of the site template's purpose. 
5. Click Save. The new site template displays in the Manage Site Templates page.  

 

Using a site template to create a site 
Site templates help you create new sites by applying the settings in the template to the sites. Use the following 
procedure to use a site template to create a new site. 
Note: You have to add the site to the hierarchy before you can  

1. Find the site (See "To search for a site" on page 33) to which you are applying the site template. The Site 
Setup page displays. 

2. From the Select a template to apply to this site list, select the desired site template. 

 
Figure 63: Apply Site Template fields 

3. Click Apply. The template settings are applied to the site. The  icon indicates site settings that were 
determined by the template settings. 

 

Managing cycles for a site 
You can create, edit, or delete cycles for the sites that you administer. You can use cycles to to set credit limits, create 
report parameters, and are used by a number of other functions on Online Card Management. Use the Manage 
Cycles page to organize a site's cycles. The following procedures explain how you manage cycles for the sites you  
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To create a new cycle 
1. Select Administration> Set Up Sites > Maintain Cycles from the menu. 
2. Search for the site (see topic on page 33) for which you want to create a cycle and click the edit link for that 

site to display the Manage Cycles page. 
 

 
Figure 64: Manage Cycles page 

3. Click Create New Cycle. The Setup Cycle dialog displays. 
 

 
Figure 65: Setup Cycle page 
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4. In the Cycle name field, enter a unique name for this cycle. This is a required field. 
5. In the Description field, enter a brief explanation of the cycle's purpose.  
6. Choose one of the following a Frequency options: 

• Monthly 
• Bi-monthly 
• Weekly 
This is a required field. 

7. From the Cycle date list, select the day you want each cycle to end and begin a new cycle. 
Note: The options that display in this list depend on the selected Frequency option. 

8. In the Start Date field, enter the date that the first cycle will begin. By default, the current date displays in this 
field.  

Tip: You can click the  icon to select the date from a calendar. 

9. Choose one of the following When cycle date falls on a weekend options: 
• Use the Friday before 
• Use the Monday after 
• Use actual day 

10. Choose one of the following When cycle date falls on a holiday options: 
• Use the day before 
• Use the day after 
• Use actual day 

11. Click Create. Online Card Management saves the new cycle. 
 

To edit a cycle 
1. Select Administration > Set Up Sites > Maintain Cycles from the menu.  
2. Search for the site (see topic on page 33) for which you want to create a cycle and click the edit link for that 

site to display the Manage Cycles page. 

 
Figure 66: Manage Cycles page 
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3. From the list of cycles, find the cycle you want to edit and click the corresponding  icon. The Edit Cycle 
page displays. 

 
Figure 67: Edit Cycle 

4. Click Update. Online Card Management saves the changes to the cycle. 
 

Working with user security profiles 
The following standard security profiles are included in Online Card Management, described in  
detail below: 
Bank Administrator 
Bank administrators are responsible for overall management and administration of online statements and reports 
products used by the bank's organizations. 
Bank Support User 
Bank support users provide bank-level and organization-level support for online statements and reports. These users 
have access to online statements and reports, but not to the administrative portions of the application. 
Organization Administrator 
Organization administrators provide organization-level support for online statements and reports products used by the 
organization. They also administer branding messages and users for  
the organization. 
Organization Manager 
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Organization managers access all available online statements, including their own, for assigned accounts or subunits. 
They also access all available online reports for assigned subunits. 
Account Holder 
Account holders have access to online statements, where they access individual statements and make payments on 
all of their accounts. 
My Profile Access user 
My Profile Access users have access to basic user profile information. 
 

Bank Administrator default privileges 
Bank administrators are responsible for overall management and administration of online statements and reports 
products used by the bank's organizations. Bank administrators with the standard security profile are able to use 
Online Card Management to perform the following tasks: 
• Act as administrator for bank site and the organization users, including the following: 
• Allocation setup 
• Assign reports to bank 
• Customize interface 
• Manage cycles 
• Manage expenses 
• Manage mappers 
• Manage Program Change Requests (PCRs) 
• Manage reports and report profiles 

 
Note: These privileges allow administrators to change the security settings for other users. They do not grant 
the administrator rights to the tasks themselves, only to the security settings related to these tasks. 
 

• Manage Site Setup options, including the following: 
• Email notification 
• Password requirements 
• Reports 
• Statements 
• Transactions 
• Setup user ID 
• Site setup settings 
• Edit Account Holder information, including the following: 
• Checking/Savings account 
• Date of birth 
• Email 
• Employee ID 
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• Fax number 
• Home phone 
• Password 
• Social security number 
• Work phone 
• Work with Account Status information, including the following: 
• Change account status 
• View expiration date 
• View account status history 
• Work with Authorization and Decline information, including the following: 
• Edit account-level parent flags (Cycle Limits, MCCG Table, and Single Purchase flags) 
• Edit card limits 
• Edit card option sets 
• Edit cash advance limits 
• Edit cycle limits 
• Edit daily amount limits 
• Edit monthly amount limits 
• Edit single purchase limits 
• Work with Card Information 
• Edit address information 
• Edit card line information 
• Edit master accounting code information 
• Edit Ace option set information 
• Edit bill type preferences 
• Edit Client Product Code information 
• Manage Card Models 
• Work with MCC group authorizations and information 
• Add/Delete MCC groups 
• Edit custom MCC group limits 
• Edit MCC group cycle limits 
• Edit MCC group daily limits 
• Edit MCC group diversion accounts 
• Edit MCC group monthly limits 
• Edit MCC group names 
• Edit MCC group option sets 
• Edit MCC group single purchase limits 
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• Edit MCC group-level parent flags (Cycle Limits, MCCG Table, and Single Purchase Limit) 
• Work with Program Change Requests (PCRs) 
• Print PCRs 
• Receive PCRs 
• Reject PCRs 
• Search for PCRs that have been received, rejected, or submitted 
• View PCRs 
• Work with Temporary Credit Limit controls 
• View Authorizations and Declines 
• Perform site administration functions 
• Add new sites 
• Assign reports to a bank 
• Maintain approval profiles 
• Edit cycles 
• Maintain messages 
• Maintain mileage rates 
• Maintain report profiles 
• Maintain security profiles 
• Upload new accounts 
• Upload new users 
• Import allocation 
• View allocation setup 
• Approve transactions 
• Edit transactions 
• Manage expenses 
• Create expense reports 
• Create out-of-pocket transactions 
• Manage expense reports 
• Reopen expense reports 
• Search transactions 
• Split transactions 
• Unlock transactions 
• Create, Edit, and Delete mappers 
• Manage mappers 
• View bank reports 
• Schedule reports, modify report schedules 
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• View all standard reports 
• Work with site setup accounts, including the following: 
• Edit account authorization option sets 
• Edit account reference tables 
• Edit ACE option sets 
• Edit client product codes 
• Edit account data retention settings 
• Enable/disable real time new cards 
• Enable real time account updates 
• Edit account MCC group authorization option sets 
• Work with site account temporary credit limit controls 
• View authorizations and declines 
• Customize site settings, including the following: 
• Colors 
• Product name 
• Upload first and second logos 
• Work with site setup user email notifications, including the following: 
• Edit new user information email 
• Edit password hint notification email 
• Edit password reset notification email 
• Work with site setup expense settings, including the following: 
• Hierarchy management 
• Manage expenses 
• Edit transaction data retention settings 
• Work with general site settings, including the following: 
• Activate corporate sites 
• Activate logons 
• View site Multifactor Authentication settings 
• Work with support email 
• Set site password rules, including the following 
• Edit password expiration days 
• Edit password expiration notification days 
• Edit password maximum and minimum length 
• Edit password rules 
• Work with site report settings, including the following: 
• Edit report data retention 
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• Edit TBR reports 
• Work with site self-registration settings including the following: 
• Edit self-registration default profile 
• Edit self-registration required fields 
• Work with site setup statements, including the following: 
• Edit allowable payment types 
• Edit available email notification 
• Enable real-time transactions 
• Edit statement data retention 
• Edit site authorizations and decline view settings 
• Work with site setup user ID rules, including the following: 
• Edit user ID minimum and maximum length 
• Edit user ID rules 
• Work with statements, including the following 
• View account audit history 
• Search for statements 
• View account summary 
• View authorizations and declines 
• View Payment Request Audit 
• View statements 
• View transactions 
• Work with user administration information, including the following: 
• Create users 
• Emulate users 
• Enable or disable users 
• Maintain user access 
• Reset password and security questions for users 
• Unlock users 
• Edit user contact information 

 

Bank Support User default privileges 
Bank support users provide bank-level and organization-level support for online statements and reports. These users 
have access to online statements and reports, but not to the administrative portions of the application. Bank support 
users may perform the following tasks: 
• Edit Account Holder Information, including the following: 
• Checking/Savings account 
• Date of birth 
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• Email 
• Employee ID 
• Fax number 
• Home phone 
• Password 
• Social security number 
• Work phone 
• Work with Account status information, including the following: 
• Edit account status 
• View account expiration date 
• View account status history 
• Work with Authorization limit information, including the following: 
• Edit card limits 
• Edit card option sets 
• Edit cash advance limits 
• Edit custom limits 
• Edit cycle limits 
• Edit daily limits 
• Edit monthly limits 
• Edit single purchase limits 
• Work with general card information, including the following 
• Edit address line 1 and address 
• Edit card line 1 and card line 2 
• Edit master accounting code 
• Work with MCC group authorization settings, including the following: 
• Add or delete MCC groups 
• Edit custom limits 
• Edit MCC group action 
• Edit MCC group cycle limits 
• Edit MCC group daily limits 
• Edit MCC group diversion accounts 
• Edit MCC group monthly limits 
• Edit MCC group names 
• Edit MCC group option sets 
• Edit MCC group single purchase limits 
• Work with Program Change Requests, including the following: 
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• Print Program Change Requests 
• Receive Program Change Requests 
• Reject Program Change Requests 
• Search for received requests 
• Search for rejected requests 
• Search for submitted requests 
• View Program Change Requests 
• Work with Temporary Credit Limits 
• Work with expense allocation, including the following: 
• Import allocation 
• View allocation setup 
• Approve transactions 
• Edit transactions 
• Search for transactions 
• Split transactions 
• Unlock transactions 
• Run Bank Reports 
• Schedule reports and mappers 
• Run the following standard reports: 
• Allocation Analysis Report 
• Cardholder Dispute Report 
• Cardholder Profile Report 
• Expense Report 
• Merchant Report 
• Statement of Account Report 
• Transaction Report 
• User Profile Report 
• Work with site setup accounts, including the following: 
• Edit account authorization option sets 
• View account reference tables 
• View data retention setting 
• View real time new card settings 
• View real time updates 
• Edit MCC group authorization option sets 
• View site temporary credit limit controls 
• View site authorization and declines 
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• Edit site setup support email settings 
• View site setup password rules, including the following: 
• Expiration days 
• Expiration notification days 
• Minimum and maximum length 
• Password rules 
• View site setup report data retention settings 
• View TBR reports 
• View self-registration default profile settings 
• View self-registration required fields 
• View site setup statement settings, including the following: 
• Allowable payment types 
• Available email notification 
• Enable real-time transactions 
• Statement data retention 
• View Authorization and Declines 
• Work with statements, including the following 
• View account audit history 
• Search for statements 
• View account summary 
• View payment request audit 
• View statements 
• View transactions 
• Work with user administration, including the following: 
• Emulate users 
• Enable or disable users 
• Maintain user access 
• Reset passwords and security settings 
• Unlock users 
• View user contact information 

 

Organization Administrator default privileges 
Organization administrators provide organization-level support for online statements and reports products used by the 
organization. They also administer branding messages and users for the organization. Organization administrators 
may perform the following tasks: 
• Act as administrator for the organization users, including the following: 
• Administer cycles 
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• Administer expenses 
• Administer mappers 
• Administer Program Change Requests (PCRs) 
• Edit Account Holder Information, including the following: 
• Checking/Savings 
• Date of birth 
• Email 
• Employee ID 
• Fax Number 
• Home Phone 
• Password 
• Social Security Number 
• Work Phone 
• Work with Account Status information, including the following: 
• Edit account status 
• View account expiration date 
• View account status history 
• Add accounts to profile 
• Work with authorization information, including the following: 
• Edit account-level parent flags (Cycle limit, MCCG table, Single purchase) 
• Edit card limits 
• Edit card option sets 
• Edit cash advance limits 
• Edit custom limits 
• Edit cycle limits 
• Edit daily limits 
• Edit monthly limits 
• Edit single purchase limits 
• Work with general card information, including the following 
• Edit address line 1 and address 
• Edit card line 1 and card line 2 
• Edit master accounting code 
• Create new cards 
• Edit Ace option set information 
• Edit bill type preferences 
• Edit Client Product Code information 
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• Manage Card Models 
• Work with MCC group authorizations and information 
• Add/Delete MCC groups 
• Edit custom MCC group limits 
• Edit MCC group cycle limits 
• Edit MCC group daily limits 
• Edit MCC group diversion accounts 
• Edit MCC group monthly limits 
• Edit MCC group names 
• Edit MCC group option sets 
• Edit MCC group single purchase limits 
• Edit MCC group-level parent flags (Cycle Limits, MCCG Table, and Single Purchase Limit) 
• Work with Program Change Requests (PCRs) 
• Delete PCRs 
• Modify PCRs 
• Print PCRs 
• Reject PCRs 
• Search for PCRs that have been received, rejected, or submitted 
• Search for unsubmitted PCRs 
• Submit PCRs 
• View PCRs 
• Perform site administration functions 
• Maintain approval profiles 
• Maintain cycles 
• Maintain messages 
• Maintain mileage rates 
• Maintain security profiles 
• Upload new accounts 
• Upload new users 
• Import allocation 
• View allocation setup 
• Approve transactions 
• Edit transactions 
• Manage expenses 
• Create expense reports 
• Create out-of-pocket transactions 
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• Manage expense reports 
• Reopen expense reports 
• Search transactions 
• Split transactions 
• Unlock transactions 
• Create, Edit, and Delete mappers 
• Manage mappers 
• View bank reports 
• Schedule reports, modify report schedules 
• View all standard reports 
• Edit self-registration default profile 
• Work with statements, including the following 
• View account audit history 
• View account summary 
• View authorizations and declines 
• View statements 
• View transactions 
• Work with user administration information, including the following: 
• Create users 
• Enable or disable users 
• Maintain user access 
• Reset password and security questions for users 
• Unlock users 
• Edit user contact information 
• Edit site setup support email 

 

Organization Manager default privileges 
Organization managers access all available online statements, including their own, for assigned accounts or subunits. 
They also access all available online reports for assigned subunits. They do not have access to any administrative 
functionality. Organization managers may perform the  
following tasks: 
• View Account Holder information, including the following: 
• Checking/Savings account 
• Date of birth 
• Email 
• Employee ID 
• Fax number 
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• Home phone 
• Password 
• Social security number 
• Work phone 
• View Account Status information, including the following: 
• Account status 
• Expiration date 
• Status history 
• View authorization information, including the following: 
• Card limit 
• Card option set 
• Cash advance limit 
• Custom limits 
• Daily limits 
• Monthly limits 
• Single purchase limit 
• View card information, including the following: 
• Address line 1 
• Address 
• Card line 1 and Card line 2 
• Master accounting code 
• View general information, including the following 
• ACE option set 
• Bill type 
• Client product code 
• View MCC group authorization information, including the following: 
• Custom limits 
• MCC group action 
• MCC group cycle limits 
• MCC group daily limits 
• MCC group diversion account 
• MCC group monthly limits 
• MCC group name 
• MCC group option set 
• MCC group single purchase limit 
• Approve transactions 
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• Edit transactions 
• Create out-of-pocket expenses 
• Manage expense reports 
• Split transactions 
• Unlock transactions 
• Schedule reports 
• Run the Cardholder Dispute Report 
• Run the Merchant Report 
• Run the Transaction Report 
• Enable or disable users 
• View Account Audit history 
• View statements 
• View transactions 
• Reset passwords and security questions 
• Unlock users 
• View user contact information 

Account Holder default privileges 
Account holders have access to online statements, where they access individual statements and make payments on 
all of their accounts. Account holders may perform the following tasks: 
• View Account Holder information, including the following: 
• Checking/Savings account 
• Date of birth 
• Email 
• Employee ID 
• Fax number 
• Home phone 
• Password 
• Social security number 
• Work phone 
• View Account Status information, including the following: 
• Account status 
• Expiration date 
• Status history 
• Add account to their own profiles 
• View Authorization information, including the following: 
• Card limit 
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• Card option set 
• Cash advance limit 
• Custom limits 
• Daily limits 
• Monthly limits 
• Single purchase limit 
• View card information, including the following: 
• Address line 1 
• Address 
• Card line 1 and Card line 2 
• Master accounting code 
• View general information, including the following 
• ACE option set 
• Bill type 
• Client product code 
• View MCC group authorization information, including the following: 
• Custom limits 
• MCC group action 
• MCC group cycle limits 
• MCC group daily limits 
• MCC group diversion account 
• MCC group monthly limits 
• MCC group name 
• MCC group option set 
• MCC group single purchase limit 
• Edit transactions 
• Create out-of-pocket transactions 
• Manage expense reports 
• Search transactions 
• Split transactions 
• Schedule reports 
• Run the Cardholder Dispute Report 
• Run the Expense Report 
• Run the Merchant Report 
• Run the Statement of Account Report 
• Run the Transaction Report 
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• View account audit history 
• Make payments 
• View account summary 
• View statements 
• View transactions 
• View user contact information 

 

My Profile Access user default privileges 
My Profile Access users have access to basic user profile information. My Profile Access users have access to the 
following: 
• Add Account to My Profile 
• Edit User Contact Information 

 

Defining custom security profiles 
To define a custom security profile, select a site and define the task permissions in the new custom security profile. 
When you save the new security profile, it becomes available for assignment to  
site users. 
You can also modify an existing security profile. Users who already have that profile assigned have their permissions 
updated to reflect the new profile settings. 
Note: Individual permissions settings override any default settings given to the user by the security profile. You can 
modify the permissions for a specific user on a case-by-case basis (see topic on page 143). 
 

To define a custom security profile 
Note: This procedure explains how you create a new profile. For information on editing an existing profile, see "To 
modify an existing security profile (on page 90). 

1. Select Administration > Manage Users > Maintain Security Profiles from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site for which you are creating a security profile. 
Important: Do not use your browser's Back button to return to the list of sites. To return to the Search 
for Site page, click the Select Different Site button. 

• If you have access to only one site, the Security Profile page displays. 
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Figure 68: Security Profile page 

2. Click the Create Profile button. The Security Permissions for New Profile section displays below the list of 
existing security profiles. 

 
Figure 69: Security Profile page- profile selected 
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3. In the Profile name field, enter a name for this profile. 
4. In the Description field, enter a brief explanation of the profile's purpose. 

 

 
Figure 70: Security Profile page- Security Permissions 

 
5. Click the plus sign ( + ) for a category to expand the list of individual permissions. 
6. Choose the security permissions you want this profile to use. Security permissions are as follows depending 

on the specific permission with which you are working. 

• Select Deny or Grant to disallow or allow permission to complete a task listed in  
the profile. 

• Select Hide, Display, or Edit to hide a system object, show a system object as display only, or allow 
users in the profile to edit information for the system object. 

By default, all permissions are either Deny or Hide, whichever is appropriate to the permission. 

Tip: You can click Restore to Previous to restore permissions to their most recently  
saved settings. 

7. Click Save to save the profile when you have changed all permissions necessary to create your new security 
profile. The new profile displays in the security profile list at the top of the Security Profiles page. You can 
now assign the new profile to site users. 
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To modify an existing security profile 
1. Select Administration >Manage Users > Maintain Security Profiles from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site for which you are modifying security profiles. 
Important: Do not use your browser's Back button to return to the list of sites. To return to the Search 
for Site page, click the Select Different Site button. 

• If you have access to only one site, the Security Profile page displays. 

 
Figure 71: Security Profile page 

Important: Do not use your browser's Back button to return to the list of sites. To return to the Search for 
Site page, click the Select Different Site button. 
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2. In the Security Profiles page, select an existing security profile in the Security Profile Name column. Online 
Card Management highlights the profile name, and the existing permissions for that profile display in the 
Security Permissions list. 
 

 
Figure 72: Security Profile page- profile selected 
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3. Click the plus sign ( + ) for a category to expand the list of individual permissions. 
4. Modify individual permissions as necessary. 
5. Click Save. The new permission settings save and become available to site users. Permissions for users 

already have the profile update to reflect the new profile settings. 
Note: Custom permissions settings that are established for a user override any permission settings applied by the 
security profile. For information about individually tailored permission settings, see "To tailor individual permissions (on 
page 143). 
 
 

Working with approval profiles 
Approval profiles are applied to the users that need to approve and reject expense reports. The profile determines 
whether a user can approve, approve and close, reject, or edit submitted expense reports. Approval Profiles also 
determine when and if a user receives notification of an expense report status change. 
Users are assigned to specific approvers through their personal information. Approval profiles are assigned to 
approvers when you add them to a user's personal information. The same approver can use a different approval 
profile for different users. See "Creating a user (on page 135) for information on assigning approvers to users. Read 
the following topics for information on creating and editing approval profiles. 
 

To create an approval profile 
1. Select Administration >Manage Users > Maintain Approval Profiles from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site for which you are adding security profiles. 

• If you have access to only one site, the Approval Profiles for Site page displays. 

 
Figure 73: Approval Profiles page 

Important: Do not use your browser's Back button to return to the list of sites. To return to the Search for 
Site page, click the Select Different Site button. 

92 

 



 

2. Click Create Profile. The New Approval Profile for Site dialog displays. 

 
Figure 74: New Approval Profile page 

3. Enter a name for the approval profile in the Profile name field. 
4. Enter an explanation of the general purpose for this approval profile in the Description field. 
5. Select a Copy an Existing profile option. 

• If you select Yes, the Existing profiles list becomes available. Select the profile you want to copy from 
the list. The permissions from the existing profile are copied to your new profile. Modify the copied 
permissions by completing only the necessary steps in this procedure. 

• If you select No, complete all of the steps in this procedure. 

6. Select a Type of approver option. 

• Select Interim if the approver reviews expense reports and forwards them to  
another approver. 

• Select Final if the approver reviews expense reports and closes it. When an expense report is closed, all 
the transactions within it are locked. 
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7. Select an Attach transactions to expense reports option. If you select Yes, the approver can add 
transactions to an expense report after submitting it. 

8. Select an Edit expense report transactions option. If you select Yes, the approver can edit the transactions 
in an expense report receiving it for approval. The cardholder who created the report cannot edit the expense 
report after submitting it. 

9. Select a Reject Individual transactions option. If you select Yes, the approver will be able  
to select the transactions that he or she does not want to approve and still approve the  
expense report. 

10. Select a Receive email of status change option. If you select Yes, the approver receives a notification 
every time the expense report changes status via email. See "Expense report status (on page 324) for 
information on expense report status. 

11. Click Create. The Approval Profile for Site page re-displays. The new profile is included in the list of approval 
profiles. 

 

To edit an approval profile 
1. Select Administration > Manage Users > Maintain Approval Profiles from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site for which you are adding security profiles. After you select your site the Approval Profiles for Site 
page displays. 

• If you have access to only one site, the Approval Profiles for Site page displays. 

2. Select the approval profile you want to modify from the list. The profile approval options display in the Profile 
Settings section. 
 

 
Figure 75: Edit Approval Profile page 
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3. Modify the profile as necessary. 
Note: Online Card Management disables the Copy an existing profile options and list when you edit an 
existing profile. 

4. Click Save. 
 

To delete an approval profile 
1. Select Administration> Manage Users > Maintain Approval Profiles from the menu. 

• If you have access to more than one site, the Search for Site page displays. Use this page to select the 
site for which you are adding security profiles. After you select your site the Approval Profiles for Site 
page displays. 

• If you have access to only one site, the Approval Profiles for Site page displays. 

2. Click the  icon next to the profile you want to delete. A message displays asking you to confirm that you 
want to delete the profile. 

 
Figure 76: Delete approval profile confirmation message 

Note: The  icon only displays for approval profiles that have no assigned users. You cannot delete a 
profile if there is a user assigned to the profile. 

3. Click Yes. The Approval Profiles for Site page displays. Online Card Management removes the deleted 
approval profile from the list of available profiles. 

Maintaining Home page message for a site 
Administrators can create messages that display on the Home page of the sites you manage. Use Home page 
messages to communicate important announcements with users, such as informing account holders about new 
services or letting them know about organization events. 
Messages are displayed based on the site to which they are added, and are inherited from the higher units to the 
lower units of the hierarchy. For example, if a bank-level user logs on, only system-level and bank-level messages 
display on that user's Home page. Organization-level users can view system-level, bank-level, and organization-level 
messages. 
Administrators can add, edit, and delete messages for their assigned bank and the organizations associated with the 
bank, or for their own organization. Messages can have a specified time period during which they display. When a 
message's time frame expires, it no longer displays on the Home page. Administrators can delete the message, or 
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edit it and display it for another  
time period. 
Note: To manage messages, Administrators must have the security access for maintaining site messages. 
Administrators can only create messages for your the units in the hierarchy to which they have rights. 
 

To maintain site messages 
Administrators can add and update messages for organizations if allowed to do so by an access setting. (An 
organization administrator who does not have permissions for branding can contact a bank administrator.) The 
Branding setting for a user determines the messages that user sees on the Home page. For information about the 
Branding setting, see the task "To modify user information (on page 150). 

1. Select  Administration> Customize Sites > Maintain Messages from the menu. 

• If you have access to more than one site, the Search for Site page displays. Find the site for which you 
are entering site messages and click the Edit link in the Profile column. The Maintain Messages page 
displays. 

• If you only have access to one site, the Maintain Messages page displays. 
Important: Do not use your browser's Back button to return to the list of sites. To return to the Search for 
Site page, click the Select Different Site button. 

 
Figure 77: Maintain Messages page 
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2. To add a new message, click Add New Message. Message fields display. 

 
Figure 78: New Message fields 

3. In the Message heading field, enter the message heading you want, up to 75 characters. In the Message 
text field, enter the message text, up to 2500 characters. If you want a link to another Web site (such as your 
organization Home page), enter text for that link in the Hyperlink text field, and enter the link itself in the 
Hyperlink ref field (in the form www.mylink.com). 

4. Enter a posting date and an end date in the Posts and Ends fields. Use the date format selected in your 
browser. If you enter the current date as the posting date, the message displays immediately after you 
refresh the page. 
Note: Most users in the United States should use the mm/dd/yyyy format. UK users should use dd/mm/yyyy. 
The message posts at midnight of the posting date, and ends at 11:59 p.m. of the ending date. 

5. Click the Add to save the message. The new message displays in the message list. 
Tip: To cancel your changes, click the Cancel link. 

To work with existing messages 
Complete steps 1 through 3 and complete one of the following: 

• If it is an existing message, click the  icon next to the message. The same fields display, and you 
can update existing message text. 

• To delete an existing message, click the   icon. A message box displays asking if you want to delete 
the message. Click OK. The message is deleted. 
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Customizing and branding the site interface 
The site interface for your bank or organization can be customized to include your logo and business colors, and to 
allow you to use a name of your choice for the product. All wording and color changes are visible throughout the 
product to your users. 
Administrators can add and update branding for organizations if allowed to do so by an access setting. The Branding 
setting for a user determines the branding that user sees on the Home Page. For information about how to set the 
branding for a user, see Modifying User Information. 

• You must create brand images with the following specifications: 

• The desktop brand image must be 650X80 pixels with no padding (whitespace). 

• A mobile brand image must be 380X47 pixels with no padding (whitespace). 

• A iTouch brand image must be 58X58 pixels with no padding (whitespace). 

• A Favicon brand image must be 16X16 pixels with no padding (whitespace). This image will be a .ico format. 

• The image file format must be a Portable Network Graphics (.png), Joint Photographic Experts Group (.jpeg), 
or  Graphics Interchange Format (.gif) file. The .png format is preferred. 

• The graphic must extend the full dimensions. Padding is automatically added. 
 

To customize the Online Card Management interface 
To customize the interface (desktop): 

1. Click Browse in the Branding section. The Choose File to Upload dialog displays. 
2. Navigate to your local folder where the 650X80 image is located and click Open. The path to the image 

displays in the Image file path (site logo) field.  
3. Click Save. The image is saved and displays on the Home page. 

To customize the interface (mobile): 
1. Click Browse in the Branding section. The Choose File to Upload dialog displays. 
2. Navigate to your local folder where the 380X47  image is located and click Open. The path to the image 

displays in the Image file path (mobile logo) field. 
3. Click Save. The image is saved and displays on the mobile device Home page. 

To customize the interface (iTouch): 
1. Click Browse in the Branding section. The Choose File to Upload dialog displays. 
2. Navigate to your local folder where the 58X58  image is located and click Open. The path to the image 

displays in the Image file path (iTouch logo) field. 
3. Click Save. The image is saved and displays on the Apple device Home page. 

To customize the interface (Favicon): 
1. Click Browse in the Branding section. The Choose File to Upload dialog displays. 
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2. Navigate to your local folder where the 16X16 with a .ico  image is located and click Open. The path to the 
image displays in the Image file path (Favicon logo) field. 

3. Click Save. The image is saved and displays as an icon for a website. 

 
Figure 79: Branding Section 

 
To customize the interface color: 
To change the colors of the interface, link, and text colors, select the color under elements. A preview window will 
display to choose a color. Click Save to complete the changes.  
You can click Restore Defaults to return to default settings. 
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Figure 80: Interface Colors 

The following examples show a new image on the home page (desktop and mobile) with message icons, the 
logout button, and links to user preferences. 

 
Figure 81: Home Page  
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Figure 82: Mobile example 

 
 

Working with email templates 
Online Card Management sends email messages to account holders and other users when certain events occur. 
These messages are generated from a template. For example, when a payment is past due Online Card Management 
sends an email to the account holder. 
As a bank administrator, you can modify the content of the emails by editing the email templates. Using the templates, 
you can determine the standard text of the emails as well as the dynamic data fields that display in the email 
messages. Use the Email Template Maintenance to work with the email templates in Online Card Management. The 
following procedures explains how you can edit templates to control the content of the emails sent to your users.   
 

Understanding data tags 
Data tags are used to insert dynamic data into the messages generated from the template. In the template, data tags 
display as place holders inside brackets with a descriptive name. For example, the {Account Number} data tag in the 
template will insert the actual account number in the text of the messages generated from the template. Each template 
has a unique set of available data tags which you can embed in the subject and body of the template. 
Data tags can only be inserted at the end of a sequence line. You can continue the text on the next line by not 
inserting a Carriage Return after a data field. For example, if you want to insert "Dear {Account Number},"  into a 
message. The Dear and the "," would be on separate lines with the Data Field at the end of the first line. 
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To edit an email template 
1. From the Administration menu, select Manage Email Templates. The Email Template Maintenance page 

displays listing the templates available. 

 
Figure 83: Email Template Maintenance page 
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2. Find the template you want to edit and click the  icon. The Email Template Detail  
page displays. 

 
Figure 84: Email Template Detail page 

3. Customize the subject section of the template by completing the following: 
a. Select the notification language from the Email Language list. 
b. Review the existing notification subject line in the Email Subject Preview field. This field is read-only. 
c. Select the Email Format Options, Create standard email template or Upload HTML formatted email 

template. 
d. If you select Create standard email template: 

a.  If you want to modify the text, you can insert text or data tags anywhere in the sequence: 
b. To insert text, select the next line in the sequence. Type your new text or insert a data tag by 

selecting one from the Data Tag list. 
e. If you select Upload HTML formatted email template 

a. Click Upload your file here. 
b. Type the local pat to your template or click Browse and navigate to the local folder that contains 

your template. 
c. When the path is correct, click Save. The application verifies the template code and a message 

displays at the top of the page if the template was successfully saved. The new email template 
displays in the Email Template Maintenance page. 

f. If you want to modify the text, you can insert text or data tags anywhere in the sequence: 
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a. To insert text, select the next line in the sequence. Type your new text or insert a data tag by 
selecting one from the Data Tag list. 

g. Continue editing the subject line until it is acceptable. If you need to modify the notification body text, 
proceed to the next instruction set. 

 
Note: You cannot insert a carriage return between subject sequence lines. 

4. Customize the body section of the template by completing the following: 
a. Review the existing notification subject line in the Email Body Preview field. This field is read-only. 
b. If you want to modify the text, you can insert text or data tags anywhere in the sequence: 

a. To insert text, select the next line in the sequence. Type your new text or insert a data tag by 
selecting one from the Data Tag list. 

c. Click Preview Email Template to review the edited notification subject text format.  
d. Click Save to save the modified notification. The edited notification is listed on the Email Template 

Maintenance page. 

Note:  Modified email templates have the Delete icon ( ) and a Date Modified associated with them. 
The modified templates are the only templates you are allowed to delete from the system. 

 

Managing broadcast email notifications 
You use the Manage Broadcast Email Notifications menu option to create email notifications to a subset of users 
within a bank or unit (Ex. Program Administrator or Account Holder). The notification can only be sent to active users, 
which is defined as users who have logged in within the last 90 days. 

Creating a new broadcast email notification 
1. Click Create New Broadcast Email Notification. The Create Broadcast Email Notification: Search for 

Site page opens.  

Note: Click the detail icon (  ) to the left of an existing email to view a previously sent email. 

Figure 85: Manage Broadcast Email Notifications page 
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2. Select Site Name, Site Number, or Bank Number from the Search By list. 

 
Figure 86: Create Broadcast Email Notification page 

3. Type in the search criteria. Click Search. To display all sites leave search criteria blank and click Search. 
The bank(s) or unit(s) will display under Search Results. 

 
Figure 87: Search Results 

4. Select a bank or unit by clicking the include icon ( ). The bank or unit will display under Selected Sites. 
You can remove the bank or unit by clicking the remove icon ( ). 

 
Figure 88: Selected Sites 

5. Click Next. The Create Broadcast Email Notification: Select Profile and Compose page opens. To return 
to the Manage Broadcast Email Notifications page, click Cancel. 

6. In the Select Profiles section, from the Profile list choose the subset for which you would like to create the 
broadcast email notification. The number of recipients will display to the right of the profile in the Recipients 
column. If you do not select a profile, the email will be broadcast to all active users within the bank or unit, 
and its subunits. To return to the previous step click Select Different Site. 
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Figure 89: Create Broadcast Email Notification page: Select Profiles 

7. In the Compose section begin your correspondence. Both the Email Subject and Email Body field are 
required and must be populated to send the email. A preview window will display on the right. When the 
email is complete, click Send. To return to the previous step, click Cancel. 

 
Figure 90: Create Broadcast Email Notification page: Compose 
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Setting Up Allocation 
Allocation is the process of assigning transactions to the proper general ledger accounts in your organization's 
accounting system. The accounting codes, or fields, associated with an organization's allocation requirements are 
combined into an Allocation String. The process of defining these fields and assigning them to an allocation string 
consists of both automated and manual allocation assignment. 
This section includes the following topics: 

• Understanding system allocation (see topic on page 107) 
• Setting up site allocation rules (see topic on page 108) 
• Defining fields and setting properties (see topic on page 109) 
• Creating and assigning valid codes (see topic on page 115) 
• Setting default allocations (see topic on page 128) 

 

Understanding system allocation 
Online Card Management manages allocation at the site level. Your site setup determines: 

• How to handle the default allocation string from the processor when importing transaction data to Online 
Card Management 

• Whether the organization can edit the allocation codes that were automatically assigned by applying the 
allocation rules set up in Online Card Management 

• Whether the organization can configure valid codes to ensure that allocation rules are set up using only 
approved codes 

You can set up a series of allocation rules in Online Card Management. These rules assign allocation strings to 
transactions based on any or all of the allocation types: 

• MCC: Assign allocation strings based on a class of merchants, such as airlines or office supply stores, 
by associating them to specific merchant category codes (MCC). All transactions made at these 
merchants are assigned the allocation string you have associated with that MCC code. 

• Expense type: Associate allocation strings to an expense type, which are groupings of merchant 
category codes (MCC). All transactions made at merchants included in an expense type are assigned 
the associated allocation string. 

• Point of Sale: Associate allocation strings with the merchant's Point of Sale (POS) code. All 
transactions referencing that POS code are assigned the corresponding allocation string. 

• Unit: Associate allocation strings to a unit. All transactions made with accounts that roll up to a unit are 
assigned the unit's allocation string. 

• Account: Associate allocation codes to individual accounts. All transactions made with the selected 
account are assigned the corresponding allocation code. 

Allocation order refers to the priority given to which allocation rules as they are applied to transactions. This order is 
important because it determines which allocation string takes precedence when the transaction is imported into Online 
Card Management. Each allocation rule overwrites the allocation string applied by a previous rule. 
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Setting up site allocation rules 
The process of setting up your site allocation rules in Online Card Management involves three major tasks, each 
consisting of multiple steps: 

1. Defining fields and setting properties (on page 109) 
2. Creating and assigning valid codes (on page 115) 
3. Setting default allocations (on page 128) 

Complete these steps from the Setup Allocations page. The Setup Allocations page does not activate links to steps 
until their prerequisites are complete. For example, when you first access the Set Up Allocation page, the only active 
link is step 1 under Define Fields and Set Properties. When you complete that step, other links are activated. You can 
save your selections so that you can return to complete this process without having to start over. 
Before you begin setting up allocation, you need the following information about your organization's accounting 
system: 

• Allocation field names and lengths in your default allocation string 
• Whether each allocation field is editable, read-only, or hidden 
• Whether each allocation field requires validation (if validation is enabled) 
• The format of each allocation field, whether the fields contain letters, numbers, special characters, or 

combinations of all three (if applicable) 

Note: If you are the administer for more than one site, select a site to begin the setup process. 
 

To create a new allocation scheme 
The first time you access the Set Up Allocation page, the links to the allocation tasks are disabled. You must create an 
allocation scheme by completing the following steps: 

1. Select Administration> Set Up Allocation from the menu. The Set Up Allocation page displays. 
Note: If you are the administrator for more than one site and you have not specified a site, you must choose 
the site for which you are setting up allocation rules before the Set Up Allocation page displays. 

2. Click Create New Allocation Scheme. The Create New Allocation Scheme dialog opens. 

 
Figure 91: Create New Allocation Scheme dialog 
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The scheme name bundles the specific allocation rules for an organization. 

3. Enter a name for your allocation scheme in the Scheme name field. 
4. Enter a brief explanation of the allocation scheme's purpose in the Description field. 
5. Click Save. The Set Up Allocation page displays the new scheme name and displays the In Progress status 

indicator for your scheme. 
You are now ready to complete the set up allocation procedures. 
 

Defining fields and setting properties 
Site administrators only need to perform this task once to create the fields in the default allocation string for the 
organization. Specify which fields to display in the Expenses module, and define what types of values can be entered 
for each field. 
Complete the following steps to define allocation fields and field properties: 

1. Position fields and create labels (See "To position fields and create labels" on page 109) 
2. Select fields for display (See "To select fields for display" on page 112) 
3. Assign properties (See "To assign properties" on page 113) 

 

To position fields and create labels 
In this step of the allocation setup process, you define the fields in your organization's allocation string according to 
your accounting system's requirements. 
Important: If your site uses the processor master accounting code to populate your account defaults, you must enter 
the fields in the sequence they display in your processor allocation string before adding any additional fields required. 

4. From the Administration menu, select Set Up Allocation. The Set Up Allocations page displays. 
Note: If you are the administrator for more than one site and you have not specified a site, you must choose 
the site for which you are setting up allocation rules before the Set Up Allocation page displays. 
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Figure 92: Set Up Allocations page 

5. Click the Position Fields and Create Labels link under the Define Fields and Set Properties section. The 
Position Fields and Create Labels page displays. 
Note: If you are resuming this step from a previous session, click Modify. 

 
Figure 93: Position Fields and Create Labels page 
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6. Field positions and lengths control how the allocation string displays to users. Enter the total length (number 
of characters) of the complete organization default allocation string in the  
field provided. 

7. Click Add Allocation Field. A window to enter  the allocation field label and length for the first allocation field 
will display. Click Add. The field label and length are displayed in the Define Fields grid, the field label and 
length entry fields change to read-only, and a new entry row displays.  

 
Figure 94: Position Fields & Create Labels- Define Fields section 

8. In the Field Label field, enter the allocation field label for the first allocation field. 
9. In the Length field, enter the length for the first allocation field. 
10. Click Add. The field label and length display in the Define Fields grid, the field label and length entry fields 

change to read-only, and a new entry displays. 

 
Figure 95: Define new field 

Note: After you finish defining a field by clicking Add, the Insert icon becomes available. You can insert a 
new blank row using the Insert icon. 
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11. Repeat steps 5 through 7 until you assign the total length of the allocation string to the allocation field 
segment. When you have accounted for the entire string, a new row does not display after you click OK, and 
the Undefined column no longer displays in the Define Fields grid. 
For example: 

 
Figure 96: Define Fields (example) 

12. Click Next. The Select Fields for Display page displays. 
Note: The sum of the individual field lengths must equal the length of the allocation string you entered above before 
you can move to the next step (see topic on page 112). 
To modify the label or length for an existing field: 

1. Click the Edit icon next to the field. 
2. Re-enter the field label or length and click Update. 

To insert a new blank row: 

1. Click the the icon next to one of the rows. 
2. Specify whether to insert a row above or below it, and click Add to insert the new blank row. 
3. Enter the information for that row and click Add. 

To remove an allocation field from the list: 
1. Click the Remove icon that corresponds to the field you wish to delete. A message displays asking to confirm 

that you want to remove the field. 
2. Click Yes. Online Card Management removes the field from the allocation string. 

 

To select fields for display 
Complete the following task to select the fields from the default allocation string to display in the Expenses module, 
and define the order in which they are displayed: 
Note: This task assumes that you have already completed the "To position fields and create labels (on page 109). If 
you click the Next button from the Position Fields and Create Labels page, start this procedure with step 3. 

1. From the Administration menu, select Set Up Allocation. The Set Up Allocation page displays. 
Note: If you the administrator for more than one site, you must first select a site. For more information, see 
the task "To search for a site (on page 33). 
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2. Click the Select Fields for Display link. The Select Fields for Display page displays. 

 
Figure 97: Select Fields for Display 

3. Select all fields in the Available box that you want to display to end users, and click the right arrow button. 
Tip: If you want to add most of the available fields, click Select All and clear check boxes for the ones you 
do not want to include before clicking the right arrow button. 

4. You can change the way users view the allocation field sequence by moving the fields in the Selected box: 
click a field name to select it, and click the Move Up or Move Down buttons to reposition it in the list. 

5. When you finish defining which fields to display and the order to display them, click Next. The Setup 
Allocations page displays. 

Continue the allocation setup process by assigning field properties. 
 

To assign properties 
For each allocation field displayed in the allocation string (as you defined in the previous task), you can allow users to 
edit the value in the field (by default the field is read-only). If you make a field editable, you can further determine the 
format the user must enter. Complete the following steps to change properties for allocation. 
Note: This task assumes that you have completed the "To select fields for display (on page 112). If you are 
completing this task immediately after selecting fields for display, start the procedure  
with step 2. 

1. From the Administration menu, select Set Up Allocation. The Set Up Allocation page displays. 
Note: If you administer more than one site, you must first select a site. For more information, see the task 
"To search for a site (on page 33). 
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2. Click the Assign Properties link. The Assign Properties page displays. 

 
Figure 98: Assign Properties page 

3. To make a field editable, select the corresponding Edit option. 
Note: If you select the Read-Only option, you do not need to complete steps 4 through 7. 

4. From the Format list, select the format for the field. The format applies to all characters in the field. For 
example, if you assign the format "Alpha only" to a 5-character field, the user can only enter letters for all five 
characters of the field. You can set additional restrictions for individual character positions for any field. 

5. Click the the View/Edit link under the Restrictions column. The Restrictions dialog displays. 

• If you select any field format except "Amount" the Restrictions dialog displays. Codes for the available 
restrictions are listed, depending on what format you choose (if any). 

 
Figure 99: Restrictions dialog 

Complete the following to apply non-amount restrictions: 

a. To allow users to enter any value for a character position, leave the corresponding  
box empty. 

b. To set the restriction for any character position, enter a new code in the corresponding box. 
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c. Click OK to close the dialog. The restrictions you specified display in the Restrictions 
column in the Assign Field Properties section. 

• If you select the "Amount" format, the Restrictions for Amounts dialog displays displaying the field label 
and length. 

 
Figure 100: Restrictions for Amounts dialog 

Complete the following to set Amount format: 

a. Select whether or not to display a decimal. 
b. If you opted to display the decimal, enter the number of places to the right of the  

decimal point. 
c. Click OK to close the dialog. The amount restrictions you specified display in the 

Restrictions column in the Assign Field Properties section. 

6. Select a Required option for the field. If you select Yes, the allocation is not valid unless this field's 
requirements are not satisfied. 

7. Select an Ellipsis option for the site. If you select Yes, an ellipsis button displays next to the field when users 
are allocating their expenses. Clicking the button allows users to choose from a list of valid codes. 

8. Complete steps 3 through 7 for every allocation field. 
9. Click Finish. The Set Up Allocation page displays. 

 

Creating and assigning valid codes 
Assuming that validation is enabled in the site setup, and the appropriate permissions are assigned, administrators 
can complete the following tasks: 

• Create and edit valid allocation codes (See "To create and edit valid codes" on page 116) 
• Configure allocation validation field codes (See "Configuring allocation validation" on page 118) 
• Import valid allocation codes (See "To import valid codes from an external file" on page 121) 

You can also use Online Card Management to export the valid codes from the application to an external file (see topic 
on page 124). 
 

115 

 



 

To create and edit valid codes 
If validation is enabled for your site, you can create new codes by typing them into entry fields or by importing them 
from an external file, or you can search for existing codes and edit them. 
Accessing the Create and Edit Codes page 

1. Open the Create and Edit Codes page by completing one of the following: 
From the Set Up Allocation page, click the Create Valid Codes link in the Create and Assign Valid Codes section. 

• From the Configure Validation page, click Create and Edit Codes. The Create and Edit Codes page 
displays. 

 
Figure 101: Create and Edit Codes page 

2. From the Allocation Field list, select the field for which you want to create or edit  
existing codes. 

Entering new codes for the selected allocation field: 
Note: If you want to import valid codes from an external file, do not complete this step. Click Import and refer to the 
task "To import valid codes from an external file (on page 121). 
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3. Click Add New Code. A Add New Code dialog will display. 

 
Figure 102: Create and Edit Codes- new code fields 

 
4. Click the plus sign ( + ) next to add more codes. 
5. Enter the code descriptions. Continue adding valid codes for each field. 
6. Click Add. 
7. When you finish entering valid codes, click Update. 

Editing existing codes for the selected allocation field: 
Note: You can also export existing codes to an external file. See "To export codes to an external file (on page 124). 

8. Expand the Edit Existing Codes For section bar to expand the section. 

 
Figure 103: Create and Edit Codes page- Edit codes 

9. From the Search by list, select the field you want to use as search. 
10. Select which codes to display: active, inactive, or both. 
11. In the Search for field, enter a value to use as the search criteria. 

Tip: Remember that you can use a wildcard (*) for beginning or ending characters, or both. 
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12. Click Search. Online Card Management displays a list of existing codes. 

 
Figure 104: Create and Edit Codes- search results 

13. You can modify the description for any code, activate or deactivate a code, or remove a  
code entirely. 

14. When you finish editing codes, click Update. 
 

Configuring allocation validation 
Configuring validation consists of creating a list of valid allocation codes for the user to select from, and assigning that 
list to an allocation field. Valid codes can be assigned to a single account or unit, or to multiple accounts or units. 
Complete the following task to configure allocation validation. 
 

To configure validation for a single account or unit 
Note: If you are configuring validation for more than one account or unit, see "To configure validation for multiple 
accounts or units (on page 120). 
To configure single account or unit validation: 
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1. From the Administration menu, select Set Up Allocation. The Set Up Allocation page displays. 
Note: If you administer more than one site, you must first select a site as described in "To search for a site 
(on page 33). 

2. Click Configure validation. The Configure Validation page displays. 

 
Figure 105: Configuration Validation page 

3. If you need to create new, or edit existing codes, click Create and Edit Codes. See "To create and edit valid 
codes (on page 116). When you complete that task, you can return to this page. 

4. Find the desired account or unit. The Allocation Field section of the page displays, displaying the validation 
fields for the specified account or unit. 

 
Figure 106: Allocation Field- configure validation 
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5. Complete the following steps to find valid codes for the selected unit or account. 
a. From the Allocation Field list, select the allocation field you want to configure. 
b. From the Search by list, select the field to use for the search. 
c. In the Search for field, enter a value to search for (remember that you can use a wildcard (*) for 

beginning or ending characters, or both) and click Search. The list of available valid codes to choose 
from displays. 

d. Select the Assigned check box in the column for all valid codes. 
e. If you want to apply the validation to the selected units, select the Yes option for Apply to Subunits. 
f. Note: The Apply to Subunits option is not applicable when working with accounts. This option is only 

available when you select a unit. 

6. When finished selecting codes, click Save Changes. 
7. Repeat steps 3 through 7 as necessary. 

 

To configure validation for multiple accounts or units 
Note: If you are configuring validation for one account or unit, see "To configure validation for a single account or unit 
(on page 118). 
To configure multiple account or unit validation: 

1. From the Administration menu, select Set Up Allocation. The Set Up Allocation page displays. 
2. If you administer more than one site, you must first select a site as described in "To search for a site (on 

page 33). 
3. Click the Configure validation link in the Create and Assign Valid Codes section. The Configure Validation 

page displays. 

 
Figure 107: Configuration Validation page 
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4. If you need to create new, or edit existing codes, click Create and Edit Codes. See "To create and edit valid 
codes (on page 116). When you complete that task, you can return to this page. 

5. Select the Assign valid codes to multiple accounts/units option. 
6. Find the desired accounts or units. The Allocation Field section of the page displays, displaying the validation 

fields for the specified accounts or units. 
7. Complete the following steps to select valid codes 

a. In the Search by list, select the field you want to use for your search. 
b. In the Search for field, enter a search value. 
c. Click Search. The list of available valid codes to choose from displays. 
d. Select the valid codes from the Available box, and click Add to Selected. 
e. To modify codes in the Selected box, you can click the Remove icon for any code to remove it, or click 

Remove All to remove all codes. 

8. Click Save Changes when you are finished selecting codes. 
 

To import valid codes from an external file 
If validation is enabled for Administration > Set Up Allocation your site, you can import valid codes from either a text 
(.TXT) or comma separated (.CSV) format external file. The file can be in either delimited (with or without a header) or 
fixed field format without a header. Any other file types will not be recognized. 
Note: Make sure your file is formatted correctly before you import the codes into Online Card Management. See 
"Working with default code upload files" for further instruction on file formats. 

1. From the Administration menu, select Set Up Allocation from the menu. The Set Up Allocations page opens. 
2. Click Create Valid Codes the Create and Edit Codes page displays. 
3. Click Import. The Import Allocation Codes page displays. 
4. From the Step 1: Select File section, click Browse. The Choose file dialog displays. 
5. Locate the import file and select it. In the Step 2 section, if you have previously saved import settings, you 

can select them from the Saved settings list 
6. Click Next. A sample of the source file and the Step 3 section displays. 
7. To define the format of the source file: 

a. If the file is delmited fields, do the following: 
 Select the Delimited from the File format option. 
 If a text qualifier is used in the import file, select it from the list. 
 If the first row of the import file contains column names, select the First row has column 

names check box at the bottom of the dialog. 
 Click Next. The Step 4 and 5 sections display. Proceed to step 9 of this topic. 

b. If the file format is fixed length fields, do the following:  
 When you select "Fixed length field" from the File format option, all delimiter fields are 

disabled. Click Next to open step 4. 
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 Select the number of columns to add to the grid (this dhould equal the total number of 
columbs in the import file) and click Go. The column order grid displays. 
 Type the column name and length for each column in the same sequence as they display 

in the import file (left to right). 
 When you finish, click Next. Step 5 displays. 

8. To map each column in the import file to the corresponding destination: 
a. Select the Allocation Field from the Destination Columns list that corresponds to each columns in 

the import file. 
b. To save all import settings (with the exception of the dile name and path) select the Save Import 

Settings check box and type a name for the settings. The next time you import allocation codes, 
you can select these parameters from the Saved settings list in Step 2. 

9. In Step 5, select one of the following options: 
a. Select “Append” to keep all existing allocatin codes and their assignments and add the imported 

codes to the existing list. You will have to ssign all newly imported coudes using in configure 
validation. If code already exists in the database, the code in the import file wil not be used. 

b. Select “Update” toreplace the description for all codes. If a description for the code exists in the 
database it will be replaced with the description in the import file. 

c. Select “Add/Update/Delete” to add new codes, update descriptions o existing codes, and delete any 
codes that are not in the import file. 

d. Select “Delete and replace” to delete all existing codes and replace them with the imported codes. 
Important: If you select the "Delete and replace" option, all existing codes and their assignments will be 
deleted and replaced with the imported codes. You will have to assign all imported codes using Configure 
validation. 

10. Click Finish. The process Import dialog opens. If there are incosistencies or mismatched fields, you will be 
alerted before the import process continues. You can view the import in the Import Log 

Note: It may take a while for the import process to complete. The import must be complete before you can assign the 
imported codes. The import complete before you can assign the imported codes. To view the details of the import, see 
"To view import details (on page 123). 
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To view import details 
1. From the Administration menu, select View Import Log. The Import Log page displays. 

 

 
Figure 108: Import log page 

2. Find the import item from the list. 
Tip: If the import does not display or the status is "Pending," click Refresh Status. 

3. Click the  icon for the import you want to view details. The File Download dialog displays. 
4. Download the file and view the import results. The ImportResults.txt file contains summary-level details of the 

import. 
Note: Even when the import is successful, duplicate codes or had other errors may exist. 
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To export codes to an external file 
1. View the list of valid codes as described in "To create and edit valid codes (on page 116). 
2. Click Export. The Export Valid Codes dialog displays. 

 

 
Figure 109: Export Valid Codes dialog 

3. Select which codes to export: active, inactive, or both by selecting the appropriate option. 
4. In the Name field, enter a name for the export file. 
5. Select the columns you want to include in the export file. 
6. From the Delimiter list, select the character you want to use as a delimiter, if you want to use a delimiter in 

the export file. 
7. Click Run Export. 

You can retrieve the export from the Output Log. See the task "Using the Output Log (on page 320), for the 
procedure. 
 

Working with default code import files 
You can import a list of default codes and descriptions into Online Card Management allocation from an external file. 
The import process can upload data from an external fixed-length or delimited file. You can use a either delimited files 
or fixed-length files to import codes and code descriptions. If you choose to import codes through a delimited file, you 
can include a column header. 
This section discusses how to format can upload the following default codes types: 

• Accounts 
• MCC 
• Point of Sale 

 

124 

 



 

Formatting import files for account default allocation codes 
You can import default account allocation codes through either fixed length files or delimited files. Use the following 
file format audit rules when creating your import file.  

Using a delimited file for importing account default allocation codes: 
• File must contain the default codes and account number for each row in the file. 
• You can use commas, tabs, or pipes as delimiters between columns.  
• Create one import file for all of the default account codes you want to import. 
• You can choose to include a header row to label the columns in the file. 
• Online Card Management only creates account default codes for accounts that are in both the 

database and the import file. 
• The allocation code lengths in the file cannot exceed the limits you defined. See "To position 

fields and create labels (on page 109) for more information on defining filed lengths. 
• The required fields can be arranged in any column order and the first row may not contain a 

column header. 
• Random audits are performed during the import process. When a data error is identified, a 

warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a comma delimited file without a column header: 
9999999999999999,133,8523652,1456 
6666666666666666,133,2563254,9634 
2222222222222222,132,5624541,1542 
7777777777777777,136,5633333,8888 

• The following is a sample of a comma delimited file with a column header: 
Card Number,Company,Account,Cost Center 
9999999999999999,133,8523652,1456 
6666666666666666,133,2563254,9634 
2222222222222222,132,5624541,1542 
777777777777777,136,5633333,8888 

Using a fixed length file for importing account default allocation codes: 
• File must contain the default codes and account number for each row in the file. 
• The fixed-length file format does not support column headers. 
• Create one import file for all of the default account codes you want to import. 
• Online Card Management only creates account default codes for accounts that are in both the 

database and the import file. 
• The field lengths in the file cannot exceed the limits you defined. See "To position fields and 

create labels (on page 109) for more information on defining filed lengths. 
• The required fields can be arranged in any order. 
• If an error is identified in the required fields, the entire file fails and is not imported. 
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• Random audits are performed during the import process. When a data error is identified, a 
warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a fixed length file: 
999999999999999913385236521456 
666666666666666613325632549634 
222222222222222213256245411542 
777777777777777713656333338888 

 

Formatting import files for MCC default allocation codes 
You can import default MCC allocation codes through either fixed length files or delimited files. Use the following file 
format audit rules when creating your import file.   

Using a delimited file for importing account default allocation codes: 
• File must contain the default codes and four digit MCC code for each row in the file. 
• You can use commas, tabs, or pipes as delimiters between columns.  
• Create one import file for all of the default MCC codes you want to import. 
• You can choose to include a header row to label the columns in the file. 
• Online Card Management only creates account default codes for MCC codes that are in both 

the database and the import file. 
• The allocation code lengths in the file cannot exceed the limits you defined. See "To position 

fields and create labels (on page 109) for more information on defining filed lengths. 
• The required fields can be arranged in any column order and the first row may not contain a 

column header. 
• Random audits are performed during the import process. When a data error is identified, a 

warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a comma delimited file without a column header: 
3000,133,8523652,1456 
5947,133,2563254,9634 
5811,132,5624541,1542 
5814,136,5633333,8888 

• The following is a sample of a comma delimited file with a column header: 
MCC Code,Company,Account,Cost Center 
3000,133,8523652,1456 
5947,133,2563254,9634 
5811,132,5624541,1542 
5814,136,5633333,8888 

Using a fixed length file for importing account default allocation codes: 
• File must contain the default codes and four digit MCC code for each row in the file. 
• The fixed-length file format does not support column headers. 
• Create one import file for all of the default MCC codes you want to import. 
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• Online Card Management only creates MCC default codes for accounts that are in both the 
database and the import file. 

• The field lengths in the file cannot exceed the limits you defined. See "To position fields and 
create labels (on page 109) for more information on defining filed lengths. 

• The required fields can be arranged in any order. 
• If an error is identified in the required fields, the entire file fails and is not imported. 
• Random audits are performed during the import process. When a data error is identified, a 

warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a fixed length file: 
300013385236521456 
594713325632549634 
581113256245411542 
581413656333338888 

 

Formatting import files for Point of Sales default allocation codes 
You can import default Point of Sale (POS) allocation codes through either fixed length files or delimited files. Use the 
following file format audit rules when creating your import file.   

Using a delimited file for importing account default allocation codes: 
• The file must contain the default code and the four digit POS code (the code passed by the 

merchant) for each row in the file. 
• You can use commas, tabs, or pipes as delimiters between columns.  
• Create one import file for all of the default POS codes you want to import. 
• You can choose to include a header row to label the columns in the file. 
• The allocation code lengths in the file cannot exceed the limits you defined. See "To position 

fields and create labels (on page 109) for more information on defining filed lengths. 
• The required fields can be arranged in any column order and the first row may not contain a 

column header. 
• Random audits are performed during the import process. When a data error is identified, a 

warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a comma delimited file without a column header: 
A6665,133,8523652,1456 
PO556,133,2563254,9634 
B777,132,5624541,1542 
A23,136,5633333,8888 

• The following is a sample of a comma delimited file with a column header: 
Point of Sale,Company,Account,Cost Center 
A6665,133,8523652,1456 
PO556,133,2563254,9634 
B777,132,5624541,1542 
A23,136,5633333,8888 
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Using a fixed length file for importing account default allocation codes: 
• The file must contain the default code and the four digit POS code for each row in the file. 
• The fixed-length file format does not support column headers. 
• Create one import file for all of the default MCC codes you want to import. 
• The field lengths in the file cannot exceed the limits you defined. See "To position fields and 

create labels (on page 109) for more information on defining filed lengths. 
• The required fields can be arranged in any order. 
• If an error is identified in the required fields, the entire file fails and is not imported. 
• Random audits are performed during the import process. When a data error is identified, a 

warning message displays, allowing the user to choose whether they want the import process 
to proceed or cancel the so they can fix the import file.  

• The following is a sample of a fixed length file: 
A666513385236521456 
PO55613325632549634 
B777 13256245411542 
A23  13656333338888 

 

Setting default allocations 
The steps in this task create the allocation rules and set the order in which they are applied to transactions. The 
following tasks are required to create the allocation rules and order: 

• Establish default types (See "To establish default types" on page 128) 
• Match types with fields (See "To match types with fields" on page 129) 
• Assign default field values (See "To assign default field values" on page 130) 

 

To establish default types 
Select the default allocation types (account, expense type, MCCs, merchants, point of sale code, or unit) for which you 
want to create allocation rules. 
Note: This task assumes that you have already Defined Fields and Settings (see topic on page 109) and Created and 
Assigned Valid Codes (see topic on page 115). If you are the administrator for more than one site, you must first 
select the site for which you are establishing default allocation types. 
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1. From the Set Up Allocation page, click the Select Default Types link in the Set Default Allocations section. 
The Select Default Types page displays. 

 
Figure 110: Select Default Types page 

2. Select the allocation types you want to use from the Available box (or click Select All to select all allocation 
types) and click the right arrow button. 

3. Specify the order of the allocation types by highlighting a type in the Selected box and clicking Move Up or 
Move Down. 

4. Repeat step 3 until the allocation types in the Selected box are in the order you want them applied. 
Note: Remember applying an allocation rule overwrites the previously assigned codes, so that the last 
allocation code for any segment applies. 

5. Click Next to open the Match Types with Fields page. See "To match types with fields (on page 129) for the 
steps required to complete this page. 

Alternatively, you can click Continue Later to save your current selections and exit the setup process. To resume the 
setup process at a later time, see the task "Resuming the allocation setup process (on page 133). 
 

To match types with fields 
Associate the allocation types selected in the previous task with the allocation fields from your default allocation string 
from the Match Types with Fields page: 
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Note: This task assumes that you have already established default types (see topic on page 128). If you are the 
administrator for more than one site, you must first select the site for which you are establish default allocation types. 

 
Figure 111: Match Types with Fields page 

1. For each allocation type (left column), you can assign default values for any number of the allocation fields 
(such as company, department, and cost center). Select the check boxes for the allocation fields to which the 
default values associated with those types are applied. 
For example, you might create an allocation rule that applies default values for Company and Department 
(and ignores Cost Center, GL, and Project) for a specified unit and create another allocation rule that applies 
default values for Cost Center (and ignores the other allocation fields) for a specified list of accounts. 

2. After you have finished making all selections, click Next. 
 

To assign default field values 
Use the Assign Default Field Values page to assign the default field values you want to assign for each allocation 
type: account, expense type, merchant category code (MCC), point of sale, or unit. 
Note: This task assumes that you have already matched types with fields (see topic on page 129) and that you have 
the Assign Default Field Values page open. 

1. Select an Allocation Type. 

 
Figure 112: Assign Default Field Values page 
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2. If you select Unit, you must also choose whether to display units by list or hierarchy. 
3. From the Search by list, select a field to use as your search criteria. 
4. In the Search For field, enter a search value. 

Tip: You can use a wildcard (*) for beginning or ending characters. For example, if you enter "Smith" the 
results might include Smith, Smithe, Smithsonian, and Nesmithe. Leave the field blank to display all. 

5. Click Search. The items (accounts, expense types, MCCs, merchants, point of sale codes, or units) matching 
your search criteria are displayed. 
You can re-sort the search results by clicking a column heading. 

6. Select an item and enter the default allocation value. You can select from a list of allocation values by 
clicking on the selection icon (  ). Click OK to save selection and return to Account Search Results. 

7. Click Save. The default field valie is applied to your selection. 
8. If you select Unit, and specify to display units in a hierarchy: 

a. Expand the hierarchy and click on a unit to select it. 
b. Enter the default allocation values. You can select from a list of allocation values by 

clicking on the selection icon ( ). Click OK to save selected and return to Account 
Search Results. 

c. If the unit has subunits and you want to apply these values to the subunits, select Yes from 
the Include Subunits option. 

d. Click Save. The default field values are applied to the selected units.  

9. If you select Expense Types, you can click the See Codes icon for any item to view a list of the MCC codes 
that are included in that expense type. 

 
Figure 113: Assign Default Field Values- Expense Type Search Results 
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10. If you select Account, Expense type, MCC, Merchant or Unit (list), you can assign default allocation values 
for multiple items, as follows: 

a. Select the items and click Batch Update. 

 
Figure 114: Enter Default Values for (field) 

b. Enter the default allocation values. See the task "To allocate a transaction (on page 308), 
for instructions. 

c. Click Update. 
d. To reset all default allocation values for the items in the search results list to the last saved, 

click Undo. 

11. If you select Point of sale, you can add new point of sale codes, as follows: 
a. Select the number of new codes to add and click Go. The entry section displays. 

 
Figure 115: Point of Sale fields 

b. Enter the new code, description, and default allocation values. See the task "To allocate a 
transaction (on page 308) for instructions for entering values into the allocation fields (Cost 
Center and GL in the example above). 

c. Click Update & Return. 

12. To assign default allocation values for individual items: 
a. Enter the default allocation values for individual items in the search results list. See the 

task "To allocate a transaction (on page 308) for instructions. 
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b. Click Save. 
c. To reset default allocation values to the last saved for a single item, click the corresponding 

Reset icon. 

13. To reset all default allocation values in the search list click Undo. 
14. Repeat the steps above for each allocation type for which you want to create allocation rules. 
15. After you assign all default allocation values click Done. 

 

Resuming the allocation setup process 
To resume the setup process at a later time, or to make changes to the completed site allocation setup: 

1. Otherwise, choose Administration > Set Up Allocation. The Set Up Allocation page displays. 
Note: If you are the administrator for more than one site, you must first select a site. 

2. Click the link for the step you want to resume from a previous session, or to modify  
completed steps. 
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Creating and Modifying Users 
Only active user IDs can log on to Online Card Management. The system security prevents unknown and potentially 
malicious users from accessing the application and viewing private information. As an administrator, you are 
responsible for maintaining the users that can access your site and what functions they can use the site to complete. 
User information includes name and email address, user ID, and branding and location ID (to associate the user with 
a site). A user also has permissions assigned to his or her User ID. These permissions are set for that user by 
assigning a default security profile or through specially-defined individual permissions and control what tasks the user 
can complete in Online Card Management. No one can access your site without a valid user ID and an assigned set of 
permissions. 
This chapter contains the following sections: 

• Creating a user (see topic on page 135) 
• Working with user access permissions (see topic on page 142) 
• Searching for existing users (see topic on page 147) 
• Modifying a user (see topic on page 149) 
• Importing multiple users (see topic on page 152) 

 

Creating a user 
There are several procedures you need to perform to manually create a user in Online Card Management. If you do 
not complete all the procedures, the user will not be able to access Online Card Management. The following steps are 
required to create a new user: 

1. Enter basic user information. 
2. Select a hierarchy location and site branding for the user. 
3. Create a unique user ID and password. 
4. Assign permissions to the user. 
5. Give the user an approval profile for his or her expense reports. 

To successfully create a new user, you must complete all the steps listed above. Each step is explained in detail in 
subsequent procedures in this chapter. 
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Step 1: Enter basic information 
1. Select Administration >Manage Users > Maintain User Information from the menu. The Search for Users 

page displays. 

 
Figure 116: Search for Users page 

2. Click Add New User. The Edit Personal Information for New User page displays. 

 
Figure 117: Edit Personal Information- new user example 
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3. In the First name field, enter the user's first name as you want it to display on the Home page when the user 
logs on to Online Card Management. This is a required field. 

4. In the Last name field, enter the user's last name as you want it to display on the Home page when the user 
logs on to Online Card Management. This is a required field. 

5. Select a Product Notification option. 
6. In the Email address field, enter the email address or addresses for this user. Online Card Management 

sends email notification messages to this address, if you selected the appropriate option to do so. This is a 
required field. 

7. In the CC Email address field, enter an email address or addresses to which the Online Card Management 
sends copies of the statement availability email. 

8. In the BCC Email address field, enter an email address or addresses to which the Online Card Management 
sends blind copies of the statement availability email. 
Tip: You can enter multiple email addresses in any of the email fields by separating them with semicolons, 
for example: jdoe@bigcompany.com;john_doe@myhome.org 

9. Continue the create new user process by selecting a hierarchy location and specifying site branding 
information, as described in "Step 2: Specify Location and Branding Information (on page 137). 

Important: You cannot save the new user information at this point. If you quit the create user process now, Online 
Card Management does not save the data you have entered to this point. 
 

Step 2: Specify Location and Branding information 
Note: You must complete "Step 1: Enter basic information (on page 136) before you can begin this procedure. 

1. Verify that the basic user information is accurate. 

 
Figure 118: Location and Branding 
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2. Click Select Location. Your hierarchy displays in a popup window. 

 
Figure 119: Select Unit from Hierarchy 

3. Select the unit or subunit (node) from the hierarchy to which this user belongs. 
Note: When you assign a user to a location on the hierarchy, you are granting the user access to view data 
for the nodes below it on the hierarchy. For a complete understanding of the hierarchy, see "Understanding 
the Hierarchy (See "Understanding hierarchy terminology" on page 345). 

4. Click Select Branding. The hierarchy displays in a popup window. 
5. Select the site from the hierarchy that has the appropriate product branding for the user. 

Note: The site you select for branding purposes also controls the rules that control the user's User ID and 
password. 

6. Continue the Create a User process by creating a User ID and password for the user (See "Step 3: Create a 
valid user ID and password" on page 138). 

 

Step 3: Create a valid user ID and password 
Note: You must complete "Step 2: Specify Location and Branding information (on page 137) before you can begin this 
procedure. 
Complete the following in the User Information section of the Edit Personal Information page: 

1. Verify that the selected location and branding information are accurate. 
2. In the User ID field, enter a user ID for this user according to the ID requirements for the organization to 

which the user belongs. This is a required field. 
Note: The site you selected to use for the user's branding settings determines the required properties for the 
User ID and Password. 
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Figure 120: Edit Personal Information- user information 

3. In the Password field, enter a password for this user according to the password requirements for the 
selected site. The Password field is case-sensitive and required. 
Tip: For information on the User ID and password requirements, refer to the Info Icons next to the 
corresponding fields. The Info Icons do not contain any instructions unless the Branding field contains a 
value. 

4. In the Confirm Password field, re-enter the password. 
Note: If there is any difference between the values you enter in this field and the value in the Password field 
(including capitalization), an error message displays when you save. The Confirm Password field is case-
sensitive and required. 

5. Choose the appropriate Logon Status options: 

• Select Yes to enable the logon so that Online Card Management will recognize the user's User ID and 
Password as valid. This is the default. 

• Select No to temporarily disable this user's logon. 

6. Continue the Create a User process by completing one of the following: 

• If the Approvers for User's Expense Report section displays on the page, complete "Step 4: Assign 
expense report approvers to the user (on page 139). 

• If the Approvers for User's Expense Report section does not display on the page, click Save. Skip Step 4 
and complete Step 5: Specify User Permissions. 

 

Step 4: Assign expense report approvers to the user 
Note: You must complete "Step 3: Create a valid user ID and password (on page 138) before you can begin this 
procedure. 
Important: Depending on your site's settings, the Approvers for User's Expense Report section may not display. If this 
is the case, skip to Step 5. 
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1. Verify that the user ID and password options are valid. 
2. From the Approvers for User's Expense Report section, click Add Approvers the Select Approvers page 

displays. 
3. Search for the approvers you want to add to this user's profile. 

 
Figure 121: Select Approvers page 

4. Select the check box next to users you want to add as approvers. 
5. Click Add Selected. The Approval Profile list dialog opens if the user selected does not have an approval 

profile assigned to them. 
6. The Approval Profile list dialog opens if the user selected does not have an approval profile assigned to 

them. 
7. Click OK to close the Approle profile list dialog. The new approver is listed. The approval profile columns 

displays a message reminding you to assign an approval profile to the new approver. 
8. From the Approval Profile, select the profile you want the approver to apply for this user. The Approval 

Profile determines the user's role in approving expense reports for this user. 
Note: The approval profile assigned to the approver only applies to the user you are creating. Approvers can 
have different profiles for different users. 

9. Click Save to save the changes to the user's personal information. 
 

Step 5: Specify user access permissions 
Note: You must complete either "Step 4: Assign expense report approvers to the user (on page 139) (if applicable to 
your site settings) or "Step 3: Create a valid user ID and password (on page 138) before you can begin this procedure. 
Complete the following procedure to assign permissions to a new user. For information on changing permissions for 
an existing user and more information on how permissions work, see "Modifying Users (See "Modifying a user" on 
page 149). 
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1. Begin the add access for a new user process by completing one of the following: 

• Click Save from the Edit Personal Information page (as described in Step 3 or Step 4). A message 
displays asking if you want to add access to the new user. Click Yes. 

• Click the Add Access link at the bottom of the Edit Personal Information page. 
The Access for [User] page displays. 

 
Figure 122: Access for [user] page 

2. Click Add Access. The Add Access page for this user displays. 
3. Choose a Select By option to indicate whether you want to select a Unit, Account, or User to control the 

user's access. 

• Unit- Select this option to assign Security access to all accounts within the unit. You can also assign the 
user as an approver for expense reports created for accounts within  
the unit. See "Working with approval profiles (on page 92) for information on  
approval profiles. 

• Account- Select this option to assign access to the specific account without referencing a hierarchy 
location. 

• User- Select this option to assign the user as an approver for all of the user's accounts. You can also 
assign security access for a user to administer other users' profile. See "Working with approval profiles 
(on page 92) for information on approval profiles. 

4. Select the desired unit, account, or user from the hierarchy. The selection displays in the Selected Items list 
at the bottom of the page. 
Tip: You may need to scroll to view this information. 

5. Select a profile from the Security Profile list. 
6. Select the unit or account options: 

• If this is a unit, you can select the Include Subunits check box to indicate that the same permissions 
apply to the user's profile to the subunits of the selected unit. 
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• If this is an account that has not been registered by another user, you can select the Make Owner check 
box to register this user to the account. See "Working with user security profiles (on page 72) for more 
information. 

7. Select a profile from the Approval Profile list. See "Working with approval profiles (on page 92) for 
information on approval profiles. 

8. Click Add. The Access page displays, with the new permissions shown. 
9. When you have specified the fields and completed the steps above, click Save. The new user profile is 

saved.  
The new user is created and the user can log into Online Card Management using the User ID and password you 
assigned to him or her. 
 

Working with user access permissions 
Each user must be assigned permissions that define the tasks that users can perform. Permissions (sometimes called 
privileges) might allow the user to perform administration tasks, manage card accounts, or view reports and other 
information. Access permissions let the user perform tasks specific to an account, unit, or user. User access 
permissions are assigned to a user by assigning user security profile and customizing permissions if necessary. 
Online Card Management lets administrators assign permissions to users through the  
following methods: 

• Assign one of the default security profiles to the user. Default security profiles include Bank 
Administrator, Bank-level User, Organization Administrator, Organization Manager, and Account Holder. 
See "Working with user security profiles (on page 72) for complete descriptions of the profiles available 
to you. Each default profile includes commonly used permissions. You can modify the individual 
permissions in a default profile to suit the needs of the organization. 

• Create and name a custom user security profile, as described in "Defining custom security profiles", and 
assign that profile to the user. 

• Tailor a set of permissions for an individual user. Individual permissions override the permissions defined 
in a profile. 

Default and custom security profiles are described in detail in "Working with user security profiles (on page 72). That 
section includes a description of each default security profile, as well as the procedure for creating or modifying a 
custom security profile. 
The following section describes three user tasks: 

• Adding or modifying permissions 
• Tailoring permissions for an individual user 
• Adding another set of permissions for a different account, unit, or user 
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To tailor individual permissions 
1. Select  Administration >Manage Users > Maintain User Information from the menu. The Search for Users 

page displays. 
2. Enter user search criteria in the appropriate fields and click Search. A list of users that match your search 

criteria displays. 
3. From the search results, click the Details icon in the Details column for the user you want to update. The Edit 

Personal Information page displays. 
4. Go to the Security and Approval Access tab, select the account for which you want to edit access. The 

Access for [User] page displays, showing existing permissions. 

 
Figure 123: Access for [user] page 

The Access page displays the following information: 

• Accounts, units, and users to which this user has permissions. 
• The security profile that defines the permissions that the user has for each account, unit,  

or user. 
• The approval profile assigned to the user. This determines the user's role in approving expense reports. 
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5. To modify the existing permissions the user has for an account, unit, or user, select the appropriate row from 
the Access for [User] page. The Security Profile section displays displaying the permissions for the selected 
row. 

 
Figure 124: Access for [User] page- Security Profile section 

The security profile that defines the permissions displays in the Security Profile list. All the permissions that 
exist for the profile either as defined by default or as modified apply to the selected account, unit, or user. 

6. Click the plus sign ( + ) next to a set of permissions to expand the list, and select either Grant or Deny next 
to an individual permission to grant or deny that permission. An asterisk ( * ) designates the profile's default 
permission level. 
Note: Depending on the permission, the options may also include Hide, Display, and Edit rather than Grant 
or Deny. 

7. Modify the permissions for the selected user as necessary. You can do so using one of the following 
methods: 
• Modify the individual permission for this user's profile. 
• Assign a different security profile to the user. Select a profile from the Access Profile list. The list of 

individual permissions changes to reflect permissions in the profile you chose. 
Note: Only profiles applicable to this site display in the list. 

 
Figure 125: Security Profile list 

8. Click Save when you finish defining permissions for this user and this account, unit, or user. The Access 
page for this user re-displays, and you can define other permissions as required. 
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To add or modify access permissions 
Use the list of existing permissions to view the current permissions assigned to a selected user ID. From this list you 
can modify existing permissions, or add permissions for another account, unit,  
or user. 

1. Select Administration > Manage Users > Maintain User Information from the menu. 
2. Enter user search criteria in the appropriate fields and click Search. A list of users that match your search 

criteria displays. 
3. From the search results, click the Details icon in the Details column for the user you want to update. The Edit 

Personal Information page displays. 
4. Go to the Security and Approval Access tab, select the account for which you want to edit access. The 

Access for [User] page displays, showing existing permissions. 

 
Figure 126: Access for [user] page 

5. Click Add Access. The Add Access page for this user displays. 
6. Choose a Select By option to choose whether you want to select a Unit, Account, or User. 

• Unit- Select this option to assign Security access to all accounts within  
the unit. You can also assign the user as an approver for expense reports created for accounts within 
the unit. See "Working with approval profiles (on page 92) for information on  
approval profiles. 

• Account- Select this option to assign access to the specific account without referencing a hierarchy 
location. 

• User- Select this option to assign the user as an approver for all of the user's accounts. You can also 
assign security access for a user to administer other users' profile. See "Working with approval profiles 
(on page 92) for information on approval profiles. 
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Figure 127: Add Access for User search results 

7. Select the desired unit (or account or user), from the hierarchy. The selected account, unit, or user displays 
in the Selected Items list at the bottom of the page. 
Note: You may need to scroll down to view this information. 

 
Figure 128: Add Access for User hierarchy selection 

8. Select a profile from the Security Profile list. 
9. Select the unit or account options: 

• If this is a unit, you can select the Include Subunits check box to indicate that the same permissions 
apply to the user's profile to the subunits of the selected unit. 

• If this is an account that has not been registered by another user, you can select the Make Owner check 
box to register this user to the account. See "Working with user security profiles (on page 72) for more 
information. 

10. Select a profile from the Approval Profile list. See "Working with approval profiles (on page 92)  for 
information on approval profiles. 

11. Click Add. The Access page displays, with the new permissions shown. 

Note: Click the corresponding  icon to delete any account, unit, or user from the list. 
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Searching for existing users 
To view or edit an existing user's information, you must first find them in Online Card Management. When you work 
with a user's information, you must use the Search For Users page to find the user information. Once you select the 
desired user from the Search For Users page, you can select the individual user to modify his or her information. You 
can also export the information shown in the Search Results list to a location that you can specify. 
 

To search for a user 
1. Select Administration > Manage Users > Maintain User Information from the menu. The Search for Users 

page displays. 

 
Figure 129: Search for Users page 

2. Specify some or all of the following search criteria. The search performance increases by providing as much 
information as possible. 
Important: Use leading or trailing wildcard characters (*) in partial text searches only. Do not embed a 
wildcard character within a text search string. 

• Bank Number - Enter the bank number in this field. You can only enter numbers in this field. Up to 4 
digits can be used. No wildcard characters are permitted. The field is only visible are bank level or 
above. 

• Corp number - Enter the corporation number assigned to a user's organization in this field. You can 
only enter numbers in this field. Up to 8 digits can be used. No wildcard characters are permitted. The 
field is only visible are bank level  
or above. 

• Corp name - Enter the corporation name of the user's organization in this field. Alphanumeric wildcard 
searches are permitted. The field is only visible are bank level or above. 

• User ID - Enter the user's logon ID he or she uses to log on to Online Card Management in this field. 
Alphanumeric wildcard searches are permitted. 

147 

 



 

• First name - Enter the user's first name in this field. Alphanumeric wildcard searches  
are permitted. 

• Last name - Enter the user's last name in this field. Alphanumeric wildcard searches  
are permitted. 

• Status - Select the user's status option. 
• Email address - Enter the user's email address in this field. Alphanumeric wildcard searches are 

permitted. 
• Notification recipient - Select the user's product notification setting. 

3. Click Go. All users matching the value you specified display in the Search Results list. 
 

To use the Search Results list 
If your search is successful, one or more users are displayed in the Search Results list: 

 
Figure 130: Search for Users- results 

The Search Results list is displayed in last name order. 
You can perform the following tasks on this page: 

• Reorder the results display: Click the column heading by which you want to reorder the display. The 
list is reordered in ascending order, based on that column. Click the column heading again to reorder in 
descending order. 

• Page through a multi-page list of results: The results initially shown on a page may not represent the 
entire set of results. Click a page link at the bottom of the list to further  
search results. 

• Delete a user: Click the Delete icon next to the user listing. A warning message displays. Click OK to 
continue with the delete or Cancel to discontinue the delete. 

 CAUTION: Deleting a user is a permanent action. There is no way to recover a deleted user. 

• Modify the user's information or permissions: Click the Edit link, to modify user or permissions 
information. The Edit Personal Information page displays. 

• Emulate a user: Click the Emulate icon next to the user listing. The user emulation  
page displays. 

 

148 

 



 

To emulate a user 

To emulate a user, you click the user's emulate icon ( ). Online Card Management logs you on with the 
permissions and access assigned to that user. The Emulation Session notice displays at the top-right of the user 
screen with emulated user listed in the "You are emulating:" section of the notice. 

 
Figure 131: User Emulation in Progress indicator 

If you are emulating a user, you can make any changes to their account that their access and permissions allow. 
Depending on the site settings, you can, for example, reallocate or split transactions or create expense reports. All 
changes are saved as though the user made them. 
During an emulation session, both you and user can log on to the user's account simultaneously. In this case, any 
changes made by you or the user will not display on the other's computer screen unless they are manually refreshed 
by pressing F5 (Internet Explorer). It is recommended that if you and the user are logged on at the same time, real-
time communications, either telephone or instant messaging, be established so each of you is aware of what the other 
is doing. 
After a period of inactivity, a session time-out occurs. 

 
Figure 132: Session time out pop-up 

Select Yes to renew the emulation session with the user. Click No to end it. 
Important: To terminate the emulation session, click the End link in the Emulation Session dialog. The Search for 
Users page displays with a notification that the user emulation session has ended. 
 

Modifying a user 
You can modify information for an existing user, including resetting the user's password. 
You can also customize permissions for this user. For information about customizing permissions, see "Working with 
user permissions (see topic on page 142). 
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To modify user information 
1. From the Search Results list, click the Detail icon for the user whose profile you want to modify. The Edit 

Personal Information for [User] page displays. 

 
Figure 133: Edit Personal Information- existing user example 

2. In the Edit Profile page, modify user information in the following fields: 
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Contact Information 
First name 

Enter the user's first name. This displays on Online Card Management's Home page. 

Last name 

Enter the user's last name. This displays on Online Card Management's Home page. 

Notification Recipient 

You can use this setting as a search criterion when searching for users. 

Email address 

Enter the email address for this user. Online Card Management sends email notification messages for this 
user to this address. 

CC email address 

Enter an email address to which Online Card Management sends copies of statement availability 
notifications. Separate multiple addresses with semicolons. 

BCC email address 

Enter an email address to which Online Card Management sends blind copies of statement availability 
notifications. Separate multiple addresses with semicolons. 
Note: You can enter more than one address in any of the email fields by separating addresses with 
semicolons, for example: 
jdoe@bigcompany.com;john_doe@myhome.org 

Location and Branding 
Location 

Enter the default location with which this user is associated. Click Select Location and select a unit or 
subunit from the hierarchy. 

Tying the user to a particular site enables management options. 

Branding 

Enter the site that shows the appropriate product branding for this user. Click Select Branding, and select a 
site from the hierarchy. 

The Branding value also controls the user ID and password rules that apply to this user, as well as the 
user's default security profile. 

Logon ID and Password 
Logon ID 

Enter a user ID for this user according to the ID requirements for this organization. Hold the cursor over the 
Information icon next to the Logon ID field to see a list of user ID rules in effect for your organization. 
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Note: The user ID rules (and the password rules) are those of the site in the Branding field, above. This 
information is not available unless the Branding field contains a value. 

Logon Status option 

Select Inactive to disable this user's logon temporarily. (Alternative setting is Active.) 

Select Unlocked to unlock a user's logon after the user has accidentally locked the logon by repeated 
unsuccessful logon attempts. ("Locked" is the alternative setting.) 

3. Click Save. Online card management saves the modified user information. 
 

To reset the user password and security questions 
To reset the password from the Personal Information page, click Reset Password. If password email notification is 
active for the user's branding site, an email is sent to the user containing a new, randomly generated password. 
Otherwise, the new password displays and must be communicated to the user. The user must change the password 
after logging on to Online Card Management. 
To reset the user security questions from the Personal Information page, click Reset Security Questions. Online 
Card Management resets the user's security questions. The next time the user attempts to logon on to Online Card 
Management, the user must re-enter his or her additional security questions and answers. 
 

To export user information from the Search Results list 
You can export the list of users shown in the entire Search Results list (all pages) to a tab-delimited text file (.TXT) for 
viewing or printing. 

1. Use the Search for Users page to find the set of users for whom you want to export information. 
2. With the Search Results list displayed, click Export All. A file download dialog displays. 
3. Click Save. A Save As dialog displays. 
4. Enter a file name and location, and click Save. The user information file saves to the  

specified location. 
 

Importing multiple users 
If you need to create multiple users, you can import the user information using an import file instead of entering each 
user into Online Card Management individually. The Import Users tool lets you import cardholders, expense report 
approvers, and organization managers. The process for importing each type of user differs slightly but the User Import 
process walks you through the necessary steps for each, making the process of creating multiple users of any type 
easy to complete. 
 

To import users into online card management 
The following procedure describes the user import process. The individual steps of the import process vary depending 
on the type of user you are importing. Use the on-screen instruction and the Info Icons to guide you through the 
process specific to your user import type. 
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1. Select Administration > Manage Users > Import Users from the menu. Step 1 of the user import process 
displays. 
Note: If you are the administrator for more than one site, you must first select a site into which you are 
importing users. 

 
Figure 134: Import Users page- step 1 

2. Select a Type of User to Import option. 
3. Click Browse. The Choose file dislog displays. 
4. Navigate to your file using te dialog navigation control. 
5. Select import settings from the Saved settings list. 
6. Click Next to continue. The next step of the wizard, “Step 2: Source File Format,” displays. 

 
Figure 135: Import Users page- steps 2 & 3 

Note: If you select Expense Report Approver or Organization Manager in step 2, your application will not 
display the same fields as display the figures in this document. 
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7. Verify the file information and specify the qualifiers if applicable. 

• If the selected file is a TXT or CSV file, select the appropriate values from the Delimiter and Text 
qualifier lists. 

• If the selected file is an XLS file, these fields do not display. Verify the information in the sample window. 

8. Select the First row has column names check box if the first row of the file is a header row and does not 
include actual users you want to import. 

9. Verify that the information that displays in the sample field matches the file you want to import. 
10. Click Next. Step 3 of the import users process displays. 

 
Figure 136: Import Users page- step 3 

11. Choose the appropriate settings options: 

• If the import file contains Default User Access Profile column that you want to use, select the Use 
Default User Access Profile check box and select the appropriate value from the User Access Profile 
list. 

• If you want to save the settings you use in this import for future use, select the Save Imports Settings 
check box and enter a name for the settings you are saving in the Name of Setting field. 

• If you want to override the card ownership settings with the card ownership information in the file, select 
the Use Default Card Ownership Setting check box and select either Yes or No to indicate if you want 
to make each user the owner of their own card. 
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12. For each Destination column list, select the type of information included in the corresponding source 
column. For example, select User ID from the Destination column list for the LOGIN_ID import column. 

13. Click Next. Step 4 of the import user process displays. 
 

 
Figure 137: Import Users page- step 4 

14. Verify the data that displays on the page. 
Tip: If you have any errors, hover over the corresponding for an explanation of the error and click Revalidate 
after you have corrected the error. 

15. Click Import. The users import into online card management. 
 

Understanding user import files 
The Import Users tool works as a wizard that guides you through each step of the process. This wizard is an easy-to-
use tool that saves you time and get your users up and running quickly. You can import from a delimited text file (.txt), 
a comma-separated values file (.csv), or a Microsoft Excel® file (.xls). 
Tip: You can also import additional information about the user into Online Card Management using an import file. For 
example, a BCC email address can be imported via an import file. 
The file you are importing must include the following information for each user: 

• Last Name 
• First Name 
• User ID 
• Password 
• Email 
• User Access Profile 
• Account number 

155 

 



 

• Owner of card flag (whether or not the user is the owner of his or her card) 

The required information for importing cardholders, expense report approvers, and organizational managers varies 
slightly. Each file must have its own format and specific information. The following topics explain how the import 
process works in Online Card Management. 
 

Required fields for Cardholder import file 
To import new cardholders into online card management, the following data must exist in a delimited text file (.txt), a 
comma-separated values file (.csv), or a Microsoft Excel® file (.xls). 

Field Required Max Length Restrictions/Description 

Last Name Y 50 Cardholder last name. Map to "Last Name" destination 
column. 

First Name Y 50 Cardholder first name. Map to "First Name" 
destination column. 

Logon ID Y 25 Cardholder logon ID. Map to "User ID" destination 
column. 

Password Y 25 Cardholder password. Map to "Password" destination 
column. 

Email Address Y 60 Cardholder email address. Map to "Email" destination 
column. 

CC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "CC Email" 
destination column even if the value is blank. 

BCC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "BCC Email" 
destination column even if the value is blank. 

User Access Profile * 255 * If the "Use Default User Access Profile" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, the default values determine the default 
settings. If the "Use Default User Access Profile" 
option is not selected, this column is required in the 
import file and must be mapped to the "User Access 
profile" destination column. 

Account Number Y 16 Numeric values only. Map to "Account Number" 
destination column. 

Owner * 1 
(Y or N) 

*If the "Use Default Card Ownership Setting" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, Online Card Management overwrites 
the values with the default settings. If the "Use Default 
Card Ownership Setting" option is not selected, this 
column is required in the import file and must be 
mapped to the "Owner of Account" destination 
column. 
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Required fields for Expense Approver import file 
To import new expense report approvers into the online card management application, the following data must exist in 
a delimited text file (.txt), a comma-separated values file (.csv), or a Microsoft Excel® file (.xls). 

Field Required Max Length Restrictions/Description 

Last Name Y 50 Cardholder last name. Map to "Last Name" destination 
column. 

First Name Y 50 Cardholder first name. Map to "First Name" 
destination column. 

Logon ID Y 25 Cardholder logon ID. Map to "User ID" destination 
column. 

Password Y 25 Cardholder password. Map to "Password" destination 
column. 

Email Address Y 60 Cardholder email address. Map to "Email" destination 
column. 

CC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "CC Email" 
destination column even if the value is blank. 

BCC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "BCC Email" 
destination column even if the value is blank. 

User Access Profile * 255 * If the "Use Default User Access Profile" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, the values will be overridden by the 
default settings. If the "Use Default User Access 
Profile" option is not selected, this column is required 
in the import file and must be mapped to the "User 
Access profile" destination column. 

Approver Profile *  *If the "Use Default User Approval Profile" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, the values will be overridden by the 
default settings. If the "Use Default User Approval 
Profile" option is not selected, this column is required 
in the import file and must be mapped to the 
"Approver Access Profile" destination column. 

Bank Number Y 4 The four-digit bank number. 

Level 1 Number Y 8 The corporation number. If numbers are less than 
eight characters, they must be right-justified and 
padded with leading zeros to make eight-character 
numbers. 
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Field Required Max Length Restrictions/Description 

Level 2 Number  8 Blank if not applicable. Use, as required, to describe 
the corporation's processor hierarchy. If numbers are 
less than eight characters, they must be right-justified 
and padded with leading zeros to make eight-
character numbers.  
Important: The "Level 2 Number" through "Level 8 
Number" columns must exist, with delimiters, in the 
import file and be mapped to the corresponding 
destination columns even if the values are blank.   

Level 3 Number  8 See Level 2 above. 

Level 4 Number  8 See Level 2 above. 

Level 5 Number  8 See Level 2 above. 

Level 6 Number  8 See Level 2 above. 

Level 7 Number  8 See Level 2 above. 

Level 8 Number  8 See Level 2 above. 

Submitter Logon Y 25 Each person in the hierarchy who can submit expense 
reports to this approver must have a single file line. 
The Expense Approver information will repeat, except 
for the unique Submitter Logon, for each submitter in 
the hierarchy. Map to "Submitter User ID" destination 
column. 

 
 

Required fields for Organization Manager Import file 
To import new organization managers into Online Card Management, the following data must exist in a delimited text 
file (.txt), a comma-separated values file (.csv), or a Microsoft Excel® file (.xls). 

Field Required Max Length Restrictions/Description 

Last Name Y 50 Cardholder last name. Map to "Last Name" destination 
column. 

First Name Y 50 Cardholder first name. Map to "First Name" 
destination column. 

Logon ID Y 25 Cardholder logon ID. Map to "User ID" destination 
column. 

Password Y 25 Cardholder password. Map to "Password" destination 
column. 

Email Address Y 60 Cardholder email address. Map to "Email" destination 
column. 

CC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "CC Email" 
destination column even if the value is blank. 
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Field Required Max Length Restrictions/Description 

BCC Email Address  50 Blank if not applicable. The column is required in the 
import file and must be mapped to the "BCC Email" 
destination column even if the value is blank. 

User Access Profile * 255 * If the "Use Default User Access Profile" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, Online Card Management overwrites 
the values with the default settings. If the "Use Default 
User Access Profile" option is not selected, this 
column is required in the import file and must be 
mapped to the "User Access profile" destination 
column. 

Approver Profile *  *If the "Use Default User Approval Profile" option is 
selected in Step 5 of the import wizard, this column is 
not required in the import file. If the column exists in 
the import file, the values will be overridden by the 
default settings. If the "Use Default User Approval 
Profile" option is not selected, this column is required 
in the import file and must be mapped to the 
"Approver Access Profile" destination column. 

Bank Number Y 4 The four-digit bank number. 

Level 1 Number Y 8 The corporation number. If numbers are less than 
eight characters, they must be right-justified and 
padded with leading zeros to make eight-character 
numbers. 

Level 2 Number  8 Optional. Use as required to describe the corporation's 
processor hierarchy. If numbers are less than eight 
characters, they must be right-justified and padded 
with leading zeros to make eight-character numbers.  
The "Level 2 Number" through "Level 8 Number" 
columns must exist in the import file and be mapped 
to the corresponding destination columns even if the 
values are blank.   

Level 3 Number  8 Optional. See Level 2 above. 

Level 4 Number  8 Optional. See Level 2 above. 

Level 5 Number  8 Optional. See Level 2 above. 

Level 6 Number  8 Optional. See Level 2 above. 

Level 7 Number  8 Optional. See Level 2 above. 

Level 8 Number  8 Optional. See Level 2 above. 

Account Number Y 16 Numeric values only. Map to "Account Number" 
destination column. 

Owner * 1 
(Y or N) 

*If the "Use Default Card Ownership Setting" option is 
selected in Step 5 of the import wizard, this column is 
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Field Required Max Length Restrictions/Description 
not required in the import file. If the column exists in 
the import file, Online Card Management overwrites 
the values with the default settings. If the "Use Default 
Card Ownership Setting" option is not selected, this 
column is required in the import file and must be 
mapped to the "Owner of Account" destination 
column. 
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Using Online Statements 
This section describes how to view, download, and print online statements.  
This chapter contains the following sections: 

• Viewing an account summary (see topic on page 161) 
• Viewing a transaction list (see topic on page 163) 
• Viewing account statements (see topic on page 165) 
• Viewing authorizations and declines (see topic on page 171) 

 

Managing your account 
Typically, account holders perform statement and payment tasks for their own accounts. Depending on their 
permissions, administrators may be able to view statements for other accounts in their departments or elsewhere, as 
well as for their own accounts. This section includes information for both administrators and account holders. 
As an account holder, depending upon your permissions, you can perform the following tasks.  

• View account summary 
• View transaction list 
• View account statements 
• View authorizations and declines 

Note: Depending upon your organization's system settings or your permissions, one or more tasks may be disabled. 
 

Viewing an account summary 
Use the Account Activity page to view the account summary information for your accounts or the accounts that you 
manage in Online Card Management. 
 

To view an account summary as an administrator 
1. Select Statements > Account Activity from the menu. The Account Activity page displays displaying a 

combination of the following tabs: 

• Accounts I Manage 
• Search for Statements 

2. Select the Accounts I Manage tab. 
3. From the Search Account list select one of the following: 

• Account Number 
• Name on Account 
• Unit Number 
• Unit Name 
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4. Specify additional information in the Search Account field. You can use an asterisk ( * ) as a leading or 
trailing wildcard character in partial searches. 

5. Click Search. The list of accounts that match your search criteria displays below. 

 
Figure 138: Account Activity- Accounts I Manage tab 

From the account list, find the account for which you want to view transactions and click Details. The account 
summary information displays. You can view additional information by clicking Expand Details (+) below each 
section. 

 
Figure 139: Account Activity Details 

 

To view the account summary for your account 
1. Select Statements > Account Activity from the menu. The Account Activity page displays displaying a 

combination of the following tabs: 
• Summary (selected by default) 
• Transactions 
• Authorization Requests 
• Statements 

2. The Account Details page for your account displays. You can view additional information by clicking Expand 
Details (+) below each section. 
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Viewing a transaction list 
You can view a list of individual transactions for this account for the current month or previous months. Use the 
Account Details page to view transaction data for you and the accounts that you manage. 
 

To view the transaction list as an administrator 
1. Select Statements > Account Activity from the menu. The Account Activity page displays displaying a 

combination of the following tabs: 
• Accounts I Manage 
• Search for Statements 

2. Select the Accounts I Manage tab. 
3. From the Search by list, select your search criteria. You can use any of the following criteria to find an 

account: 
• Account Number 
• Name on Account 
• Unit Name 
• Unit Number 

4. In the Search for field, enter a search value. 
5. Click Search. The list of matching accounts that you manage displays. 

 
Figure 140: Account Activity- Accounts I Manage tab 
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6. From the account list, find the account for which you want to view transactions and click Details.  
7. Click the Transactions tab. The transactions for the current cycle are displayed by default. 

 
Figure 141: Account Details—Transactions tab 

8. You can select a different statement cycle from the Statement cycle list. The transaction list will populate 
automatically. You can print the listed transactions by clicking Print This Page.  

9. You can also download the transactions in a variety of formats by selecting the format from the Download 
format list and clicking Download. A file download dialog displays which will allow you to specify the 
download location on your local drive.  

Important: When downloading transaction data, commercial financial software, such as QuickBooks® or Microsoft ® 
Money, require a specific data format which may not be intuitive when the delimited files are downloaded and opened 
in a spreadsheet. With these files, all transactions will have a negative sign representing the amount taken away from 
the credit limit. Credits or payments are positive or the amount added to the credit limit. This format is opposite of the 
representation on the screen where transactions are positive and payments or credits are negative. 
 

To view the transaction list as an account holder 
1. Select Statements > Account Activity from the menu. The Account Activity page displays displaying a 

combination of the following tabs: 
• Summary (selected by default) 
• Transactions 
• Authorization Requests 
• Statements 
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2. Click the Transactions tab. The Account Details page for your account displays. You can view additional 
information by clicking Expand Details (+) below each section. 

 
Figure 142: Account Details expanded 

 

Viewing account statements 
The previous tasks let you view summary information and individual transaction information for an account. You can 
also view and download the complete account statement, in Adobe® Acrobat® Portable Document Format (PDF) 
format. 
Note: The Adobe Acrobat Reader software must be installed on your computer to view a statement. Visit 
http://www.adobe.com to download this free software. 
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To select an account to view statements 
1. Select Statements > Account Activity from the menu. The Account Activity page displays  

 
Figure 143: Account Activity page 

2. Specify account search criteria in the Search Account field. You can select the following from the Search 
Account list: 
• Name on Account 
• Unit Name 
• Unit Number 
You can use an asterisk (*) as a leading or trailing wildcard character for partial searches. 

3. Select additional account search criteria by selecting one or more of the following search filters: 

• Active accounts 
• Inactive within 45 days 
• Inactive longer than 45 days 
• Purged 
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4. Click Search. The search results display below. 

 
Figure 144: Account Search results 

5. Locate the account and click Details. The Account Details page displays. 

 
Figure 145: Account Details page 

The Account Details page has four tabs. You click on these tabs for additional information. 

• Summary (displayed by default) 
• Transactions 
• Authorization Requests 
• Statements 
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6. Select the Statements tab. All statements associated with the account display. 

 
Figure 146: Account Details Statements 

7. See the task "To view, print, and download the statement” (on page 170). 
 
 

To search for statements 
You can use the Account Activity page to search for available statements. 

1. Select Statements > Account Activity from the menu. The Account Activity page displays. 

 
Figure 147: Account Activity page 
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2. Select the Search for Statements tab.  

 
Figure 148: Account Search 

3. In the Bank Number field, enter a bank number for your search. This field is required. 
4. You can choose to enter additional search criteria in any of the following optional search fields. 

• Unit Number 
• Unit Name 
• Name on account 
• Account number 

5. In the Date Range fields, enter a start and end date for your search. You can use the calendar control (  ) 
to select a Start and End Date. 
Note: The date range is limited to a month unless you specify an account. 

6. Click Search. The list of statements that match your search criteria displays below. 
7. Download the statement you want to view (see To view, print, and download the statement on page 170). 
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To view, print, and download the statement 

Click the  icon next to the statement you want to view. The File Download dialog opens. 
To view the statement: 

1. Select Open to open this file from its current location. The statement opens in the Adobe Acrobat Reader. 
2. To print the file, choose File > Print from the Acrobat Reader menu. 
3. When you finish viewing the statement, close the Adobe Acrobat Reader. 

To download the statement file: 
1. Click Save from the file download dialog. 
2. Enter the location where you want to save the file and click Save. You can open the PDF file from the 

location where you saved it. 
3. Click Close to close the Download Complete dialog. 

To download all statements: 
1. Click Download Statements. The Download All Files message displays. 
2. Select a Format option. 

• If you select Single File, all the statements in the Statement search will display in  
one PDF file. 

• If you select Multiple File, each statement displays in its own PDF file. All of these files are compressed 
into a single ZIP file. 

3. In the File Name field, enter the name you want to use for the statement file or files. 
4. Click OK. The download displays in the Current Downloads section. When the file is complete, the file status 

changes to Ready. 

5. Click the  icon. The Windows File Download dialog displays. 
6. Save the file to your local hard drive. 
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Viewing authorizations and declines 
 

Searching for authorizations and declines 
1. Select Statements > Account Activity from the menu. The Account Activity page displays  

 
Figure 149: Account Activity page 

2. Specify account search criteria in the Search Account field. You can select the following from the Search 
Account list: 
• Name on Account 
• Unit Name 
• Unit Number 
You can use an asterisk (*) as a leading or trailing wildcard character for partial searches. 

3. Select additional account search criteria by selecting one or more of the following search filters: 
• Active accounts 
• Inactive within 45 days 
• Inactive longer than 45 days 
• Purged 
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4. Click Search. The search results display below. 

 
Figure 150: Account Search results 

5. Locate the account and click Details. The Account Details page displays. 

 
Figure 151: Account Details page 

The Account Details page has four tabs. You click on these tabs for additional information. 

• Summary (displayed by default) 
• Transactions 
• Authorization Requests 
• Statements 

6. Click the Authorization Requests tab. The Authorization Request tab lists all authorization requests for this 
account. You can filter the authorization results by selecting one of the following classifications and clicking 
Search. 
• All (displayed by default) 
• Approved 
• Declined 
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• Referred 
• Fraud 
• Pickup 

7. You can further narrow your search by specifying a date range. Type the date using the MM/DD/YYYY 
format in the From  and To fields  or use the calendar controls (  ) to specify a date range. The search 
results display below. 

 
Figure 152: Account Details- Authorizations RequestsTab 

8. Click Details to view additional information about the authorization request. 

 
Figure 153: Account Details- Authorizations Details
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Managing Accounts 
An organization's administrators can search for accounts, create new accounts, and modify existing account 
information. Additionally, administrators can view and manage requests to change account information called program 
change requests. 
Organization administrators generally perform account management tasks. However, a  
bank-level administrator can also perform these tasks for accounts in any organization assigned to that administrator. 
This chapter contains the following sections: 

• Searching for accounts (on page 175) 
• Creating a new account or modifying account information (on page 180) 
• Working with Temporary Credit Limit controls (see topic on page 193) 
• Managing program change requests (on page 204) 
• Maintaining Card Models (see topic on page 211) 
• Working with account alerts (see topic on page 214) 

Note: You can upload accounts into a site (see topic on page 92) that you have manually created. 
 

Searching for accounts 
You can search for accounts by account number or by the name on the account. You can search for a single account 
or multiple accounts. Search results are displayed in a Search Results list. Only accounts to which you have security 
access are displayed. 
After you have located one or more accounts, you can view or modify an account, delete an account, or export the 
Search Results list of accounts to a tab-delimited text file. 
Depending on your access privileges, some search fields described below may not display. If the field does not 
display, proceed to the next field description. 

Searching without the wildcard character 
These search features were instituted to increase the performance and reliability of account searches. These search 
features no longer require a wildcard character for partial searches. The only exception to this rule is summarized in 
number 8 below.  
The following points apply: 
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1. Wildcard characters (*) are no longer necessary for partial searches. 
2. A text search string must contain the first character or characters of elements in the search string and all 

individual elements in the search string must be separated by spaces. The more complete the search string 
components, the more accurate the search. 

3. Partial account number searches work with the last digits of the account number. 
4. The application pads partial unit number searches with leading zeros to make eight digits. For example, “18” 

and “180” will return different results (00000018 vs. 00000180). 
5. Text searches preceded by wildcard characters will no longer return expected results. For example, the wild 

card search, “*son”, which, in the past, would return, “Anderson” or “Johnson” will not return those results. 
The wildcard character is ignored so the results returned would contain “Sonya Smith”, “JB Smith and Sons”, 
or “Eric Sonnet”. (See # 2 above). 

6. Wildcard searches using the last characters or middle characters return nothing. For example, looking for 
"Johnson" - *son returns nothing but J, Jo, Joh, will return Johnson. 

7. The individual elements of the search string can be entered in any order. For example, “ John Dean Smith” is 
equivalent to “Smith John Dean” or “Dean Smith John”. 

8. Special case: When a search string is followed by a wildcard, the string is executed in that order. For 
example: “James Smith And*” will return “James Smith Anderson” not “James Anderson Smith” 

 
Examples: 
Note: The Unit Name search behaves like the Name on Account searches illustrated below. 

Search type Search string entered Example search results returned 

Name on Account 
 

"S" "M" 
 

M Scott Jones 
Michael S Thomson 
Mark Smith 
Sandra J Mitchell 

Name on Account 
 

"SM" "J" 
 

Connie J Smith 
Joan D Smith 
Bernard P Smith Jr. 
Mary Ann Smith-Jones 
Small Jobs Limited 

Name on Account 
 

"SM" "J" "S" 
 

Stephan J Smith 
Stephen Smith Jr. 
A. J. Smith & Son Const 

Name on Account 
 

"SA" "J" "SMITH" or "SMITH" 
"SA" "J" or "J" "SMITH" "SA" 

Sam P Smith Jr. 
Sandra J Smith 

Name on Account 
(Leading and imbedded 
wildcard characters are 

"*SON" Sonya Smith 
James Song 
Smith and Sons 
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Search type Search string entered Example search results returned 
ignored) 
Account Number 
 

"4521" All accounts ending with 4521 
111111******4521 

Account Number 
 

"64521" 
 

All accounts ending with 64521 – The 
“6” is masked - This greatly reduces 
the number of search results. 
111111******4521 

   
Account Number 
 

"264521" 
 

All accounts ending with 264521 – 
The “2” and “6” are masked - This 
greatly reduces the number of search 
results. 
111111******4521 

Unit Number 
 

"18" 
 

Unit number 00000018 
 

Unit Number 
 

"018" 
 

Unit number 00000018 
 

Unit Number 
 

"180" 
 

Unit number 00000180 
 

Unit Number 
 

"15180" 
 

Unit number 00015180 
 

 
 

To search for accounts 
1. Select Accounts > Manage Accounts from the menu. The Search page displays. 
Note: The illustration below displays all fields available. Depending on your level in your hierarchy,  a subset of 

the following fields displays. 
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Figure 154: Search for Account page 

2. Type the information into the following fields. Bank Number is the only required field, however, search 
performance is enhanced by entering data in as many fields as possible. Bank administrators with access to 
one bank will not see the Bank Number field. 
Note: Users with access to ten or fewer accounts will have all accounts displayed. 

• Bank Number (User with access to multiple banks) - This field is required. Type the four digit bank 
number. 

• Unit Name (User with access to multiple units) -Type the unit name. You must use a minimum of three 
characters in this field and you can use an additional asterisk (*) as a leading or trailing wildcard 
character. 

• Unit Number (User with access to multiple units) - Type the 8 digit unit number. You must use a 
minimum of three numbers in this field and you can use an additional asterisk (*) as a leading or trailing 
wildcard character. 

• Subunit name (User with access to an organization with a hierarchical unit structure) - Type the subunit 
name. You can use an asterisk (*) as a leading or trailing wildcard character. 

• Subunit number (User with access to an organization with a hierarchical unit structure) - Type the 
subunit number. You can use an asterisk (*) as a leading or trailing wildcard character. 

• Account name - Type the account name. You can use an asterisk (*) as a leading or trailing wildcard 
character. 

• Account number - Type numbers in either the prefix or the suffix fields, or both. Type a minimum of five 
digits in the prefix and four digits in the suffix fields. Wildcard characters are not allowed in either of 
these fields. 

• Account status code -Type the two characters of account status code. Wildcard characters are not 
allowed. 

178 

 



 

3. Select whether to view active, inactive within 45 days, inactive longer than 45 days, or purged accounts. 
4. Click Search. Online Card Management displays the search results in the Search Results list. If more 

accounts are located than fit on the page, you can page through the remaining results by clicking the links at 
the bottom of the page. 

 
Figure 155: Account search results 

Important: The Available Balance field reflects the available account balance as of the previous night's 
processing. Charges made against the account on the current day are not reflected in this amount. 

Tip: The search results sort by the name on the account. You can click any column heading in the list of 
accounts to sort the list in that column's ascending order. Click the heading again to sort in descending order. 

5. To view detailed information for any account, click the Details icon ( ) link to display the Account 
Management page for that card account.. 

 

To export search results to a file 
You can export the list of located accounts in the Search Results list to a coma separated values file (.CSV), and store 
that file on your computer. All located accounts  and displayed fields are included in the export file.  You can open the 
file in Microsoft Excel or another program. 

1. With the Search Results list displayed, click Export All. A File Download dialog displays. 
2. Click Save. A dialog displays asking you to whether you want to open the file or save it to your computer. 

• If you click Open, the Accounts.csv file opens in the program you have designated as the registered 
program to read CSV files such as Microsoft Excel. Once the file is open, you can view or edit 
information and save it to your PC. 
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• If you click Save, a dialog opens where you can specify the location to which you want to save the 
export file and a name for the file. Online Card Management creates the file and saves to the specified 
location. 

 

Creating a new account or modifying account information 
As an administrator you may be responsible for creating new accounts, or modifying existing account information as 
necessary. You must have the appropriate access permission to create a new account or modify an existing account. 
If your site uses real-time functionality, some or all of the changes  
you make to accounts and the accounts you create are effective immediately upon saving the information. 
For some organizations, real-time account creation and update is not available for certain account information fields or 
it may not be available at all. See your financial institution or organization administrator to learn whether real-time 
creation and update is available for your organization. If real-time is available, new accounts and updates to existing 
accounts can be created in real time or manually. Real time fields are indicated by shading. 
 

To create a new account 
3. To create a new account, on the Search for Account page click Add New Account.  

 
Figure 156: Add New Account button 

4. If your company has multiple hierarchy units defined for groups of cards, such as geographic region or 
departments, the Select Location for New Account page is displayed. If your company does not have units 
defined, skip to step 5. You can search for a unit by selecting either Unit Name or Unit Number from the 
drop-down list and specifying unit information for the location you wish the new card to be assigned to in the 
associated field. You can use an asterisk (*) as a leading or trailing wildcard character in partial searches. 

 
Figure 157: Select Location for New Account 

5. Click Search. The search results are displayed below. You can click the Hierarchy icon (  ) to display the 
unit location with your hierarchy 

6.  Select the unit and click Next. The Account Management for New Account page is displayed. 
If you have created card models to streamline your new card creation process, select the card model from the 

Select Model/Template list and click Apply Model. The fields defined in the card model are applied.   
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Figure 158: Select Model 

7. Complete any additional or required account management fields. See Account Data Fields below for more 
information. 

8. When all fields are complete, click Submit  (located at the bottom of the page) to submit the request real-
time. Click Submit with Note to open a dialog. This is where you choose the request delivery method 
(manual or real-time), attach a note of up to 250 characters, and select whether the note is marked important.   

 
Figure 159: Submit 

 

To modify existing account information, or specify new account information 
With account management, you can review, and with appropriate permissions,  change information (such as 
addresses, card limits, etc.) for the card accounts associated with your user ID.   

If you have access to only one active account, the account is displayed when you access the Account 
Management page. The following guide contains detailed information about fields that can be displayed for 
the card. Card account fields that can be updated are highligted in yellow.   
 
Account Data Fields 
Important: The data fields associated with accounts are dependent  on specifications set by your financial institution.  
If the fields displayed in your application do not match those described in this help topic, contact your financial 
institution for assistance. Required fields are marked with an asterisk (*).  
Depending on your financial institution’s specifications, the Account Management page could contain the following 
sections. Check the online help topic, Creating of modifying accounts, for information about additional sections and 
fields.  
• Card Information 
• Address Information 
• General information 
• Account Holder Information 
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• Account Status 
• Authorization 
• Merchant Category Code Group (MCCG) Authorizations 

1. Select an existing account to modify, as described in "To search for accounts (on page 177), or create a new 
account, as described above. If you are modifying an existing account, in the Search Results list, on the line 
showing the account you want to modify, click the Details icon ( ) link. The Account Management page 
displays. 

 
Figure 160: Account Management page 

For information about using the program change request functions, see "Managing program change requests 
(on page 204). 

2. Enter new account information or modify existing information in the following fields. 
The sections on this page are expandable. When you first open the page, the expanded Card Information 
section displays. Click the expand icon (  ) to expand another section, or the collapse icon (  ) to 
collapse an open section. 
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Figure 161: Account Management page- Card Information section 

Card Information 
• Account Number (shown for both new account creation and existing account modification):  Account 

number for the card. The account number cannot be modified. 
• Card line 1: Name on the card account, as it appears on the card. Do not use punctuation. Use an 

asterisk (*) after the first name or middle initial but before the last name to ensure proper alphabetization 
of names. If the name on the card does not include a person's name, place and asterisk at the end of the 
line. For example: 
 John Q*Adams 
 Alex*Hamilton 
 Jefferson Resources* 

•  Card line 2: Additional account information that is displayed under Card line 1. Typically used to display 
the organization name. Do not use punctuation. 

•  Master Accounting Code: Default account allocation code to be assigned to transactions made with 
the card. Contact your bank representative about how you can use information in this field. 
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Address Information 

 
Figure 162: Account Management - Address section 

If multiple addresses are defined for the card, a Show Address Status option is displayed. Selecting one of the 
following options will change the display of addresses for the account. 

• Active - This option displays the active addresses with the Card, Correspondence, and Statement 
statuses. 

• Card - This is typically the address that the plastic card is sent to. 
• Correspondence - The address for any general correspondence. 
• Statement - The address for the monthly statement. 
• Inactive - Any inactive addresses. 
• All - All addresses for the account are displayed. 

Up to nine card addresses are set at the processor. You cannot add additional addresses, but you can modify existing 
address parameters. To modify a parameter, enter the information in the appropriate editable field and click Submit. If 
the field is highlighted yellow, the modification is sent real-time. White fields send the modification using a manual 
program change request (PCR). 
The following fields are displayed for address support.  

• Address Line 1: Billing or identifying addresses for the account. Do not use punctuation. 
Address Line 2 
Address Line 3  
Address Line 4 

• City: City for the account address. Do not use punctuation. 
• State/Province: Two-character state or province code for the account address. 
• Postal code: Postal code or ZIP Code for the account address. Do not use hyphens or spaces. For a 

ZIP Code, enter either the 5-digit or 9-digit code. For information about non-U.S. addresses, contact your 
financial institution. 

• Country: Country for the account address. Select the country name from the drop-down list. 
• Email Address: Account holder’s email address. 
• Home Phone:  Account holder's home telephone number. 
• Work Phone:  Account holder's work telephone number. 
• Additional Phone: - Additional phone number for the account holder, if required. 
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• Fax Number:-Account holder's fax number. 
Note: For the account holder's home, work, and fax numbers, specify the full telephone number. Do not use 
hyphens, spaces, parentheses, or other punctuation. Example 3035551234 
 

General Information 

 
Figure 163: Account Management- General Information section 

Some or all of the following fields display in this section (fields are listed here in alphabetical order): 
• Location: Department or division associated with the account. This field is used primarily for reporting.  
• Company ID: Processor's billing system ID number for the site the account is assigned to. Contact your 

financial institution for more information. 
• ACE option set: ACE option set for the account. Contact your financial institution for more information 
• Client Product Code: Bank Client Product Code for the account. Contact your financial institution for 

more information. 
• Account type: Type of account. The new account is created as Individual. 
• Bill type: Determines whether the account balance is paid by the organization or the individual assigned 

to the account. Your corporate account determines the bill type for the new card account. Possible 
values are Central and Individual. 

• Number of Cards to Request: Number of plastic cards to be created for the account 
• Card Mailer Delivery Type: Method used for plastic card delivery. Hover your cursor over the Info icon 

for the code descriptions. 
• Language Code: Indicates the primary language of the account. 
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• Print Statement Option: Indicates the statement delivery option for the account. 
• Card Option Set: 4-digit code for the card processing option set applied to the account. Contact your 

financial institution for more information. 
• Mailer Option Set: 4-digit code for the card mailer option set applied to the account. Contact your 

financial institution for more information. 
• Card Hold Code: Client-defined code that indicates the hold code for plastic card delivery. Contact your 

financial institution for more information. 
• Graphic ID: Indicates whether the Graphic ID option on the plastic card will be set using corporate 

default values. 
• Graphic ID Option: Indicates which graphics are printed on the plastic card during the embossing and 

encoding routines. 

 
Account Holder Information 

 
Figure 164: Account Management page- Account Holder Information section 

The following fields are displayed for account holder support.  
• Employee ID: Account holder's company issued number. You can use numerals, letters, punctuation, 

and spaces. 
• Activation Password: Security password used for activation or verification. 
• Date of birth: Birth date of the account holder. Select the date from the drop-down lists. 
• Unique Identifier: Account holder identifier that is used for verification. Depending on site settings, 

examples can include Social Security Number (SSN), Social Insurance Number (SIN), or other 
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identifiers. Use numerals only, without hyphens, spaces, or other punctuation. This field can have a 
maximum of 10 characters. 

Note: The label of the Unique Identifier field can be different, depending on the setting specified in the 
Custom Label field during site setup. 
• Routing # (checking or savings): Bank routing number of the checking or savings account specified in 

the Account # field. For a new non-individual bill account, leave this field blank. 
• Account # (checking or savings): Checking or savings account number (also known as a Demand 

Deposit Account number). For a new non-individual bill account, leave this field blank. 
 

Account Status 

 
Figure 165: Account Management page- Account Status section 

The following fields are displayed for account status support.  
• Expiration date: Date the account expires (YYYYMM). 
• # of Cards Outstanding: - Number of plastic cards that have been issued for the account. Accounts 

with 0 (zero) cards outstanding cannot order replacement cards. 
• Order replacement card:  Click this button to order new cards (plastic) for the account. See below for 

information on how to order replacement cards*. 
• Request new cards: Indicates whether to request new cards (plastic) for the account.  
• Account status: Status of the account. Multiple statuses are listed in reverse chronological order. 
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• Request PIN Number: Option that indicates whether to have the system generate a personal 
identification number (PIN) and mail it to the cardholder's primary address. A confirmation box will 
display the address to which the mailer will be sent. 

• Current status: Current status of the account. 
*To order replacement cards for an account: 

1. In the Account Status section, click Order replacement cards. A dialog box opens. 

 
Figure 166: Order Replacement Card dialog box 

2. Specify the number of cards to be issued in the # of cards requested field. 
3. Select the request for new plastic method, Manual or Real-time. 
4. Select the card delivery method: Standard, Express, or Fast. 

Note: Real-time must be enabled for your site to send the request real-time.  If real-time is not enabled, the 
request is sent manually. 

5. Type a note in the Note field, if required. This note is sent to the card issuer along with the request. You can 
flag the note as important by selecting the Mark this note as important checkbox. 

6. Click OK. The request for replacement plastic is sent to the card issuer. You can view the status of a manual 
request by selecting Accounts>View Program Change Requests from the menu and searching for the 
request. 
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Authorization 

 
Figure 167: Account Management page- Authorization section 

The following fields are displayed for authorization support.  

Card Limits 
• Account option set: Authorization option set to be assigned to the account. Select from a drop-down 

list.  
Note: This field is only available if Account Authorization Option Sets, on Site Setup, is set to Display. 

• Card: Total charge amount allowed for this card, in whole numbers only, and no punctuation. For 
example, type 5000 for five thousand dollars. 

• Single purchase: Maximum monetary amount allowed for a single purchase, in whole numbers only 
and no punctuation. For example, type 5000 for five thousand dollars. 

• Cash advance %: Percentage or monetary amount of the total card limit allowed for cash advances. Do 
not include decimals or punctuation. 

Cycle Limits 
For each of the cycle limit fields, leave the field blank or enter 0 (zero) to indicate that the field is not used. 

• Cycle Amount: Total spending amount allowed per cycle. 
• Cycle # of Transactions: Total number of purchases allowed per cycle. 
• Daily Amount: Total spending amount allowed per day. 
• Daily # of Transactions: Total number of purchases allowed per day. 
• Monthly Amount: Total spending amount allowed per month. 
• Monthly # of Transactions: Total number of purchases allowed per month. 
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• Custom Amount: Total spending amount allowed per custom time period. 
• Custom # of Transactions: Total number of purchases allowed per custom time period. 
• Number of days (required if values are entered in Custom fields above): Number of days before card 

limit is reset. 
• Start date (required if values are entered in Custom fields above): Start date of the period. Click the 

Calendar icon to select a date from the calendar. 

Additional Restrictions using Parent Account Limits 
• Check single purchase limit for parent account: Select to apply parent account purchase limits to the 

account. 
• Check cycle limits for parent account: Select to apply parent account cycle limits to the account. 
• Check MCCG table for parent account: Select to apply parent account Merchant Category Code 

Group (MCCG) limits to the account 

190 

 



 

 
Figure 168: Account management- MCC status section 

MCC Group Authorizations (continued) 
Note: Depending on your permissions and site configuration, some of the buttons or fields described below may not 
be displayed. Contact your financial institution for more information. 

The Merchant Category Code (MCC) Group Authorization fields define card limits for MCC groups. Up to eleven MCC 
groups can be assigned to one account. 
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• Option set: Bank-defined group of MCC groups to be assigned to the account. This field is only 
displayed if MCC Group Authorization Option Sets, on Site Setup, is set to Display. 

• Group: Select an MCC group from the Group list. The MCC group controls the type of merchants the 
account holder is allowed to make purchases with. 

• Action: Select one of the following actions for this MCC group from the Action list. 
 Include - Allows the account holder to make purchases with merchants with MCC codes within the 

selected group. 
 Exclude - Prevents the account holder from making purchases with merchants with MCC codes 

within the selected group. 
 Refer - Refers all authorizations to customer service. 
 Divert - Activates the Diversion Account field and allows you to select a different diversion account 

from the list. This action will divert the authorization to the specified diversion account. When this 
action is selected, you must also select the appropriate diversion account using the Diversion 
Account field. 

 Bypass - Ignores the card's available credit limit and uses the corporate account's authorization 
limits set for the MCC group. 

 Default - Applies single purchase limit and velocity checks  to authorizations. 
 Single purchase:- Maximum monetary amount allowed for a single purchase for this MCC group, in 

whole numbers only, no punctuation. For example, enter 5000 for five thousand dollars. 

MCC group cycle limits 
For each of the following fields, leave blank or enter 0 (zero) to indicate that the field is not used. 

• Cycle Amount: Total spending amount allowed per cycle for this MCC group. 
• Cycle # of Transactions: Total number of purchases allowed per cycle for this MCC group. 
• Daily Amount: Total spending amount allowed per day for this MCC group. 
• Daily # of Transactions: Total number of purchases allowed per day for this MCC group. 
• Monthly Amount: Total spending amount allowed per month for this MCC group. 
• Monthly # of Transactions: Total number of purchases allowed per month for this MCC group. 
• Custom Amount: Total spending amount allowed per custom time period for this MCC group. 
• Custom # of Transactions: Total number of purchases allowed per custom time period for this MCC 

group. 
• Number of days (required if values are entered in Custom fields above): Number of days before card 

limit is reset. 
• Start date (required if values are entered in Custom fields above): Start date of period. Click the 

Calendar icon by each field to select a date from a calendar. 
 

Additional Restrictions using Parent Account Limits 
 
The MCCG restrictions override parent account limits only if parent account limits are set for this account and they 
apply only to the MCC group for which they are set.  

• Check single purchase limit for parent account: Select to override this account's parent account 
purchase limits for this MCC group. 
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• Check cycle limits for parent account: Select to override this account's parent account cycle limits for 
this MCC group. 

• Check MCCG table for parent account: Select to override this account's parent account MCCG limits 
for this MCC group. 

1. Click Submit. The Submit Requests dialog opens. 
2. Select Manual or Real-time to indicate how you want to submit request, and enter a note about the request if 

you want. The note appends to the request for others to view. You can mark the note as important, and print 
request information. 

3. Click Ok. Online Card Management submits the request. You can use the Program Change Request detail 
page (as described in the next section) to see information about your request and manage the request. 

If the request cannot be completed because of business rules or a system error, dialogs appropriate to the situation 
will display. Complete the dialog fields and re-submit the request. 
 
 

Working with Temporary Credit Limit controls 
Temporary Credit Limit controls (also known as TCL controls) let you grant account holders a bigger line of credit for a 
period of time. This is useful when an account holder needs to extend his or her credit limit for an usual circumstance. 
For example, if an cardholder needs to book an air travel reservation, you can expand her credit limit long enough for 
her to purchase the tickets. When the TCL expires, her credit limit reverts to its regular limit. Read the following 
section to understand how you can to use Online Card Management to work with TCL controls. 
 

Understanding Temporary Credit Limit status 
This page consists of three tabs, the Manage TCL Controls, Resolve TCL Resets, and Cancel TCL Controls tabs The 
Manage TCL Controls tab displays by default. On this tab you search for TCL controls, view TCL details, and edit 
accounts listed in the TCL log. The Resolve TCL Resets tab displays controls with Failed or Retrying statuses from 
the last 45 days. You cannot search on this tab. The Cancel TCL Controls tab allows you to cancel a TCL prior to the 
established TCL expiration. 
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Figure 169: Manage Temporary Credit Limits page 

The six control statuses are denoted by a symbol in the left column of the status log and a description in the Control 
Status column. The statuses and their descriptions are listed below. 
Note: You can hover your cursor over an icon to display a description. 

Symbol Status Description 

       Cancelled The TCL control is cancelled. 

      Initialize 
The TCL control will have this status between the time it is 
submitted until the system receives a response from the 
processor. 

      Active The TCL control has been applied to the account. 

      Retrying 
An issue with the TCL control has been encountered. The 
system checks the status of the TCL control daily. After the 
third failure (three days), the TCL control status is changed 
to Failed. 

      Failed 
The TCL control failed. Some possible reasons are a 
changed account status or downtime at the processor. 
Contact your system administrator. 

 

Successful The TCL control has completed and the account reverted to 
the original credit limit. 

   
 

Creating Temporary Credit Limit controls 
Creating Temporary Credit Limit (TCL) controls is a two step process that you complete from the Manage Temporary 
Credit Limits page in Online Card Management. The process is straight-forward, you find the account for which you 
are creating the TCL control and enter the TCL control parameters as explained in the following procedures. 
Note: Each account can only have one active TCL control at a time. 
 

To select an account for a new Temporary Credit Limit 
Complete the following to select an account for a new Temporary Credit Limit (TCL) control: 
You manage and resolve temporary credit limit (TCL) controls from this page. Select Accounts>Manage Temporary 
Credit Limits from the menu. If you have access to one organization (unit), proceed to Managing Temporary Credit 
Limit controls. If you have access to multiple units, search for a single unit using the procedure below. 

Searching for a unit if you have access to multiple units 
3. Select Accounts > Manage Temporary Credit Limits from the menu.The Select Organization page displays. 
4. Select a search type from the list. You can select a Unit Name or Unit Number search. 
5. Specify a value in the associated field. You can use an asterisk (*) as a leading or trailing wildcard character 

in partial searches. 
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Note: If you leave these fields blank, the first 300 units will be returned by your search. If you cannot find the 
unit you want, narrow your search criteria. 

6. Click Search. The search results display below. If one unit is returned from the search, the unit hierarchy 
displays. Click OK to select the unit (step 7). If multiple units are returned, proceed to step 5. 

 
Figure 170: Manage Temporary Credit Limits page 

7. Locate the unit that contain the accounts for which you want to create or review temporary credit limit 
controls. 

Note: You can sort the results set by clicking the Unit Name or Unit Number column title. When the sort 
arrow displays, click the column title again to toggle the sort order between ascending and descending. 

8. Select the unit. You can review the unit hierarchy by clicking the hierarchy icon (   ). 
9. Click Next. The Manage Temporary Credit Limit controls page displays. 

 

To set Temporary Credit Limit controls for the selected account 
You can add a new TCL from the Manage Temporary Credit Limits controls or from the Authorization section of the 
Account Management screen for an account See the quick reference guide “Creating or Modifying Accounts”. 
To create a new TCL control from the Manage Temporaty Credit Limit Controls page, click Add Temporary Credit 
Limit Control. The Add Temporary Credit Limit Control page displays. 
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Figure 171: Add Temporary Credit Limit 

1. Select an account status from the Search Account list. You can search by Account Number, Account 
Status, or Name on Account. If you select Account Status, the Account status list populates with all 
available account statuses. For the other fields, specify additional search criteria in the associated field. You 
can use an asterisk (*) as a leading or trailing wildcard character in partial searches. 

2. Click Search. The  search results display below. 

 
Figure 172: Add Temporary Credit Limit search results 

3. Select the account. The Next button displays. 
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Figure 173: Add Temporary Credit Limit account selected 

4. Click Next. The Add Temporary Credit Limit Control page displays. 

 
Figure 174: Add Temporary Credit Limit 

5. Specify the following information: 
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• Temporary credit limit - Enter the new temporary credit limit for the account. Do not include decimals, 
punctuation, or currency symbols. 

• Master accounting code - Use this field if you want an invoice number or other transaction related 
value for the TCL recorded for the account at TSYS. The value will be reset then the TCL control is 
removed. 

• Invoice number - Use this field if you want to associate an internal invoice number for the TCL. This 
value is not recorded on the account by TSYS. 

• Note - Attach a note to the TCL. You can use up to 250 characters. 
 
• Date rule - Select one of the following two options. This sets the date when the TCL expires and the 

card credit limit and card status are reset to their original values: 
• On specific date: Type a date using the MM/DD/YYYY format or use the calendar control ( ) 

to select a date. 
• After specified number of days: Type the number of days after which the TCL expires. 

• Current balance rule – Select this option to reset the TCL when the amount reaches the allowed card 
balance. When you select this option, the When current balance is within specified amount of credit 
limit: and When current balance is within specified percentage of credit limit: options are disabled. 
Otherwise, select one of the following options: 

• When current balance is within specified amount of credit limit – select this option to 
specify an amount that will close the TCL when it reaches the credit limit amount value. For 
example, if you specify 10 in this field and the credit limit is 100, then the TCL is closed then the 
balance is 90. 

• When current balance is within specified percentage of credit limit - select this option to 
specify a percentage that will close the TCL when it reaches the credit limit amount value. For 
example, if you specify 90 in this field and the credit limit is 200, then the TCL is closed then the 
balance is 180. 

6. Click Submit. The TCL is submitted on this account. 
 

Managing Temporary Credit Limit controls 
When your search is complete, locate the TCL control you want to review. Remember, the Resolve TCL Resets tab 
displays controls with Failed or Retrying statuses from the last 45 days regardless of your search criteria. You can 
perform the following management tasks on both tabs. 

3. Click the TCL control details icon ( ) to open the Status Detail dialog. This dialog lists the information 
about the original TCL control. Click OK to close this dialog. 

4. Click the Account Number link to open the Account Management screen. You modify account information on 
this screen. See the quick reference guide “Creating or Modifying Accounts”. 

 

To search for a Temporary Credit Limit control 
Active TCL controls initiated in the last 10 days display in the Temporary Credit Limit Status Log. You can search for 
additional TCLs by using the following procedure. 
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1. From the menu, select Accounts > Manage Temporary Credit Limits. The Manage 
2. Select a log type from the Show logs for option. You have a choice of one of four  

control options. 

• All controls - This option returns all control statuses: Initialize, Active, Retrying, Failed,  
and Successful. 

• Active controls - Active controls are listed. 
• Reset errors - Failed controls are listed. 
• Closed controls - Successful controls are listed. 

3. Specify one of the following to select a date range for the controls. 

• Select a date range from the For controls initiated list. 
• Click the icons next to the From and To fields to select a date from a calendar. 
Note: The date range cannot exceed 45 days. 

4. Click Search. The search results display in the Temporary Credit Limit Status log. Controls with Failed or 
Retrying statuses display on the Resolve TCL Resets tab. 

 

To resolve Temporary Credit Limit control problems 
Select the Resolve TCL Resets tab to display all controls with Failed or Retrying statuses from the last 45 days. 

 
Figure 175: Resolve Temporary Credit Limits 

You can select the details icon (  ) to display a dialog with additional information. 
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Figure 176: Resolve Temporary Credit Limits details 

 

Managing account transfers 
If the account transfer functionality is enabled for your site you transfer accounts from one unit to another within a 
single hierarchy on the Manage Transfer Accounts page. The account moves are performed in real time so they occur 
when the confirmation dialog displays. All transactions associated with the transferred accounts will post to the new 
unit after nightly processing while all transactions that posted to the original unit prior to the transfer will remain with 
that unit. 
You have the option to specify the date that transactions associated with transferred accounts post to their new unit. 
That procedure is detailed in step 4 below 
Select Accounts>Transfer Accounts from the menu to display the Manage Transfer Accounts page. 

200 

 



 

 
Figure 177: Manage Account Transfer page 

To transfer accounts between units 
3. Select Accounts > Transfer Accounts from the menu. The Transfer Accounts page displays. 

 
Figure 178: Manage Account Transfer page 

4. Select unit or account search criteria from the search control in the Select the accounts that will be transfered 
section and specify additional criteria in the associated field. If you specify unit search criteria, all accounts in 
that unit are returned. You can use an asterisk (*) as a leading or trailing wildcard character in partial 
searches. 

5. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 
the search results will include all inactive accounts. 

6. Click Search. Accounts matching your search criteria display below.  
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Figure 179: Manage Account Transfer search results 

 

7. Select the account(s) . The selection displays in the Selected Accounts section. 

 
Figure 180: Account selected 

8. Click Next. The Transfer Accounts/Select Units page displays. 
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Figure 181: Transfer Accounts/Select Units page 

9. Select unit search criteria from the search control in the Select the unit which accounts will be transferred into 
section and specify additional criteria in the associated field.. You can use an asterisk (*) as a leading or 
trailing wildcard character in partial searches. 

10. Click Search. The units matching your criteria display in the Select Unit section. 

 
Figure 182: Transfer Accounts/Select Units search results 

11. Select the unit and click Next. The Transfer Accounts / Finalize Transfer  page displays with the account or 
accounts listed. 
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Figure 183: Finalize Transfer 

12. Optional - If you want to transfer transactions posted to your selected accounts on a different day than you 
transfer accounts, select Move associated transactions to activate the calendar control (  ). Specify a 
date using the DD/MM/YYYY format or use the calendar control to select a date. The transactions for the 
accounts you transfer will move to the new unit on that date. 

Important: If you select a date prior to the date that you move accounts to a new unit, all outstanding 
transactions from that date forward will post to the account in the new unit. 

13. Click Submit. The accounts are transferred to the new unit. 

 
Figure 184: Accounts transferred 

Note: If the account has a status of Failed, hover your cursor over the associated information icon (  ) for 
more information. 

14.  Click Start a New Transfer to return to the Manage Transfer Accounts page. 
 

Managing program change requests 
A program change request results when an administrator submits a change to an account to the financial institute 
which issued the account. Submitting these account changes is described in "To modify existing account information, 
or specify new account information". For example, you might want to change a card limit for a certain account from the 
Account Management page. This results in a request that is received by the financial institution (real-time or non-real-
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time) and is accepted or rejected. These requests can be processed in real-time or there can be a delay before the 
request is processed. 
Online Card Management provides a way to easily manage program change requests, including viewing all requests 
and seeing information about each such as current status. 
 

Program change requests and real-time update 
Some account changes cannot be made in real time, and must be made manually (non-real-time). See your 
administrator for information about real-time changes at your site. 
 

Searching for requests 
You can search for one or more requests, and work with those requests. You must have a permission right granted to 
search for requests. Use the following procedure to search for requests: 
 

To search for requests 
1. From the Accounts menu, select View Program Change Requests. The Program Change Request search 

page displays. 

 
Figure 185: Program Change Requests 

2. If real-time requests are available for your site, choose whether you want to search for all requests or for real-
time requests only. 

3. In the Search By list, select the criteria you want to search by. Depending on your selection, different fields 
or check box selections are displayed. If you select Account Name, Account Number or Organization 
Name, a search field is displayed. Enter additional information in this field to narrow your search. You can 
use an asterisk (*) as a leading or trailing wildcard character in partial searches. 
• Status 
• Request ID 
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• Account name 
• Account number 
• Organization 
• Flag 
Note: The Search By list does not display for Status or Flag searches. When you select Status, check 
boxes display to let you select Not submitted, Submitted, Rejected, or Received, or any combination of 
those. When you specify Flag, no other search information is needed. You can use the flag to mark a change 
for future follow up. You can use a flag note to record notes for yourself. For example, “Don’t forget to call 
Harvey on Wednesday to make sure he knows about this change.” 

4. If the Hide requests... check box is displayed, select it to exclude requests with received and real-time 
completed status from the search results. The Hide Requests check box is displayed when you search using 
any option other than Status. 

5. Select a date range from the Date Range control. To specify a custom date range, click each calendar 
control ( ) to select a custom From and To date or type the date in the From and To fields using the 
MM/DD/YYYY format. 

Note: The Date list does not display if you select Request ID in the Search By field (Step 3). 

6. Click Search. Requests that match the criteria and date range display in the Search Results list. If more 
requests match the criteria than can fit on a single page, you use the links at the bottom of the page to view 
the other requests. 

 
Figure 186: PCR search results 

Note: New card requests will display multiple PCRs for the creation of a single new card. These multiple 
requests are a result of the processing procedure for creating new cards on the main processing system. 
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Working with requests 
The Search Results list shows all the program change requests that match your search criteria. The list shows the 
name, account number, and organization for the account for which this request was made, as well as request ID 
number, date, and status information. You can also see detailed information about individual requests, and perform 
management actions on one or more requests, including changing status, flagging, printing, and others. 
From the Search Results list, you can work with individual or multiple requests to complete any of the following 
actions: 

• Submit a request 
• Delete a request 
• Change the status of a request 
• Undo a change status command 
• Flag the request for follow-up, including a note 
• Print information about the request 

Note: Not all tasks are available to all users. 
You can click the link in the Name or Account column to display the Account Management page for this account. 
You also can access this page from the Account Management page for this account: click the Change Requests link 
immediately above the General Information section in the Account Management page for this account. The Program 
Change Request page displays with the requests for the account listed. 
 

To work with requests 
The list of requests you can work with is displayed in the Search Results list, in the bottom portion of the Program 
Change Requests page. For information about searching for requests, see "To search for requests (on page 205). 

1. Select the check box by each request on which you want to perform the task. You can select the check box 
in the column header to select all requests. Select it again to de-select all requests. 

  

• Submit ( ) 

• Delete ( ) 

• Change status ( ) 

• Flag for follow-up ( ) 

• Print ( ) 
Important: Not all tasks are valid for all requests. For example, you cannot submit or delete a request with a 
status of Received. The action icons are activated only for requests on which the selected action can be 
performed. If you select actions with different statuses, for example, Rejected and Not Submitted, the icon for 
Change Status (  ), which normally activates for the Rejected status, will not activate. 
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2. Click the action icon in the Actions control. One of the following confirmation dialogs display: 
 

• Submit 

 
Figure 187: Submit Requests 

Select Manual or Real-time. You can enter a note about the requests, if needed. The note is appended to 
the selected requests for others to view. You can mark the note as important and print the requests. Click 
Submit to submit the requests. 

 

• Delete 

 
Figure 188: Delete Requests 

Click Delete to delete all selected requests. 
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• Change Status 

 
Figure 189: Change Status 

 

Select the new status from the Change status of… list. You can enter a note about this change for others to 
read (optional). Finally, you can specify that you want to print information about the requests after the status 
is changed. 
 
Click Submit. The status of each selected request is changed and the Print dialog displays if you selected 
the Print after changing status check box. 

 

• Flag for follow-up 

 
Figure 190: Flag Notes 

209 

 



 

 

Enter a flag note and click Submit. The flag note is added to each selected request, and a Flag icon ( ) is 
displayed next to the request in the search results list. 

 

• Print 

 
Figure 191: Print Request 

 

Select one of the following Contents options:  
 
Summary:  Information in the Search Results page. 
History:  Information in the top of the request detail page. 
Account information:  Information in the bottom of the request detail page. 
Both history and account information:  All information in the request detail page. 
 
Select one of the following Output Format options:  
 
Printer-friendly format:  The requests are sent to your local printer 
Tab-delimited file: This option activates only when the Summary contents is selected. The information is 
output to a tab delimited file. 
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To view notes and flag notes 
You can add information about individual program change requests with notes and flag notes: 

• A note (  ) can be viewed by anyone who works with this request. Use a note to record information that 
others may need to know. For example, “Account holder requests increased card limit for special equipment 
purchases.” You can add a note whenever you submit a request or change its status. 

• A flag note (  ) can be viewed only by the person who adds the flag note to this request. Use a flag note to 
record notes to yourself. For example, “Don’t forget to call Harvey on Wednesday to make sure he knows about 
this change.” You can add a flag note to a request anytime from the Search Results list. 

To view notes and flag notes: 
From the Program Change Requests Search List, click the appropriate icon next to the request, as follows: 
• When you click the Flag Note icon, the flag note dialog displays with your note. Only your most recent flag note 

is displayed. Previous flag notes about this request are not saved. 
• When you click the Note icon, the Notes dialog displays, containing all notes for this request in order of their 

entry. You cannot edit or delete previous notes. Click Print to print the complete list of notes. 
 

Maintaining Card Models 
Card models save you data entry time by creating templates for types of cards that you create over and over again. 
These templates save the settings and data entry that never changes for the cards you create based on the model. 
For example, you can create a model for Fleet Cards and use the model to create issue a Fleet Card to a new 
cardholder. 
Creating a card model is similar to creating an actual card. With the exception of the Card Model Name, the entered 
data entered in the Card Model Detail is automatically populated for new cards created using this model. For example, 
if you enter address information for a card model all cards based off this model will have the same address 
information. If the information changes from card to card, leave the field blank. 
The Card Model Maintenance page lets you manage the card models. You can use this page add new models, modify 
existing models, change a models active/inactive status, or delete models. 
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To create a new card model 
1. Select a unit. If you have access to multiple units, you can only select one. 
2. Select Accounts>Manage Card Models from the menu. The Card Model Maintenance – Select Organization 

page is displayed.  
3. Select either Unit Number or Unit Name from the list and specify additional information in the associated 

field. You can use the asterisk (*) as a leading or trailing wildcard character in partial searches. 
4. Click Search. The search results are displayed below. 
5. Select a unit and click Next. The Card Model Detail… page is displayed. 
6. Click Add New Model. The Card Model Detail for [New Card Model] page is displayed. 

 
Figure 192: Card Model Detail page 

7. Enter a unique name in the Card model name field.  Example: Travel Cards. This field is required. 
8. Enter a description in the Card model description field. This field is optional. 
9. Enter or select all additional information you want in your card model. For a description of these fields, refer 

to the following quick reference guides:  
Creating a New Account for TS2  
Modifying Accounts for TS2  
Creating a New Account for TS1 
Modifying Accounts for TS1   
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10. You can also refer to the online help topic Creating or modifying accounts by selecting Help>Help on This 
Page from the menu while on the Account Management page. 

11. When the card model is complete, click Save. The card model is saved. 
12. Click Back to results to return to the Unit Search page. 

 

To edit an existing card model: 
1. Select a unit. If you have access to multiple units, you can only select one. 
2. Select Accounts>Manage Card Models from the menu. The Card Model Maintenance – Select Organization 

page is displayed. 
3. Select either Unit Number or Unit Name from the list and specify additional information in the associated 

field. You can use the asterisk (*) as a leading or trailing wildcard character in partial searches. 
4. Click Search. The search results are displayed below. 
5. Select a unit and click Next. The Card Model Detail …page is displayed.  

 
Figure 193: Card Model Maintenance page 

6. You can edit the existing card model fields by clicking the detail icon (  ) to open the Card Model 
Detail...page, editing the fields as required, and clicking Save. For a description of these fields, refer to the 
following quick reference guides: 
Creating a New Account for TS2 
Modifying Accounts for TS2 
Creating a New Account for TS1 
Modifying Accounts for TS1 

To delete a card model 
Use the Card Model Detail page to delete card models. Complete the following to delete a  
card model. 
Tip: If you do not want to use a card model, make the model inactive rather than deleting it. See "To change a card 
model's active status (on page 214).  
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1. From the Accounts menu, select Manage Card Models. The Card Model Maintenance page displays. 
Note: If you have access to more than one site and you have not specified a location in the hierarchy, you 
must select an organization unit from the hierarchy before the Card Model Maintenance page displays. 

2. Find the model you want to delete from the list and click the Delete icon ( ). A confirmation  
dialog displays. 

3. Click Yes. Online Card Management deletes the card model. 
 

To change a card model's active status 
Use the Card Model Maintenance page to change a card model's active status. Complete the following to change a 
card model's active status. 

1. From the Accounts menu, select Manage Card Models. The Card Model Maintenance  
page displays. 
Note: If you have access to more than one site and you have not selected a location in the hierarchy, you 
must select an organization unit from the hierarchy before the Card Model Maintenance page displays. 

2. Find the Card Model you want to activate or inactivate. 
3. In the Active column, select or clear the check box. 

 

Working with account alerts 
Use the Manage Alert Subscriptions page to activate or de-activate alerts for your account and the accounts that you 
manage. Select the account or accounts and then specify which alerts you want to receive for them. The site settings 
determine which alerts are available for your account holders. See "To manage alerts for a site” on page 37. All of the 
alerts enabled for your site are selected by default. You can use the Manage Alerts page to deactivate or re-activate 
the available alerts. 
 
 

To activate alerts for accounts 
After you have selected the units and accounts (if applicable), you can choose which of the available alerts you want 
to activate or deactivate. By default, all of the enabled alerts are activated. Complete the following to change the 
activation status of account alerts. 

1. From the Home page, click Manage Alerts. The Manage Alert Subscriptions page displays displaying the 
Accounts I Manage tab. 

2. If you manage multiple units, select the unit (see topic on page 215) for which you want to change alert 
activation status. 

3. If you want to choose accounts within the selected unit, select the desired (see topic on page 216) accounts. 
Note: If you do not specify any accounts, the alert settings will apply to all accounts in the select unit. 
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4. Select the check boxes for the alerts you want to activate, or clear the check boxes for the alerts you want to 
disable. 
If you select the Current balance approaching credit limit check box the activation fields display. You 
select one of these options and specify the trigger point. 

• Calculate by: Amount within. Specify the amount within the credit limit. When the account balance 
exceeds the credit limit minus the amount you specify, the alert will trigger. Specify whole, positive 
numbers. Do not use currency symbols, commas, or decimals. 

• Calculate by: Percent within. Specify the percent within the credit limit. The alert will trigger when 
account balance, expressed as a percent of the credit limit, exceeds 100 minus the number you specify. 
For example, if you want the alert to trigger when the balance is 95% of the credit limit, enter '5' in the 
Percent within field. Specify whole, positive numbers. Do not use the percent sign, commas, or decimals 

5. Click Apply settings to selected accounts. 
 

To select units for alerts 
If you have access to multiple units, you can choose to activate alerts for specific units. To activate alerts, you first 
need to search for the unit you want to receive the alerts. You then have the option to receive alerts for all accounts 
within the unit or specific accounts within that unit. When you access the Manage Alerts Subscriptions page, you first 
search for a unit. 

To search for a unit: 
1. From the Home page, click Manage Alerts. The Manage Alert Subscriptions page displays displaying the 

Accounts I Manage tab. 
2. Click Select Organization. The Select Organization dialog displays. 

 
Figure 194: Select Organization dialog 

3. From the Search by list, select the unit search criteria. 
4. Further refine your search by specifying additional criteria in the Search for field.  

Tip: You can use the asterisk (*) as a leading or trailing wildcard character for partial searches. 

5. Click Search to display the unit search results. The search results display in a hierarchy. 
6. Select the unit from the search results. The hierarchy information displays in the dialog. 
7. Select the Include Subunits checkbox if you want the alert settings to apply to the subunits of the selected 

unit. 
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To select accounts for alerts 
After selecting a unit you can choose to specify individual accounts to activate. If you do not specify accounts, the 
alerts are sent to everyone in the unit. 

1. From the Accounts I Manage tab, click the Account. The Select Accounts search fields display. 
 

 
Figure 195: Select Accounts search fields 

2. From the Search using list, select the search criteria you want to use to find the  
desired accounts. 

3. In the Search for field, enter the search criteria for the accounts you are trying to find. 
Tip: You can use the asterisk (*) as a leading or trailing wildcard character for partial searches. To return all 
accounts in the unit, leave the Search for field blank. 

4. Click Search. The accounts that match your search criteria display. 
5. Select the check boxes next to the desired account or accounts.  
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Using Reports 
Online Card Management has reporting functionality that helps you analyze data.  
This chapter contains the following sections: 
• Processor reports (see topic on page 217) 
• Standard reports (see topic on page 226) 
• Saving and downloading reports (see topic on page 227) 

 

Processor reports 
You can search for, view, download, and print processor reports. To view these reports, you complete the following 
tasks: 
• Select a unit or units within which to search for reports (if you have access to more than one) 
• Search information in the reports for the selected unit or units 
• From the list of reports, select a page number of a report to view and print the selected page 
• Download and print a report 

 

Understanding processor reports 
Processor reports are generated by the bank processor. These reports are in a standard format which you cannot 
change. This means you cannot change the font or data elements using Online Card Management. You can run 
Processor reports at an organization level or a specific point in the hierarchy. You have online access to your reports 
for a length of time determined by your bank. Processor reports are available for online viewing, downloading, or 
printing. Refer to the documentation from your program administrator for specific information about the reports that  
you receive. 
 

Searching for processor reports 
You can search for previously generated reports. After you select a unit or units for which to search for reports, the 
reports available for the selected units display in the Available Reports box. From the list in the Available Reports box, 
you can select the reports within which you want to search for specific information. 
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To search for reports 
1. Select Reports >Bank Reports from the menu. The Bank Reports page displays. 

 
Figure 196: Bank Reports page 

2. Select the units whose reports you want to view: select All available (includes subunits) to see reports 
from all units that are available to you, or Selected units only to specify which units for which you want to 
see reports. (If you select all available units, and you have access to many units and subunits, it may take a 
long time to search for reports.) 

3. If you chose Selected units only, click Select Units to choose the units to include. The Change Business 
Unit Selection for Report Search page displays. 
 

 
Figure 197: Business Unit Selection for Report page 
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4. Select the units for which you want to view reports by clicking the Include icon ( ). Select Include 
Subunits, if applicable. The unit(s) will display in Selected Units. 

5. When you have selected all units whose reports Show Reports. 

 
Figure 198: Available and Selected Reports 

6. In the Available Reports section click the Include icon ( ) to include the reports you would like to include 
in the search. 

7. You can specify further selection criteria to narrow the list of reports to view: 

• In the Include Reports for this Date Range fields, enter a date range for the reports you want to view, in 
the format specified in your browser (usually this is the standard mm/dd/yyyy format). 

• Select a field from the Search reports by list (the list includes all fields in all selected reports), and in the 
For field enter a value. You can use the wildcard ( * ) to search for report pages that contain your search 
value. Online Card Management displays all reports with the value in the selected field. 

8. Click Search. A list displays the reports that match the search criteria. If you entered a value in the Search 
reports by field, the display includes a list of page numbers on which that value displays in the report. 

 
Figure 199: Report Search results 
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9. Your current report search criteria display at the bottom of the page. Click Revise Search to return to the 
Search Reports page to revise your search, if necessary. 

 

To view or download the full report 
Note: This procedure assumes that you have completed a report search as described in "To search for reports (on 
page 218). 

From the the Report Search Results list, click the  icon in the Download Full column. The File Download dialog 
opens. 
To view the full report: 

1. Click the Preview Page icon ( ). The file (in .TXT format) displays in a report page. 
2. Click the maximize button in the upper right corner of the report page to expand it. 
3. When finished viewing the report, click the close button in the upper right corner of the report page to close it. 

To download the full report: 
1. Select Save this file and click OK. Note that the file is in text format with a .TXT extension. 
2. Enter the location where you want to save the file and click Save. 
3. Click Close to close the Download Complete dialog. 

 

To view or print a specific page in the report 

1. In the Reports list, type the page number in the Preview Page columns for that report and click the  icon. 
The page you selected displays. 

2. To view other pages in the same report, scroll to the bottom of the display. Page numbers are listed. Click a 
page number link to go to that page. 

 
Figure 200: Report page links 

3. Click a page number link to go to that page. 
4. To print the page you are viewing: 

a. Click View Print Friendly Page. The Print-friendly version of the page opens in  
another window. 

b. Select File > Print from the menu on the report page. The Print dialog displays. 
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c. Click Print. Online Card Management sends the report to your printer. 
d. Close the Print-friendly page. 

5. To return to the Reports list, click Back to Search. 
 

Maintaining report profiles for bank users 
With the appropriate access permission, you can set up report profiles and assign bank-level users to profiles. This is 
a bank-level administration task. The report profile determines which reports the user assigned to the profile can view. 
In this way the bank administrator can limit the access of a bank-level user to a specific set of reports. 
All users at banks that do not use report profiles have access to all reports for that bank. 
Maintaining report profiles includes the following tasks: 
• Creating a report profile (see topic on page 221) 
• Assigning reports to a report profile (see topic on page 222) 
• Assigning users to a report profile (see topic on page 223) 
• Assigning report profiles to a user (see topic on page 224) 

 

To create or modify a report profile 
1. Select Administration >Manage Reports > Maintain Report Profiles from the menu. 

Note: If you have access to more than one site, you must select the site (see topic on page 33) before 
continuing. 

2. To create a new report profile, click New. The New Report Profile page displays. 

 
Figure 201: New Report Profile page 

3. Enter a name and description for the new profile in the appropriate fields. 
4. Click Save. The Maintain Report Profiles page re-displays, with the new report name shown in the list. 
5. To modify the new profile, or any of the existing profiles, do one of the following: 

• Click the profile name link to edit the reports or users assigned to this profile, or to edit the profile name 
and description. The Maintain Report Profile page displays. See step 6 of this procedure for more 
information. 
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• Click the icon in the Copy column to clone the existing profile. The Edit the Report Profile Name and 
Description page displays, and you can give the copied profile a new name and description, and modify 
it. See step 6 for more information. 

• Click the icon in the Edit Reports column to edit the reports specified in this report profile. The Assign 
Reports to Report Profile page displays. See the task "To assign reports to a report profile (on page 
222). 

• Click the icon in the Edit Users column to edit the list of users assigned to this profile. The Assign Users 
to Report Profile page displays. See the task "To assign users to a report profile (on page 223). 

• Click Delete to delete the profile. 

6. If you clicked the profile name or the Copy icon, the Maintain Report Profile page displays, showing the 
reports and users assigned to this profile. 

 
Figure 202: Maintain Report Profile page 

7. You can modify the name or description of the report profile. Click Save when you have finished modifying 
the name or description. 
Important: Modify the name and description for copied (or cloned) profiles; if you do not, two profiles with the 
same name and description display for this bank. 

 

To assign reports to a report profile 
1. You can add or remove reports in the profile. Do one of the following: 

• From the Maintain Report Profiles page, click the Edit Reports icon by the report profile for which you 
want to modify reports. 

• From the Maintain Report Profile page ("Edit report profile name and description"), click the Edit link over 
the Reports box. 

The Assign Reports to Report Profile page displays, showing reports already assigned to this  
report profile. 
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Figure 203: Assign Reports to Report Profile 

2. Select the Include organization-level reports check box to include organization-level reports in this profile, 
as well as bank-level reports. 

3. Select the reports to include in the profile: 
• Select All Available to include all available reports in this report profile. 
• Use the Search Criteria and Search Value fields to enter the name or number of the report name for 

which you are searching. Click Search. The report or reports that match the search criteria are listed in 
the Available Reports box. 

• From the list of reports shown in the Available Reports box, click the right-facing arrow next to the report 
number to list a specific report in the Select Reports box. Click the double arrow ( >> ) to list the reports 
that display on the page in the Selected Reports box. Click the *> arrow to list all available reports in the 
Selected Reports box. 

4. Click Save to save the list of selected reports in the report profile. The Maintain Report Profile page re-
displays, showing the new list of reports for this profile. 

 

To assign users to a report profile 
1. You can add or remove users from the report profile. Do one of the following: 

• From the Maintain Report Profiles page, click the Edit Users icon by the report profile for which you want 
to modify users. 

• From the Maintain Report Profile page, click the Edit link over the Users box. 
The Assign Users to Report Profile page displays, showing users already assigned to this report profile. 
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Figure 204: Assign Users to Report Profile page 

2. Select the users to include in the profile: 

• Use the Search Criteria and Search Value fields to enter the user ID, first name, last name, or report 
profile name for which you are searching. Click Search. The user or users that match the search criteria 
display in the Available Users box. If you choose to search on a report profile name, all users included in 
the report profile you entered in the Search Value field display in the Available Users box. 

• From the list of users shown in the Available Users box, click the right-facing arrow next to the user to list 
a specific user in the Selected Users box. Click the double arrow ( >> ) to list the users that display on 
the page in the Selected Users box. Click the *> arrow to list all available users in the Selected Users 
box. 

3. Click Save to save the list of selected users in the report profile. The Maintain Report Profile page re-
displays, showing the new list of users for this profile. 

 

To assign report profiles to a user 
In the previous tasks you selected a report profile and assigned users to use that profile. This task is the reverse: you 
select a user, and assign one or more report profiles to that user. 

1. Select Administration >Manage Reports > Assign Report Profiles to User from the menu. The Assign Report 
Profiles to User page displays. 
Note: If you have access to more than one site, you must select the site (see topic on page 33) before 
continuing. 
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Figure 205: Assign Report Profiles to User 

2. To select a user: 
a. Use the Search Criteria and Search Value fields to specify a user ID, first name, last name, or report 

profile name for which you are searching. 
b. Click Search. The user or users that match the search criteria are listed in the Available Users box. If 

you choose to search on report profile name, all users included in the report profile you chose in the 
Search Value field display in the Available Users box. 

3. Click the  icon on the line of the user to which you want to assign report profiles. The Assign Report 
Profiles page displays, showing available report profiles. 

 
Figure 206: Assign Report Profiles to User- Available Reports 

4. To move report profiles from the Available Report Profiles box to the Selected Report Profiles box, do any of 
the following: 

• From the list of report profiles shown in the Available Report Profiles box: click the right-facing arrow 
next to the report profile name to list a specific profile in the Selected Report Profiles box. 

• Click the double arrow ( >> ) to list the profiles that display on the page in the Selected Report Profiles 
box. 

• Click the *> arrow to list all available profiles in the Selected Report Profiles box. 
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5. Click Save. Online Card Management assigns selected report profiles to the user. The Assign Report Profiles 
to User page displays. 

 

Managing reports as an administrator 
As a bank-level administrator, you can also set up report profiles, and assign other bank-level users to those profiles. 
A report profile determines which bank-level reports the assigned user can access. A user can be assigned to one or 
more report profiles. 
If a bank does not use report profiles, a bank-level administrator can access all bank-level and organization-level 
electronic reports generated for this bank. 
A bank can require that every bank-level user be assigned to one or more report profiles. That requirement is made 
with the Report Profile site setting, on the Site Setup window for this bank. The procedure is described in the reports 
module of the task "Selecting application modules (on page 43). 
 

Standard reports 
To run a standard report, you select it from the list of available reports and set the search criteria for the report. Most 
of the standard reports let you search for accounts using either an account or a unit report criteria. 
 

Understanding Standard Reports 
You select the report and specify parameters that control the data retrieved and the report output format. You can run 
the report as an ad hoc occurance or save those parameters as a custom report for use later. 
To see the list of standard reports, choose Reports > Standard Reports from the menu. If you want to see a summary 
of the report parameters and an example of the report output click the  icon for the report. Detailed procedures for 
setting up and running each report can be found in the online help. 
Depending on the report output format you select, certain report formats (HTML) are available directly while others 
(.txt or .csv) can only be accessed in the Output log. You will receive an email notification when your report is 
available in the Output log (typically 5-10 minutes.) 
If you need additional information on running a standard report, creating a custom report, scheduling a report, or 
locating your report in the Output log, please review the appropriate topics in the online help. 
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To select a report 
1. Select Reports > Standard Reports from the menu. The Standard Reports page displays. 

 
Figure 207: Standard Reports page 

2. From the Report Name list, select the report you want to run. The report page displays. 
Tip: You can click the icon in the Sample column to view a sample of the report output. 

 

Saving and downloading reports 
After you complete specifying standard report criteria, you can save the report. This saved report will display in the 
standard report list as a custom report. The custom report can be scheduled using the Scheduler. 
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To save a custom report 
1. Complete the required criteria for the specific report. You can include any optional criteria, as needed. 
2. Click Save. The Save Report page displays. Online Card Management appends a sequence number to each 

instance of the report to create a custom Report number. 
 

 
Figure 208: Save Report page 

3. Enter a name in the Report name field. This field is required. 
4. Select a report category from the Report category list. These categories are useful for grouping reports by 

their functionality. 
5. Enter a description in the Report Description field. 
6. Select Include selected units and accounts if you want the units or accounts you selected for this report to 

be included each time the report runs. If you clear this checkbox, these parameters users must specify them 
every time they run the report. 

7. Click Save. Online Card Management saves the report and displays it in the Standard Report list. 
 

Reports Dashboard 
You can use the Reports Dashboard to view charts of trending analysis of program spending and CentreSuite usage. 
Enable the Reporst Dashboard 
To enable this feature, navigate to Set Up Site in the Administration module. Click the Modules tab. In the Report 
section the Enable Reports Dashboard option will display. The default value is No. Select Yes to have access to the 
Reports Dashboard. 
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To allow all companies to use the feature, enable the option at the bank level. 

To allow specific companies to use the feature, enable at the company level. 

Once enabled, administrators and users with Audit Reporting permission will have access to the Report Dashboard.  

When the site is enabled, the system will run a process that night to ensure all the bank’s data is included in new 
tables to create the dashboard charts related to spending. 

 

Using the Reports Dashboard 
You can access the dashboard, by clicking the link under Quick Links on the CentreSuite home page or clicking 
Reports Dashboard under the Reports tab. 

 
Figure 2. CentreSuite Home Page 

Organization administrators can access 10 different dashboards: 
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• Total Program Spend  
• Average Transaction Amount 
• Average Program Spend 
• Top 10 Merchants by Spend 
• Top 10 Cardholders by Spend  
• Statement Downloads 
• Program Total Card Issued 
• Total Active Users 
• New Users 
• Total Logins 
 
The Monthly Glance 
At the top of the page, the Monthly Glance provides a summary of the current monthly activity. The totals of each 
report will refresh to zero at the beginning of each month, increasing as the month progresses when new transactions 
are imported or new users are added.  

The Monthly Glance will only display 8 out of the 10 reports at a time to which organization administrators have 
access. You can choose which tabs and charts to display by clicking Show/Hide Graphs. Select or de-select which 
reports you want to display. 

 
Figure 3. Reports Dashboard - Monthly Glance for Organization Administrators 

Bank administrators also can access the dashboard, but different charts will display. They can access the 
following reports: 

• Modules Activated 
• Statement Downloads 
• Total Active Users 
• New Users 
• Total Logins 
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• Newly Activated Organizations 
 

 
Figure 4. Monthly Glance for Bank Administrators 

From the Monthly Glance you can click on the name of the report and a pop-up window will display the chart 
associated with that report. 

Within each chart a common set of controls display: 

• Information icon 
• Set Date Range dropdown menu 
• Print icon 
• Download icon 
• Zoom icon 
 

 
Figure 5. Total Program Spend Pop-up Window 
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Dashboard 
 
The charts that you selected to include on this dashboard will display in a two by four tiled format. You can control the 
order of the charts by dragging each one to where you want it to display. 

 
Figure 6. Reports Dashboard 

The information icon displays next to the chart name providing information related to the data within the chart. 

 
Figure 7. Information Icon 

Use the Set Date Range dropdown menu to define the date range and how to breakdown the data for each chart. 
Click the radio button next to the break down option you want the chart to display. Depending on the date range 
defined, some breakdown options will not be available for use. Click Apply to regenerate the chart.  
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Figure 8. Set Date Range Menu 

Print and download icons display to the right above the chart. A standard print dialog displays after clicking the print 
icon. 

A PNG file will be created after clicking the download icon. 

 
Figure 9. Closeup of Icons 

To isolate and enlarge the chart, click the zoom icon in the upper right corner. A pop-up window will display. Select the 
Date Range from the dropdown list and select a date by clicking on the calendar icon in the date fields. Click Apply to 
regenerate the chart. You also can print and download the chart using appropriate the icons. 
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Figure 10. Average Transaction Amount Pop-up Window 
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Working with Mappers 
A mapper is a set of instructions that query a transaction database and export data in a specified format, called the 
mapper output file. When the mapper output file is complete, users download it from the Output Log. The file is then 
read by your organization's accounting software or other internal programs in order to update data. 
When the output file is created, the associated database transactions statuses are changed to "mapped" and locked 
from further editing. When database transactions have a mapped status, they are not returned in subsequent runs of 
the mapper. If you need to modify mapped data, you can create mappers that specifically do not set the Mapped flag 
on returned data or you can use the Unmap option in the Output Log. If you unmap transactions, all transactions 
associated with a mapper output file are unmapped. You cannot unmap a single transaction associated with a mapper 
output file. See "To work with the Output Log (on page 320) for instruction for unmapping transactions that are already 
in a mapper output file. 
You can experience a slight delay in the processing of your mapper because factors like Internet traffic levels, the 
number of users accessing the database servers, routine database integrity procedures, and the complexity of your 
mapper parameters all have an impact on processing time. 
You can run a mapper after you create it or you can schedule the mapper to run automatically using the Scheduler. 
Specify the transaction date range when you run a mapper. Use the Scheduler (see topic on page 267) to set the date 
ranges for mapper scheduling. 
This chapter includes the following sections: 
• Creating Mappers (see topic on page 235) 
• Using Mappers in Online Card Management (see topic on page 244) 
• Managing Mappers as a bank administrator (see topic on page 251) 

 

Creating Mappers 
Use the Data Mapping tool to create new mappers. Before you create a mapper, determine your internal software 
upload file format requirements and create mappers that satisfy the requirements. Read the following topics to 
understand how mappers work and how you can use the  
Data Mapping tool. 
When a mapper is run, the output is found in the Output log. Select Expenses>Output Log from the menu to view the 
Output log. There might be a slight delay between when you run the mapper and when the mapper data is available in 
the Output log because the database performs periodic data integrity checks and, while these are running, locks the 
mapper data. Once the integrity checks are complete, the mapper is run. 
 

Creating mappers using the Data Mapping Tool 
The Data Mapping Tool guides you through the process of creating a new mapper. Complete each page off the Data 
Mapping Tool to create a new mapper. This procedure explains the steps necessary to complete the Data Mapping 
Tool to create a new mapper. Subsequent procedures explain each step in detail. 
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1. Select Reports> Data Mapping from the menu. The Manage Mappers page displays. 

 
Figure 209: Manage Mappers Page 

2. Click Create New Mapper. The General Information page of the Data Mapping Tool displays. 
3. Enter the general information for the mapper as described in "To enter general information for a new mapper 

(on page 237). 
4. Click Next. The Define Mapper Format page of the Data Mapping Tool displays. 
5. Define the mapper format using one of the following procedures depending on the format  

you select: 

• For fixed-length mappers, complete "To define a fixed length mapper format (See "To define a fixed-
length mapper format" on page 241). 

• For delimited mappers, complete "To define a delimited mapper format (on page 240). 

6. Select the mapper record type as described in "To select mapper record type (on page 242). 
7. Define the data fields in the output file as described in "To define columns for mapper output file records (on 

page 242). 
Note: To save time, you can copy an existing mapper and modify only the properties that are different. See "To copy 
settings from an existing mapper (on page 236) for more information. 
 

To copy settings from an existing mapper 
1. From the Copy from existing mapper options, select Yes. The Select mapper list activates. 
2. From the Select mapper list, select the mapper that you want to copy settings from and click Go. All settings 

are populated from the original mapper except: 
• Mapper name. Enter a unique name for the new mapper. This field is required. 
• Description. Enter a description for the new mapper. 
• Output file name. Enter a unique name for the output file name. This field is required. 
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3. Click Next to review or edit the mapper format and record type settings. 
4. Click Next to review or edit columns for the header, detail, and footer records. 
5. When the columns definitions are complete, click Finish to complete the new mapper. 

 

To enter general information for a new mapper 
1. From the Reports menu, choose Data Mapping Tool. The Manage Mappers page displays. 
2. Click Create New Mapper. The General Information page displays. 

 

 
Figure 210: Create Mapper page- step 1 
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3. From the Copy from existing mapper options, select No. 
4. In the Mapper name field, enter a unique name for the mapper. This is a required field. 
5. In the Description field, enter a brief explanation of the mapper . 
6. Enter a unique output file name in the Output file name field. This field is required. This name displays in the 

Save as field in the download dialog when the recipient of the output file downloads it from Online Card 
Management. 
Note: Online Card Management generates a unique internal file name for the output file  
when running the mapper. This file name prevents overwriting previous versions of the mapper output file. 

7. From the File format option, select one of the following data column formats. 

• Select Fixed length to create an output file with data contained in columns with fixed lengths. You will 
specify each column length in later steps. 

• Select Delimited to create an output file with column length equal to the data contained in them. Each 
column is separated by a delimiter character. You will specify the column delimiter character in later 
steps. 

8. From the File extension list, select one of the following file extensions: 

• Select "TXT " to append a .txt extension to the file name (FILE_NAME.txt). This extension is typically 
used for flat text file formats. 

• Select "CSV" to append a .csv extension to the file name (FILE_NAME.csv). Files with this extension 
can be viewed using Microsoft ® Excel. 

Your selection defines the mapper format page in later steps of the Data Mapping Tool. 

9. Select the Create for bank check box if you want to create this mapper for a bank and use it for multiple 
organizations. The bank mapper fields display. 

 
Figure 211: Print mapper fields 

If you select the Create for bank check box, complete the following for the bank mapper fields: 

a. From the Bank list, select the bank for which you are creating this mapper. 
b. Select the Allow copying check box if you want to create future mappers by copying  

this one. Leave this check box clear if you do not want new mappers to copy this  
mapper's setting. 

238 

 



 

10. If you selected the Create for bank check box, select the bank for which you are creating the mapper from 
the Bank list. 

11. If you have access to multiple organizations, click Select Organization and complete  
the following. 

a. The Select Units dialog displays. 

 
Figure 212: Select Units dialog 

a. Find and select the organization's unit from the unit search results. 
b. Select the unit from the hierarchy. 
c. Click OK. The selected unit displays in the Create Mapper page. 

12. Select one of the following account type options: 
• Select Individual to include only individual-type accounts in programs where transactions typically post. 
• Select Corporate to include only corporate-type accounts. 
• Select Both to include both individual and corporate account types. 
Only accounts for the selected billing type will be included in the mapper output file. 

13. Select the transaction types you want included in the output file. 

• Select Regular Card Transactions to include standard card transactions. 
• Select Payments, Fees, and Adjustments to include these transaction types in the output file. You can 

specify debit and credit signs in later steps. 
• Select Out of pocket transactions to include transactions created by the user for submission in an 

expense report. 
• Select Personal transactions to include transactions that have been flagged as  

personal expenses. 

14. Select an Include transaction splits option. 

• Select Yes to include split transaction detail in the output file. The parent transactions of splits are not 
mapped to the output file. 

• Select No, to only map the parent transaction to the output file. Splits and personal transactions are not 
mapped to the output file. 

15. Select an Include only transactions assigned to expense reports option. 
If you select Yes, the Expense report status list activates. Select an expense report status from the list. 
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16. Click Next to access the mapper format and record type page of the Data Mapping Tool. 
17. Continue to define your mapper by completing either "To define a fixed length mapper format (See "To define 

a fixed-length mapper format" on page 241) or "To define a delimited mapper format (on page 240) according 
to the file format you select. 

Note: The format options that display in the Define Mapper Format section of the Data Mapping Tool depend on your 
File format selection. 
 

To define a delimited mapper format 
Important: This procedure assumes that you have completed the procedure "To enter general information for a new 
mapper (on page 237) for a new delimited mapper.  If you are creating a fixed-length mapper, complete "To define a 
fixed-length mapper format (on page 241) instead. 

 
Figure 213: Create Mapper page- delimited steps 2 & 3 

1. From the Delimiter list, select the delimiter character you want to use to separate data fields in the output 
file. 

2. From the Decimal option, select one of the following options: 

• Select Implied to exclude the decimal point from numeric data in the mapper output file. This format is 
used by accounting applications that define the decimal position by the number of digits in numeric data. 

• Select Fixed to include the decimal point in numeric data in the mapper output file. Numeric data is 
rounded to the number of decimal places set in the next step. 
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3. Select the Number of decimal places option to set the decimal places reported in numeric data. Online 
Card Management rounds data to the selection. 

4. From the Debit sign and Credit sign lists, select the sign you want to use to designate credit and debit 
transactions. 

5. Select a Sign position option. 
• Select Before from the  to place the debit and credit signs before numeric data. 
• Select After to place the signs after numeric data. 

6. Select the date format from the Date format list. Online Card Management uses this format for all dates in 
the output file. 

 

To define a fixed-length mapper format 
Important: This procedure assumes that you have completed the procedure "To enter general information for a new 
mapper (on page 237) for a new fixed-length mapper. If you are creating a delimited mapper, complete "To define a 
delimited mapper format (on page 240) instead. 

 
Figure 214: Create Mapper page- fixed mapper step 2  

1. From the Decimal option, select one of the following format options: 

• Select Implied to exclude the decimal point from numeric data in the output file. This format is used by 
accounting applications that define the decimal position by the number of digits in numeric data. 

• Select Fixed to include the decimal point in numeric data in the output file. Numeric data is rounded to 
the number of decimal places set in the next step. 
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2. Select the Number of decimal places option to set the decimal places reported in numeric data. Online 
Card Management rounds data according to the selection. 

3. Select a Justification option. Select Right to right-justify numeric data within the defined column or Left to 
left-justify data. 

4. Select Zeros for the Padding option to pad unused spaces in the column with the zero (0) character or 
Spaces to pad unused spaces with spaces. 

5. Select the debit and credit signs from the Debit sign and Credit sign lists. 
6. Select Before from the Sign position option to place the debit and credit signs before numeric data. Select 

After to place the signs after numeric data. 
7. Select Right for the Justification option to right-justify text data within the defined column. Click Left to left-

justify data. 
8. Select Zeros for the Padding option to pad unused spaces in the column with the zero (0) character. Select 

Spaces to pad with spaces. 
9. Select the date format from the Date format list. Online Card Management uses this format for all dates in 

the output file. 
 

To select mapper record type 
Important: This procedure assumes that you have entered general information and defined the mapper format. 

1. Select Yes for the Include header record option to include a header record in the output file. You specify the 
header fields and their formats in subsequent steps of the Data Mapping Tool. 

2. Select Yes for the Include detail record option to include detail records in the output file. The Detail record 
level list activates and you can select a record detail level from it. Specify the detail fields and their formats in 
subsequent steps of the Data Mapping Tool. 
• Select Allocation to include one summary detail record for each unique allocation field combination. 
• Select Cardholder to include one summary detail record for each cardholder. 
• Select Transaction to include one detail record for each transaction. 
• Select Unit to include one summary detail record for each unit. 

3. Select Yes for the Include footer record option to include a footer record in the output file. You specify the 
footer fields and their formats in subsequent steps of the Data Mapping Tool. 

4. Click Finish. 

To define columns for mapper output file records 
Important: This procedure assumes that you have entered general information, defined the mapper format and 
selected the mapper record type. 
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Specify the name, type, and value of each data field in the output file. If you select a fixed-length output file format in 
the general section of the Data Mapping Tool, you must also specify each field length. Depending on your selection in 
the record type section of the Data Mapping Tool, you see the column definition page for your first selection; header, 
detail, or footer record. You complete the field definitions for each record type and save the mapper. Once the first 
field is completed, you can insert fields before or after, edit, or delete fields. 

 
Figure 215: Create Mapper page-step 3 

1. Click Add Field. The Add Field dialog displays. All fields in this dialog are required. 

 
Figure 216: Add Field dialog 

2. In the Field Name field, enter the name of the field you want to display in Online Card Management. You can 
use up to 50 characters. 
Note: The field name does not display in the output file. 

243 

 



 

3. In the Field Length field, enter the number of characters in the field. This is a numeric field. This field does 
not display if you chose a delimited output file format in the general section of the Data Mapping Tool. 

4. From the Field Type list, select the type of field you are adding (for fixed-length fields). This selection 
populates the Field Value list where you further refine the data to be output in  
this field. 

5. Select the field value from the Field Value list. This list is dependent on your selection in the Field Type list. 
6. Click OK. The field displays in the Define Columns For ... Record section. 

• The Order field automatically updates and shows the sequential, left to right, order the field will display 
in the output file. You can insert fields before or after any field, if required. 

• For Fixed Length files, the Field Length and Position fields show the length and cumulative position of 
each field in the output file. 

7. Repeat steps 1 - 6 for each field required for the header, detail, or footer record. 
8. Click Finish to complete the mapper. 

 

Using Mappers in Online Card Management 
You create, run, schedule, and manage mappers in the Manage Mappers page. Use the Data Mapping Tool to create 
and edit mappers. Once created, the mappers are listed here. You can run a mapper or schedule it to run using the 
Scheduler. See "To schedule a mapper (on page 267) for complete step-by-step instructions on scheduling mappers. 
Select Reports >Data Mapping from the menu to access the Manage Mappers page. 

 
Figure 217: Manage Mappers page 

 

To run a mapper 
1. Select Reports > Data Mapping Tool from the menu. The Manage Mappers page displays. 

 
Figure 218: Manage Mappers page 
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2. From the list of mappers, find the mapper you want to run and click the  icon. The Run Mapper page 
displays. 

 
Figure 219: Run mapper page 
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3. Choose one of the following Flag transactions as mapped options: 

• Select the Yes option to flag transactions as mapped when the mapper runs. If transaction has in the 
mapped status, account holders can no longer allocate the transaction, split the transaction, or attach 
the transactions to expense reports. The Lock Description Field options enable when you select Yes. 

• Note: Transactions with mapped status are excluded from future output files. 
• Select No for the Flag transactions as mapped option to prevent the transactions from being assigned 

a mapped status. Selecting No also activates the Include mapped transactions options. 

Note: If you choose No and retain the unmapped status, you can include these transactions in future output files. 
4. If you selected the No in step 3, choose one of the following Include mapped  

transactions options: 
• Select Yes to include mapped transactions from previous mappers in the output file.  
• Select No to exclude previously mapped transactions. 

5. If you selected Yes in step 3, choose one of the following Lock Description Field options: 
• Select Yes if you do not want account holders to edit transaction descriptions after running the mapper. 
• Select No if you want to allow account holders to edit transactions after running  

the mapper. 

6. From the Date type list, select either the posted date or the transaction date (occurred). 
7. From the Date Range list, select the range you want.  

If you select "Custom", the From and To fields activate. Enter the dates in the fields, or click the  icon to 
select the dates from a calendar. 

8. Select the account and units for which you are running the mapper. You can run the mapper against 
combined accounts and units. 

• Select Account from the Search by list, specify further search criteria in the Search for field, and click 
Search. 
If you select "Account name" or "Account number", all accounts that meet your search criteria display in 
the Select List page. Select the accounts and click Add to Search. The accounts display in the Selected 
list. If you select "Unit name" or "Unit number", all accounts within the units that meet your search criteria 
display in the Select List page. Select the accounts and click Add to Search. The accounts display in 
the Selected list. 

• Select Unit from the Search by list, specify further search criteria in the Search for field, and click 
Search. 
You can search by "Unit name" or "Unit number", all units that meet your search criteria display in the 
Available list. Click on the units to display them in the Selected list. If you want to include subunits, select 
Yes as the Include subunits option. 

 
Note: You must select at least one account or unit. 
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9. Click Run. An informational dialog displays when the mapper runs. A message displays informing you that 
the mapper is running. 

 
Figure 220: Run Mapper confirmation 

10. Click OK to exit the dialog. 
11. Use the Output Log to verify the status of the mapper. 

 

To edit a mapper 
You edit mappers using the same Data Mapping Tool you use to create them. 

1. Select Reports > Data Mapping Tool from the menu. The Manage Mappers page displays. 

 
Figure 221: Manage Mappers page 

2. Locate the mapper and click the  icon. The Edit Mapper page displays. This is the first page in the Data 
Mapping Tool. The mapper fields are editable.  

3. Locate the fields you want to change. Click Next to navigate through the Data Mapping Tool to find the fields 
you want to edit. 
Tip: See "To create a mapper using the Data Mapping Tool (See "Creating mappers using the Data Mapping 
Tool" on page 235) for detailed instructions on mapper fields and settings. 

4. Click Next. The final page of the Data Mapping Tool displays. 
5. Edit the fields as necessary. 
6. Click Finish to save the changes. 

 

To delete a mapper 
1. Select Reports >Data Mapping from the menu. The Manage Mappers page displays. 

2. Locate the mapper and click the  icon. A confirmation dialog displays. 
Note: If the mapper is a scheduled event, you cannot delete it until you have removed it from the schedule. 
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3. Click OK. Online Card Management deletes the mapper. 
 

To insert a field into a mapper 
1. Select Reports > Data Mapping from the menu. The Manage Mappers page displays. 

 
Figure 222: Manage Mappers page 

2. Locate the mapper and click the  icon. The Edit Mapper page displays. This is the first page in the Data 
Mapping Tool. The mapper fields are editable. 

3. Click Next until you reach Step 3: Define columns for detail record. 

4. Locate the field next to which you want to insert the new field and click the corresponding  icon. The 
Insert Field dialog displays. 

 
Figure 223: Insert Field dialog 

5. Select Above Allocation for the Insert Field option to insert a new field before the field. Click Below 
Allocation to insert the new field after the field. This is a required field. 

6. In the Field Name enter the name of the field as it should apply in Online Card Management. You can use up 
to 50 characters. This is a required field. 
Note: The field name does not display in the output file. 
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7. In the Field Length field enter the number of characters in the field. This is a numeric field and is required. 
Note: This field does not apply to delimited mappers, it only displays if you are inserting a field into a fixed-
length mapper. 

8. Select the type of field from the Field Type list. This selection populates the Field Value list where you 
further refine the data to be output in this field. This is a required field. 

9. If applicable, select the field value from the Field Value list. This list is dependent on your selection in the 
Field Type list. 

10. Click OK. The field displays in the Define Columns For ... Record section. The Order field automatically 
updates to show the insertion order. For fixed-length mappers, the Field Length and Position fields update 
to show the inserted field. 

11. Click Finish to save the changes to the mapper. 
 

To edit a field in a record 
1. Select Reports >Data Mapping from the menu. The Manage Mappers page displays. 

 
Figure 224: Manage Mappers page 
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2. Locate the mapper and click the  icon. The Edit Mapper page displays. This is the first page in the Data 
Mapping Tool. The mapper fields are editable. 

3. Click Next until you reach Step 3: Define columns for detail record. 

4. Locate the field you want to edit and click the corresponding icon. The Insert Field  
dialog displays. 

 
Figure 225: Insert Field dialog 

5. Edit the necessary fields. 
6. Click OK to save the changes. 
7. Click Finish to save the changes to the mapper. 
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Managing mappers as a bank administrator 
The Bank Mapper Manager lets you work with bank-level mappers. Bank Administrators can use the Bank Mapper 
Management create bundles of mappers, assign bundles and mappers to organizations. Bundles let you group 
mappers together so you that you can quickly assign mappers to the sites that you administer.  

 
Figure 226: Bank Mapper Management 

The following procedure explain how you can use the Bank Mapper Manager to work with mappers in Online Card 
Management. 
 

To create a mapper bundle 
Bundles let you group a series of mappers that logically belong together. For example, if your bank assigns five 
standard mappers to all of your organization sites, you can create a bundle of standard mappers and then associate 
the bundle with the organizations rather than creating the mapper for each site. Complete the following to create a 
mapper bundle. 

1. Select Reports > Bank Mapper Management from the menu. The Bank Mapper Management page displays. 

 
Figure 227: Bank Mapper Management 
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2. Click the Bundles link. The Bundles page displays. 

 
Figure 228: Bundles page 

3. Click Add A Bundle. The Add Bundle page displays. 
Tip: If you want to create a bundle that is very similar to an existing bundle, click the Copy icon for the bundle 
you want to copy and then change the bundle. 

 
Figure 229: Add a Bundle page 

4. From the Bank list, select the bank you want to associate with this bundle. 
Note: If you only have access to one bank, the bundle is assigned to your bank automatically.  

5. In the Name field, enter a unique name for the bundle. The name can contain up to 250 characters. 
6. In the Description field, enter a brief explanation of the bundle's purpose. The description can contain up to 

500 characters. 
7. Select the Automatically assign this bundle to new corps check box if you want all new sites you set up 

to have access to this set of mappers. 
8. Click Add. Online Card Management creates the new bundle. The Bundle Details page displays listing the 

newly created bundle. 
You are ready to assign bank-level mappers to this bundle, as described in "To assign mappers to bundles (See "To 
assign mappers to a bundle" on page 253). 
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To assign mappers to a bundle 
Use this procedure to associate existing mappers with a bundle.  
Important: If you are assigning mappers to a bundle at the same time as you create the bundle, begin this procedure 
at step 5. This procedure assumes that you have already complete the "To create a mapper bundle procedure on 
page 251. 

1. Select Reports >Bank Mapper Management from the menu. The Bank Mapper Management page displays. 
2. Click the Bundles link. The Bundles page displays. 
3. From the Bank list, select the bank to which the bundle belongs. 

Note: If you only have access to one bank, this selection is made for you. 

4. From the list of available bundles, click the Details icon of bundle to which you want to add mappers. The 
Bundle Details page displays. 
 

 
Figure 230: Bundle Details page 
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5. From the Bundle Details page, click Add Mappers To Bundle. The Add Bank Mappers to <bundle name> 
page displays listing the mappers that are available for assignment. 

 
Figure 231: Add Bank Mappers to <bundle name> page 

6. Select the check boxes that correspond to the mappers you want to assign to the bundle. 
7. Click Add. The Bundle Details page redisplays listing the mappers associated with the bundle. 

 

Assigning bundles to organizations 
You can select the organizations that you want to a mapper bundle to, or you can assign the bundle to all of the 
organizations under your bank. The following procedures explain how you can do this in Online Card Management. 
 

To assign bundles to selected organizations 
Completing this procedure assigns a bundle to selected organizations. See "To assign bundles to all organizations" on 
page 256 if you want to assign the bundle to all of the organizations under your bank. 

1. Select Reports > Bank Mapper Management from the menu. The Bank Mapper Management page displays. 

 
Figure 232: Bank Mapper Management 
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2. Click the Bundle Assignments link. The Bundle Assignments page displays. 

 
Figure 233: Bundle Assignments page 

3. From the Bank list, select the bank to which the bundle belongs. 
Note: If you only have access to one bank, this selection is made for you. 

4. Click the bundle for which you want to make bundle assignments. The Bundle Assignments for <bundle 
name> page displays. 

 
Figure 234: Bundle Assignments for <bundle name> page 

5. Click Assign To Individual Corps. The Assign <bundle name> to Corps page displays. 

 
Figure 235: Assign <bundle name> to Corps page 
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6. From the list of available organizations, select the check boxes for the organizations to which you want to 
assign the bundle. 

7. Click Assign. The Bundle Assignments page displays listing the organizations assigned to the selected 
bundle. 
Tip: Click the Unassign From All Corps to remove the bundle assignment from all the organizations that 
belong to your bank. 

 

To assign bundles to all organizations 
Completing this procedure assigns a bundle to all the organizations under your bank. See "To assign bundles to 
selected organizations on page 254 if you want to choose the organizations to which the bundle is assigned. 

1. Select Reports>Bank Mapper Management from the menu. The Bank Mapper Management page displays. 

 
Figure 236: Bank Mapper Management 

2. Click the Bundle Assignments link. The Bundle Assignments page displays. 

 
Figure 237: Bundle Assignments page 

3. From the Bank list, select the bank to which the bundle belongs. 
Note: If you only have access to one bank, this selection is made for you. 
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4. Click the Details icon for the bundle for which you want to make bundle assignments. The Bundle 
Assignments for <bundle name> page displays. 

 
Figure 238: Bundle Assignments for <bundle name> page 

5. Click Assign To All Corps. The Assign <bundle name> to All Corps page displays. 

 
Figure 239: Assign <bundle name> to All Corps page 

6. Select the Automatically assign this bundle to new corps check box if you want any new organization 
sites that you set up in the future to have this bundle assignment without having to complete the assignment 
procedure. 

7. Click Assign. The Bundle Assignments page displays listing the organizations assigned to the selected 
bundle. 
Tip: Click Unassign From All Corps to remove the bundle assignment from all the organizations that belong 
to your bank. 

 

To assign individual mappers to organizations 
Use this procedure to assign mappers to organizations without using a bundle. 

1. From the Reports menu, select Bank Mapper Management. The Bank Mapper Management page displays. 

 
Figure 240: Bank Mapper Management 
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2. Click the Bank Mapper Assignments link. The Bank Mapper Assignments page displays. 

 
Figure 241: Bank Mapper Assignments page 

3. From the list of available bank mappers, click the Details icon of the mapper you want to assign. The Bank 
Mapper Assignments for <mapper name> page displays. 

 
Figure 242: Bank Mapper Assignments for <mapper name> page 

4. Click Assign To More Corps. The Assign <mapper name> to Corps page displays. 

 
Figure 243: Assign <mapper name> to corps page 

5. From the list of available organizations, select the check boxes that correspond to the organizations to which 
you are assigning the mapper. 

6. Click Assign. The Bank Mapper Assignments page redisplays. 
 

To view bundle and bank mapper assignment information 
You can use the Online Card Management's Bank Mapper Management tool to view the bundle and bank mapper 
assignments by corporation.  
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1. Select Reports> Bank Mapper Management from the menu. The Bank Mapper Management page displays. 

 
Figure 244: Bank Mapper Management 

2. Click the Bundle and Bank Mapper Assignments by Corp link. The Bundle and Bank Mapper Assignments by 
Corp page displays. 
 

 
Figure 245: Bundle and Bank Mapper Assignments by Corp page (search) 

3. In the field provided, enter the name of the corporations whose bundle and mapper assignment information 
you want to see. 

4. Click Search. The organizations that match your search criteria display. 
5. From the search results, click the Details icon of the organization you want to view. The Bundles and 

Mappers Assigned to <organization> page displays. 
 

 
Figure 246: Bundles and Mappers Assigned to <organization> page 
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6. From this page you can: 

• Unassign a bundle or mapper by clicking the  icon. 
• Assign more bundles  
• Assign more bank mappers 
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Scheduling Tasks 
Using the Scheduler, reports and mappers can automatically run at regular intervals and larger tasks, which take 
longer to process, can be scheduled for weekend days when more system resources are available. For example, you 
could run the Statement of Account report for a large group of account holders every Sunday. When you arrive at work 
on Monday, the report is ready for you to download from the Output log. 
This chapter includes the following sections: 
• Scheduling a report (see topic on page 261) 
• Scheduling a mapper (see topic on page 267) 
• Viewing scheduled task information (see topic on page 272) 

 

Scheduling a report 
Use the Scheduler to generate a report on a regular interval without requiring user interaction. Scheduled reports 
deliver information to you and your users without taking away time from your regular duties. The Scheduler can create 
tasks for both saved and standard reports. 
Scheduled reports do not use the date range functions defined in the report criteria. When you create a scheduled 
report, the report includes transaction data from the previous interval according to the scheduled report interval. Daily 
reports display data for the previous day, weekly reports display data for the previous week, and monthly reports 
display data for the previous month. For example, if you schedule a monthly Transaction report for 9/10/08, the report 
displays the transactions that match the reporting criteria from 8/1/08 to 8/31/08. 
Scheduled reports are generated after 3:00 PM Mountain Time and are posted to the Output log. After you download 
the report, you can choose to delete the report from the Output log. For more information on the Output log, see "To 
view the Output Log". 
There are two methods for creating a report schedule: you can schedule the report directly in the Scheduler, or you 
can schedule the report as you enter reporting criteria. See "Standard reports (on page 226) for more information 
entering report criteria. Read the following topics to understand how to use the Scheduler and work with saved 
reports. 
 

Creating a scheduled report in the Scheduler 
The Scheduler manages all scheduled tasks in Online Card Management. You can select any standard or saved 
report and create a timetable for the report to generate automatically. You can choose to have a scheduled report run 
daily, weekly, or monthly. If you are interested in scheduling a standard or saved report from the report criteria page, 
read "Scheduling a saved or standard report (on page 265) for more information. 
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To schedule a report in the Scheduler 
1. Select Reports> Scheduler from the menu. The Scheduler page displays. 

 
Figure 247: Scheduler page 

2. Click Schedule New Event. The Schedule New Task page displays. 

 
Figure 248: Schedule New Task 

3. From the Task category list, select Reports and click Search. A list of the saved and standard reports 
opens.  
 

 
Figure 249: Schedule New Task 

4. From the Reports list, select the report for which you are creating a schedule by clicking the Schedule icon. 
To schedule a report, you must have the security permissions necessary to run the report. See "Working with 
user security profiles (on page 72) for more information on security privileges. 
Note: You cannot schedule the Cardholder Dispute or Expense reports because they are specific to a 
transaction. They do not display in this list. 

5. Click Next. The criteria for the selected report display. 

• If you are creating a schedule for a standard report, complete the required and optional criteria for the 
selected report, as necessary. See the procedure for entering criteria specific to your report in the 
Standard reports section on page 226 or review the procedure for your report using the online help.  
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• If you are creating a schedule for a saved report, the report criteria are already entered for you. Review 
the information on this page to confirm that the saved criteria will produce the desired report. 

 
Figure 250: Schedule New Task—Step 1 
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6. Click Next. The Name and schedule task criteria section displays. 

 
Figure 251: Schedule New Task—Step 2 

7. In the Task name field, enter a name for the report schedule. 
8. Select a frequency option. The frequency determines the date range used to generate scheduled reports. 

Scheduled reports always display data for the previous interval according to the frequency option. That 
means daily reports display data for the previous day, weekly reports display data for the previous week, and 
monthly reports display data for the previous month. 
• If you select Weekly, select the option for the day of the week on which you want to run the report. 
• If you select Monthly, select the date on which you want to run the report. 
• If you select Cycle, choose the cycle you want to use from the list and enter the number of days to wait 

after the cycle ends. 
Note: If you schedule a monthly report to run on a date that does not exist in every month, the report runs on 
the last day of the month. For example, if you schedule a report to run on the 31st day of the month, the 
report will run on the last day of the month in February, April, June, September, and November. 

9. From the Output format list, select the file format in which you want your report to display. 
10. Select the Yes for the Email me when the report is ready option if you want to receive an email every time 

the report runs. 
Note: Online Card Management sends the email message to the email address in the user profile for the 
user who creates the report schedule. See "Creating a user (on page 135) for more information on user 
profiles. 
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11. Click Next. The Review task settings page displays. 

 
Figure 252: Schedule New Task—Step 3 

12. Evaluate the scheduled task settings. If you want to change a setting, click the corresponding Edit Settings 
button. 

13. Click Finish. A message displays confirming that the task schedule. 

 
Figure 253: Scheduled Task saved message 

14. Click OK. The report generates after 3:00 PM Mountain Time on the next scheduled date. 
 

Scheduling a saved or standard report 
You can create a schedule for a standard report or a saved report as you enter the criteria for the report. When you 
create a report schedule in a standard report, the Schedule criteria page displays after you enter the report criteria. 
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The selected Date Range option is ignored in the scheduled reports; scheduled reports display data that occurred 
since the last time the report was generated. 
 

To schedule a report as you enter the report criteria 
1. Select Reports >Standard Reports from the menu. The Standard Reports page displays. 
2. From the Standard Reports list, select the report you want to schedule. To schedule a report, you must have 

the security permissions necessary to run the report. 
Note: You cannot create a schedule for the Cardholder Dispute or Expense reports. 

3. Click Next. The criteria page for the selected report displays. If you select 

• If you are creating a schedule for a standard report, complete the required and optional criteria for the 
selected report, as necessary. Review the online help for information on entering report criteria for a 
specific report. 

• If you are creating a schedule for a saved report, the report criteria are already entered for you. Review 
the information on this page to confirm that the saved criteria will produce the desired report. 

4. Complete the report criteria for the selected report. See "Standard reports (on page 226)  for more 
information on completing the report criteria. 
Note: Report schedules do not use the criteria you enter in the Date Range fields; scheduled reports always 
include data for the previous scheduled interval. However, a valid date range is required to complete the 
report criteria page. 

5. When you have completed the criteria for the report, click Schedule. The Schedule New Task page displays. 
6. In the Task name field, enter a name for the scheduled report. 
7. Select a frequency option. The frequency determines the date range used to generate scheduled reports. 

Scheduled reports always display data for the previous interval according to the frequency option. That 
means daily reports display data for the previous day, weekly reports display data for the previous week, 
monthly reports display data for the previous month, and cycle reports display data for the previous cycle. 

• If you select Weekly, select the option for the day of the week on which you want to run the report. 
• If you select Monthly, select the date on which you want to run the report. 
• If you select Cycle, select the cycle option from the list and enter the number of days to wait after the 

cycle ends before the report runs. 

Note: If you schedule a monthly report to run on a date that does not exist in every month, the report runs on the 
last day of the month. For example, if you schedule a report to run on the 31st day of the month, the report 
will run on the last day of the month in February, April, June, September, and November. 

8. From the Output format list, select the format in which you want your report to display. 
9. Select the Yes for the Email me when the report is ready option if you want to receive an email every time 

the report runs. 
Note: Online Card Management sends the email message to the email address in the user profile for the 
user who creates the scheduled report. See "Creating a user (on page 135) for more information on user 
profiles. 
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10. Click Next. The Review task settings page displays. 
11. Evaluate the scheduled task settings. If you want to change a setting click the corresponding Edit Settings 

button. 
12. When you are satisfied the settings are to your liking, click Finish. A message displays confirming that the 

report is in the Scheduler. 
13. Click OK. The report generates after 3:00 PM Mountain Time on the next scheduled date. 

 

Scheduling a mapper 
You schedule a mapper using the Scheduler. When you schedule a mapper, you specify the transaction date range 
using the Scheduler. 
 

To schedule a mapper 
You schedule your mappers from the Manage Mappers page. If you want to run the mapper directly, see "To run a 
mapper (on page 244). 

1. Select Reports > Data Mapping from the menu. The Manage Mappers page displays. 

 
Figure 254: Manage Mappers page 
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2. Select the mapper you want to schedule and clieck the Schedule icon. The Schedule Mapper…  
page displays. 

 
Figure 255: Schedule Mapper- step 1 
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3. Select one of the Flag transactions as mapped options detailed below: 

• Select Yes for the Flag transactions as mapped option to flag transactions as mapped. The following 
events occur when a transaction has a mapped status: 
 Transaction data copies to an output file. 
 Online Card Management flags he mapped transactions with a mapped status. Transactions with 

this status are excluded from future output files. 
 Proceed to step 4 and complete the Date Information section. 

• Select No for the Flag transactions as mapped option to prevent transactions from being flagged as 
mapped and to activate the Ignore mapped transactions option. Transactions will retain an unmapped 
status if you select this option. 

Note: If you choose No (retain the unmapped status) these transactions could be included in future output files. 
• Select Yes for the Ignore mapped transactions option to include mapped transactions in the output file.  

4. Select the date type from the Date type list. 
5. Select the account and units for which you want to run the mapper. You can run the mapper for a 

combination of accounts and units. 

• To select accounts, choose the Account Search option, select an option from the Search by list, enter 
further search criteria in the Search for field, and click Search. 
 If you select "Account name" or "Account number", all accounts that meet your search criteria 

display in the Select List page. Select the accounts and click Add to Search. The accounts display 
in the Selected list. 

 If you select "Unit name" or "Unit number", all accounts within the units that meet your search 
criteria display in the Select List page. 

Select the accounts you wish to include in the mapper and click Add to Search. The accounts display in the 
Selected list. 

• To select Units, choose the Unit Search option, select an option from the Search by list, enter further 
search criteria in the Search for field, and click Search. 
 You can search by "Unit name" or "Unit number", all units that meet your search criteria display in 

the Available list. 
 Click the units to display them in the Selected list. If you want to include subunits, select Yes for the 

Include subunits option. 
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6. When all the accounts and/or units display in the Selected list, Click Next. The Name and Schedule Task 
page displays. 

 
Figure 256: Schedule Mapper- step 2 

7. Enter a descriptive name for the task in the Task name field. This field is required. 
Note: If you are creating a schedule for an existing mapper, the description of the mapper automatically 
displays in this field. 

8. Select the Frequency option. 
• If you select Daily, the task will run every day. 
• If you select Weekly, the day of the week option set is activated. Select which day of the week you want 

the task to run. The task will run once per week on the day you select. 
• If you select Monthly, the Select day of month list is activated. Select which date in the month you 

want the task to run. The task will run once per month on the date you select. 
• If you select Cycle, the Cycle name list is activated. Select the cycle you want the task to run. Have the 

option of delaying the mapper by entering the number of days after a cycle the mapper should begin to 
run in the Delay field. For example, if your cycle is set up to run every Friday, typing "1" in the Delay 
field will set the task to run on Saturday. 
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9. Select Yes from the Email me when the report is ready option to receive an email notification when the 
scheduled mapper has run and is available for review. Online Card Management sends the notification 
message to the email address in your personal information. 

10. Click Next. The Review task settings page displays. 

 
Figure 257: Schedule Mapper- step 3 

11. Review the task settings in each of the task setting sections. 
12. If you see a setting you want to change, navigate to the tab containing that section.  
13. Modify the setting and click the Review and Submit tab. The Review task settings page displays. 
14. When you have verified all task settings, click Finish. A confirmation dialog displays and the task is 

scheduled. You can view the scheduled task in the Scheduled Events list. 
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Viewing scheduled task information 
The Scheduler displays an inventory of scheduled tasks in two views: a calendar view and list of scheduled tasks. 
Both of these views display list of upcoming tasks scheduled in Online Card Management. The list of scheduled tasks 
displays the next occurrence of each scheduled task. The calendar view displays every scheduled instance of the 
report in a graphical calendar view for a period of time. Complete one of the following to view upcoming scheduled 
tasks. The List option lets you modify the schedule, reporting criteria, or delete an instance of a scheduled report. 
 

To view the scheduled task calendar 
1. Select Reports >Scheduler from the menu. The Scheduler page displays. 
2. Select a value to search by from the Search by list. 

a. If you select "Date created", "Last run date", or "Next run date", type a date range in the From date 
and To date fields. You can type a date in these fields or click the calendar icon ( ) next to each 
field to select a date from the calendar. 

b. If you select "Event name", type the event name in the Search for field. You can use wildcard (*) 
searches. 

c. If you select "Event type", select the event type from the Event type list. 
d. If you select "Status", select the event status from the list. 

3. Click Search. The search results display in the Scheduled Events section. You can review the event's history 
and status, modify the event schedule, modify an event's criteria, or delete a scheduled event. 

4. If you selected "Date created", "Last run date", or "Next run date" from the View option, select a value from 
the Display by list. 

a. If you select "Day" from the Display by list, type the date in the field. You can click the calendar 
icon ( ) to select a day from the calendar. Click Update Display. All scheduled events for that 
day display in the Scheduled Events section. 

b. If you select "Week" from the Display by list, click the calendar icon ( ) to select a day from the 
calendar then click Update Display. All scheduled events for that week display in the Scheduled 
Events section. 

c. If you select "Month" from the Display by list, click the calendar icon ( ) to select a month from 
the calendar then click Update Display. All scheduled events for that month display in the 
Scheduled Events section. 

Note: The events listed in Calendar view are for review only. You can use calendar view to locate a 
scheduled event but you must use list view to delete it or modify the schedule or event criteria. 

 
 
 

Editing a scheduled report 
Use the Scheduled task list to modify a report schedule, change the reporting criteria for a scheduled report, or delete 
a report schedule. The changes you make to scheduled reports apply to all future instances of the scheduled report. 
The following procedures explain how to edit a scheduled report. 
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To modify a task schedule 
1. Find the task (report or mapper) you want to change in the scheduled task list. See "To view the scheduled 

task list (on page 272) for instructions on using the scheduled task list. 

2. Click the corresponding  icon in the Modify Schedule column of the scheduled task list. The Schedule 
Task Name page displays. 

3. Change the schedule as necessary. 
4. Click Update. The Review Task Settings page displays. 
5. A message displays confirming that the task was scheduled. Click OK. 

 

To delete a scheduled report 
1. Find the task you want to delete from the scheduled task list. See “To view the scheduled task list” on page 

272 for instructions on using the scheduled task list. 

2. Click the corresponding  icon in the Delete column of the scheduled task list. A message displays 
asking you to confirm that you want to delete all future instances of the scheduled task. 

 
Figure 258: Delete Scheduled Event confirmation message 

3. Click Delete. Online Card Management removes the scheduled task from the scheduled task list and cancels 
all future instances of the task. 

 

To change task criteria for a scheduled task 
1. Find the task you want to delete from the scheduled task list. See "To view the scheduled task list (on page 

272) for instructions on using the scheduled task list. 

2. Click the corresponding  icon in the Modify Criteria column of the scheduled task list. The Report 
Criteria or the Mapper Criteria page for the selected task displays. 

3. Change the criteria as necessary. 
4. When you are satisfied the settings are to your liking, click Update. A message displays confirming that the 

task was scheduled. 
5. Click OK. 
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Making payments online 
You can use Online Card Management to make payments towards your account balance. This easy-to-use tool 
quickly processes a payment towards your account in Online Card Management. The process is secure and 
eliminates any paper check writing and the need for mail. Before you can send a payment in Online Card 
Management, you must specify the Paying Account as described in To create new paying accounts. Once the paying 
account or accounts are established, you can make a payment towards your account online.  
This chapter contains the following topics to explain everything you need to do to setup paying accounts and make 
payments in Online Card Management: 
• Maintaining paying accounts (see topic on page 275) 
• Making a payment toward your account balance (see topic on page 278) 
• Reviewing payment history (see topic on page 288) 

 

Maintaining paying accounts 
To make online payments, you must enter paying accounts in Online Card Management. Paying accounts are the 
accounts from which the funds for a payment originate. Creating a paying account in Online Card Management is 
easy to complete using the information that is displayed on a check or a deposit slip for the paying account. You can 
create as many paying accounts as needed. 
Note: When you access Payment Management, Online Card Management displays the last account from which you 
paid in the Pay from list. Your existing payment accounts are displayed on this page and you can change the account 
when you make the payment. 
 

To create paying accounts 
1. Select Statements > My Bank Accounts from the menu. The My Bank Accounts page displays. 

 
Figure 259: My Bank Accounts 
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2. Click Add New Bank Account. The Add New Bank Account page displays.

 
Figure 260: Add New Bank Account 

Provide the following information in the fields provided. Those fields marked with an asterisk (*) are required. 

a. Required - Select the Account Type from the list and choose whether the account is a Personal or 
Business account. 

b. Required - Select the currency type from the Account Currency list. 
c. Required - Specify the account number in the Account Number field. The number must be 5 to 17 digits 

in length and must not have dashes or spaces. 
d. Required – Specify the 9 digit Transit Routing Number in the Transit Routing Number field. 
 
The following graphic illustrates where the Account Number and Transit Routing Number are located on most 
checks. 

 
Figure 261: Routing and Account number examples 
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e. Required - Specify the Account Nickname. This is useful to distinguish between multiple paying 
accounts. 

f. Required - Specify the account address in the Address Line 1 field. If an additional address is required, 
enter that in the Address Line 2 field. The Address Line 2 field is not required. 

g. Required - Specify the account city in the City field. 
h. Required - Select the account state or province from the State / Province list. 
i. Required – Specify the account postal code in the Postal Code field. 

3. Verify the information you provided and click Add Account. The My Bank Account page re-displays with 
your new paying account listed. 

 
Figure 262: My Bank Accounts - new paying account 

Important: Make sure the account number you enter is valid. When you save the new paying account, only the transit 
routing number is verified. The account number is verified the first time a payment is submitted using the paying 
account. 
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To edit an existing paying account 
Scheduled payments are not updated with edited paying account information. Before you edit a paying account, check 
the payment log to verify that there are no scheduled payments using it. If there are payments scheduled, delete and 
reschedule them using the updated paying account. 

1. Select Statements >My Bank Accounts from the menu. The My Bank Accounts page displays. 
2. Click Edit for the paying account you want to change. The Edit Bank Account page displays. 

 
Figure 263: Edit Bank Account 

All fields are editable except the Account Type and Account Currency fields. If these fields need to be 
changed, you must cancel any payments outstanding on this account, delete the account, and create a new 
paying account.  

3. Make any changes required and click Save Account. The My Bank Accounts page redisplays with your edits 
displayed. 

 
 

Making a payment towards your account balance 
After you have set up your paying accounts (see topic on page 275), you can make payments on your account online 
using the card management system. With the payment functionality of Online Card Management, you can: 
• Set up same day payments 
• Schedule future payments 

Note: Contact your system administrator to find out how many days in advance you can schedule a payment. 
• Review payment status and history 
• Create and maintain paying accounts 

The payment process involves setting up the payment, making the payment, and reviewing a receipt of your payment. 
Tip: For additional help while making a payment, choose Help>Help On This Page from the menu. 
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To make a payment on your account 
1. Select Statements > Payments from the menu. 
2. If you have a single account, the Define Payment Details page displays. 

 
Figure 264: Define Payment Details - Single Account 

3. Review the information for your account then select a Payment Amount option: 

• Pay statement balance 
• Pay minimum amount due 
• Pay current balance 
• Pay other amount 
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4. Select a paying account  from the Pay From: list 
5. Specify a Payment Date:. You can type the date in the field using the MM/DD/YYYY format or use the 

calendar control (  ) to select a payment date. 
6. Click Confirm Payment . The Confirm Payment page displays. 

 
Figure 265: Confirm Payment page 

7. Review the information on the Confirm Payment page. If you need to change information, click on the Modify 
link at the bottom to return to the Make Payment page. If the information is correct, type your log on 
password in the Password field and click Submit Payment to make the payment. The Payment Receipt 
page displays. 

Important: You must click Submit Payment to make the payment. The payment will not be processed until 
you click Submit Payment. 
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Figure 266: Payment Receipt page 
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8. On the payment receipt page you have the option to print the receipt to a local printer by clicking Print at the 
bottom of the receipt. 

Recurring Payment Option: 
1. Follow steps 1-5 above. 

 
Figure 267: Define Payment Details 
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2. Select whether to make the payment on Payment Due Date or Day of the Month. If you select Day of the 
Month, you will choose the day of the month from the drop down list. 

3. Select how long continue recurring payments: I stop or change my plan or Month and Year. If you select 
Month and Year, you will choose the number of the month and the year from the drop down list. 

4. Review the information on the Confirm Payment page. If you need to change information, click on the 
Modify link at the bottom to return to the Make Payment page. If the information is correct, type your log on 
password in the Password field and click Schedule Payment. The Authenticate and Confirm Payment 
dialog box displays.  

 
Figure 268: Authenticate and Confirm Payment 

5. Review the information and enter your password. Click Submit Payment Schedule. 
 

To make a payment on multiple accounts 
1. Select Statements > Payments from the menu 
2. Search for accounts by specifying search criteria from the Search Account list. You can select Name on Account 

or Account Number. You can also use an asterisk (*) as a leading or trailing wildcard character for partial 
searches. 
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Figure 269: Payments page - multiple accounts 

3. Select additional search filters:  Active accounts, Inactive within 45 days, Inactive longer than 45 days 
4. Click Search. The search results display below. 
5. Select the account or accounts you want to make a payment on. You can also select the check box next to the 

Search Results header to select all accounts. The first 60 accounts displayed can be selected for payment in this 
way. The selected accounts are displayed in the Selected Accounts list. 

 
Figure 270: Search Results 
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Figure 271: Confirm Payment page 

6. Click Continue. The Define Payment Details page displays. 

 
Figure 272: Define Payment Details 

7. Select Payment Method: Standard or Recurring (see Recurring Payment option below). 
8. Select the paying account from the Pay From : list. 

9. Specify the Payment Date. You can use the calendar control ( ) to select a date or type the date using the 
MM/DD/YYYY format. 
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10. Select the account to make a payment on. 
11. Select the payment amount from the Amount field. If you select Other Amount, a field displays that allows you to 

specify the amount using the 000.00 format. Do not type currency symbols in this field. 
12. Click Make Payment. The Authenticate and Confirm Payment page displays. 
13. Review the payment information and type your logon password in the Password field. 
14. Click Submit Payment. The Payment Request Receipt page displays. You have the option to print this page to a 

local printer or to make another payment. 

 
Figure 273: Confirm Payment 

15. Review the information on the Confirm Payment page. If you need to change information, click on the Modify link 
at the bottom to return to the Make Payment page. If the information is correct, type your log on password in the 
Password field and click Submit Payment to make the payment. The Payment Receipt page displays 

Important: You must click Submit Payment to make the payment. The payment will not be processed until 
you click Submit Payment. 

 
16. On the payment receipt page you have the option to print the receipt to a local printer by clicking Print at the 

bottom of the receipt.. 
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Figure 274: Payment Request receipt 

 
Recurring Payment Option: 

1. Follow steps 1-8 above.  

 
Figure 275: Define Payment Details 
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2. Select whether to make the payment on Payment Due Date or Day of the Month. If you select Day of 
the Month, you will choose the day of the month from the drop down list. 

3. Select how long continue recurring payments: I stop or change my plan or Month and Year. If you 
select Month and Year, you will choose the number of the month and the year from the drop down 
list. 

4. Review the information on the Confirm Payment page. If you need to change information, click on the 
Modify link at the bottom to return to the Make Payment page. If the information is correct, type your 
log on password in the Password field and click Schedule Payment. The Authenticate and Confirm 
Payment dialog box displays.  

 
Figure 276: Authenticate and Confirm Payment 

5. Review the information and enter your password. Click Submit Payment Schedule. 

 
 
 

Reviewing payment history 
You can review the status of payments made for up to 12 previous months, cancel unprocessed payments, or review 
the detail of a single payment on this page. Only online, telephone, and voice response unit (VRU) payments are 
listed. To view all previous payments for the account, return to your online banking site. 
Payment status 
The payment status indicates the payment processing status. 
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• Future - The payment has not been processed. You can edit or cancel this payment. 
• Pending - The payment will be processed that day. You can edit or cancel this payment before the payment 

cutoff time (5:00 P.M. Eastern time) 
• Processed - The payment was processed and cannot be edited. 
• Cancelled - The payment was cancelled by the user. 

 

To view the payment log 
1. Select Statements > Payments from the menu. The Make Payment page displays. 

 

 
Figure 277: Make Payment page 

2. Click Payment Log. The Payment Log page displays listing the payments made for that account. 

 
Figure 278: Payment Log page 
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3. Click Details to view more information about the payment. 

 
Figure 279: Payment Log details 
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Managing Transactions 
If you have permissions to work with expense transactions, you can search for transactions based on a variety of 
criteria, and export transaction information to a file for other uses within the organization, including import into an 
internal accounting system. 
If Edit Transactions has been enabled for your site, and you have permissions set up to view transactions, you can 
modify the allocation codes for transactions. If you also have permissions set up to split transactions, you can split 
transactions and modify the allocation codes for the splits (such as to share the cost of an expense between two 
departments). 
This chapter includes the following sections: 

• Searching for transactions (see topic on page 291) 
• Working with display formats (see topic on page 301) 
• Editing transactions (see topic on page 305) 
• Exporting transactions (see topic on page 319) 
• Using the Output Log (see topic on page 320) 

 

Searching for transactions 
The Search for Transactions page lets you search for Transactions based on any combination of search criteria. You 
can also use this page to save a search criteria for future use and customize the format in which transactions are 
displayed and save it for future use. If you have access to multiple accounts, you must first select one or more 
accounts or units. 
The Search for Transactions page is divided into two tabs. The Search for Transactions tab lets you complete a basic 
transaction search using a date range, transaction type, and whether or not the transaction is included in an expense 
report. The Advanced tab lets you refine the search criteria further. You can enter advanced search criteria using any 
of the following criteria: 
• MCC or Expense Type 
• Merchant information 
• Amount (including diverted amounts) 
• Transaction addendum information (travel transactions, fleet transaction information, etc.) 
• Allocation information 
• Expense report assignment status 
• Card transaction or Out of Pocket transaction 
• Mapped status 

 

Selecting accounts or units 
If you have access to multiple accounts, you can search for those accounts and include some or all of them in your 
transaction search. If you have access to both accounts and units, you can combine specific accounts and all 
accounts within a unit in your transaction search. The unit search is for users who have both account and unit access. 
If you have access to only accounts, the unit search will return nothing. 
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Important: If allocation is activated for your site, you cannot include accounts and/or units with different allocation 
schemes in your search. Only single allocation scheme searches are allowed. 
 

1. Select Expenses>View Transactions from the menu. The Search for Transactions page displays.  

 
Figure 280: Search for Transactions page 
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2. Expand the Click here to select accounts or units for your search section.  

 
Figure 281: Select accounts or units 

3. Select the search type from Search for: control: Account or Unit: 
Account Search: 
To search by account, select Account from the Search for: field. The Account list is populated with account 
search criteria. 

• If you select Name on Account or Account Number and specify additional search criteria in the adjacent 
field. See "Searching without the wildcard character" for examples of these searches. 
a. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 

the search results will include all inactive accounts. 
a.  Click Search. The results of your account search display in the Selected Accounts/Units section. 
b. Select the accounts to be included in the search. 

• If you select Unit Name or Unit Number and specify additional search criteria in the adjacent field. See 
"Searching without the wildcard character" for examples of these searches. 
c. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 

the search results will include all inactive accounts. 
d. Click Search. All accounts you have access to in that unit display in the Selected Accounts. Units 

section. 
e. Select the accounts to be included in the search. 
f. If you want to include all accounts within a unit, and you have unit access, use the procedure in the Unit 

Search section below to add all accounts within selected units to your search. Otherwise, proceed to the 
Specify additional search criteria section below. 
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Unit Search: 
To search by unit, select Unit from the Search for: field, the Unit list is populated with unit search criteria.  

a. Select Unit Name or Unit Number and specify additional search criteria in the adjacent field. See 
"Searching without the wildcard character" for examples of these searches. 

b. Click Search. All units you have access to in that unit display in the Select Units section. 
c. Select the units to be included in the search. All accounts within the selected units are included in the 

search results. For additional information about the unit, click the Hierarchy icon (   ) to display a pop-
up window with hierarchy information. 

 
Figure 282: Hierarchy pop-up 

Specify additional search criteria: 
4. (Optional) Select a saved search and Display format from the appropriate lists, if applicable. 
5. Select a transaction date range from the Date range list. To specify a custom date range, select Custom 

from the Date Range list and click each calendar control (  ) to specify a custom From and To date or 
type the date in the From and To fields using the MM/DD/YYYY format. 

6. Select the number of transactions to display from the Number of results per page: list. 
7. Select transaction types from the Include transactions and Transaction type controls. If you want to 

specify additional transaction criteria, expand the Advanced Search control. See the quick reference guide 
“Searching for Transactions using the Advanced Search” . 

8. Click Run Search. All transactions returned by your search display on the Search Results page. 

 
Figure 283: Search results 
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Saving a search 

You can save transaction searches. All criteria specified will be used in subsequent searches. You specify a 
search name and description and this search will display in the Select a saved search list.   

Important: If you specify a custom date range using the calendar controls or the From: and To: fields, you must 
select Custom from the Date range list before saving the search. If you do not, the saved search will use the 
selection in the Date range list and discard your custom date range. 

1. Specify search criteria as described above. 
2. Click the Save Search link next to the Run Search button at the bottom of the page. The Save Search dialog 

displays. 

 
Figure 284: Save Search 

3. Specify a unique search name in the Name field. This is the name that will display in the Select a saved 
search list. This field is required. 

4. Specify a search description in the Description field. This field is optional. 
5. If you have units and/or accounts selected and you want to include these in the saved search, select the 

Include selected accounts or units with saved search option. 
6. If this search is to be the default search, select Select as your default search. If you have a previously 

selected default search, this new search will override that setting. 

Note: To edit an existing search, select the search from the Select a saved search list, make your changes 
and re-save it. 

7. Click Save. The search is saved and displays in the Select a saved search list. 
 

Completing an advanced transaction search 
Advanced transaction searches let you narrow your search by using one or more optional search filters. You can apply 
specific criteria to your transaction search using the Advanced Search section on the Search for Transactions page. 
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You perform the account, unit, date, transaction type selections and then apply any or all or these criteria to your 
search. Expand the Advanced Search section by clicking on the plus sign ( + ) and then click on the expand icon to 
open any of the Advanced Search fields. 

 
Figure 285: Advanced Transaction Search 

You can specify the following advanced search features for transaction searches: 
• MCC/Expense Type 
• Merchant Information 
• Amount 
• Addendum Information 
• Allocation Information 
• Mapped Status 
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MCC/Expense Type 

 
Figure 286: MCC Search 

1. Expand the MCC/Expense Type section. 
2. Select a value from the Search by list 

• MCC Code 
• MCC Description 
• Expense Type 

3. Enter additional search criteria in the adjacent field. You can use leading and trailing wildcard characters (*) 
in your searches. If you leave the field blank, all items will display in the Available list.  

4. Select Description or Code to specify the sort order. 
5. Click Search. The Expense type section is displayed with the Filter By list populated with MCCs based on 

your selection in step 2. 
6. Make a selection from the Filter By list. All MCC/Expense Types in this category are displayed in the 

Available list.  
7. Select the check boxes next to the MCC/Expense Types that you want to include in your search and click the 

right-arrow button ( ). The selections are displayed in the Selected list. To remove selections, select the 
check boxes next to the any MCC/Expense Types you want removed and click the left-arrow button ( ). 

8. Repeat steps 2 through 7 to add additional MCC/Expense Types to the Selected list. 
9. When your MCC/Expense type search criteria list is complete, run your search or add additional search 

criteria, as required. Click the Reset Criteria link at the top of the Advanced Search section to clear the 
section search criteria and start over. 
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Merchant Information 

 
Figure 287: Merchant Information 

1. Expand the Merchant Information section. 
2. In the Search for option, the Name check box is selected by default, and the field for you to specify the 

name is displayed. To search for City or State/Province, select the appropriate check box to display the 
corresponding fields. 

3. Enter the value or values to search for in the Name field. You can use leading and trailing wildcard 
characters (*) in your searches or leave the field blank to select all. 

4. When your Merchant Information search criteria list is complete, run your search or add additional search 
criteria, as required. Click the Reset Criteria link at the top of the Advanced Search section to clear the 
section search criteria and start over. 

Amount 

 
Figure 288: Amount Informaton 

1. Expand the Amount section. 
2. Select the amount filter from the Amount list. Any amount is selected by default. If you select Equal to, 

Less than, or More than, a single field is displayed. Enter the monetary amount in the field. If you select 
Between, specify the upper and lower monetary amount limits in the two fields that display. Select Credits to 
limit the search to credits. 

3.  Select the type of transaction from the Include option. All transactions is selected by default. The diverting 
transactions option can be used only if it has been set up for your company by your financial institution. The 
typical application of this option is using a company level account to authorize and pay for high monetary 
amount transactions, such as airfare. By diverting certain transaction types, the card limit and available 
balance of the individual making an airfair purchase are not impacted. The charges are, instead, authorized 
and accumulated by the company account. 

4. When your Amount search criteria are set, run your search or add additional search criteria, as required. 
Click the Reset Criteria link at the top of the Advanced Search section to clear the section search criteria and 
start over. 
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Addendum Information 

 
Figure 289: Addendum Information 

1. Expand the Addendum Information section. 
2. Select the addendum  types to include in the search. 
3. When your Addendum Information search criteria are set, run your search or add additional search criteria, 

as required. Click the Reset Criteria link at the top of the Advanced Search section to clear the section 
search criteria and start over. 

Allocation Information 

 
Figure 290: Allocation Information 
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1. Expand the Allocation Information section. If allocation is activated for your site, a list of allocation code 
segments display. 

2. Type the transaction allocation code segment or segments you want to include in your search. 

Note: You cannot perform a search of multiple codes for the same segment. You must perform a separate 
search for each instance of an allocation code segment. 
Important: Remember that allocation codes are case sensitive. For example, m1234 is not the same as 
M1234. If the valid code for the segment is M1234, a search using m1234 will not return transactions. 

3.  When your Allocation Information search criteria are set, run your search or add additional search criteria, as 
required. Click the Reset Criteria link at the top of the Advanced Search section to clear the section search 
criteria and start over. 

 

Mapped Status 
When a data mapper is run, there is an option to lock transactions so that further updates to the transactions included 
in the mapper’s output file are blocked. If that lock option has been used, then the transactions are flagged as having 
been mapped. 

 
Figure 291: Mapped Status 

1. Expand the Mapped Status section. 
2.  Select Mapped... or Unmapped... to display either mapped or unmapped transactions. Both types are 

selected by default. 
3. When your Mapped Status search criteria are set, run your search or add additional search criteria, as 

required. Click Reset Criteria to reset all Mapped Status search criteria and start over. 
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Working with transaction display formats 
Display formats let you control which transaction fields display and in what order. The initial default display includes a 
subset of the available fields. You can define one or more display formats, save them, and set one as your default. 
The default display format is applied when you open the Search for Transactions window again. 
Note: If you want to display transaction descriptions in the transaction grid, you must select this field in your format. 
 

To edit or create a display format 
Display formats let you control which transaction fields display and in what order. The initial default display includes a 
subset of the available fields. You can define one or more display formats, save them, and set one as your default. 
The default will be applied when you open the Search for Transactions page again. 
Important: You must have search results displayed to edit or create a display format. 

 
Figure 292: Transaction Search Results 

1. Run your transaction search. See the quick reference guide “Searching for Transactions”. 
2. Select New format from the Display format control. The Edit button activates. 

 
Figure 293: Display format 

3. Click Edit. The Format Display page displays. 
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Figure 294: Format Display 

4. Specify a name for the new format in the Name field (required) and a description in the Description field 
(optional). 

5. Select the fields you want added to the transaction display from the Available field. You can scroll down to 
view additional fields. 

 
Figure 295: Format Display 
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6. Click the right arrow button (  ) to move these fields to the Selected field. You can remove fields by 
selecting the field and clicking the left arrow button (  ). 

7. Select the fields you want to include in the new format. To include all fields, click the Select All link. 
 

 
Figure 296: Format Display 

8. At this point you have two options, Save and Finished. 
a. Click Finish to apply the new format to the current data set. The current data set redisplays with the new 

fields added. 
b. Click Save. The current data set redisplays with the new fields added and the new format is added to the 

Display Format list. 

Changing transaction status 
Administrators or anyone with approval permissions can change the status of a transaction to indicate that a 
transaction has been reviewed, approved, or rejected.   

1. Run your transaction search. See the quick reference guide “Searching for Transactions”. 
2. Select the transaction or transactions you want to change the status of by selecting the associated check box

 
Figure 297: Search Results 
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3. Click the Detail icon ( ) for the transaction or a transaction in your multiple selection. The Transaction 
Detail page displays. If you selected multiple transactions, the transaction whose detail icon you clicked 
displays on the Transaction Detail page. 
 

 
Figure 298: Out-Of-Pocket Detail 

4. Expand the Transaction Section. 

Note:  Remember that you can hover your cursor over a field’s information icon ( ) to display additional 
information about the field 

 
Figure 299: Transaction Status 
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5. Change the status of the transaction. You can mark a transaction as Personal or Disputed or change the 
Transaction Status to one of the following statuses, Reviewed, Approved, or Rejected. You can also 
remove the Personal or Disputed transaction status.  

Note: Administrators can lock or unlock transactions from the Transaction Status section of the Transaction 
Detail page by changing the Locked status. Administrators can also lock or unlock transactions from the 
transaction search results page. See “Locking or unlocking transactions” below. 

6. Click Save to save the status update. If you selected multiple transactions, click Previous or Next to display 
the next transaction in your selection. 

7. When you have completed the status updates, click Back to results (top of page) to return to the the 
transaction search results. The status of your selected transactions is updated. 

8. Click Save to save the updated statuses. 
 
 

Editing transactions 
The Edit Transactions permission lets you change the allocation of transactions. Allocation is the process of assigning 
transactions to the proper accounting values in your organization's accounting system. Allocation consists of both 
automated and manual activities. 
 

To view transaction detail 
1. Complete one of the following to view transaction detail from the Transaction list (Search for Transactions 

page): 
• Click the detail icon ( ) to view transaction detail information. 
• Click the addendum icon (such as travel or car rental) to view addendum information. 

• Click the attach receipt icon ( ) to add a receipt at the transaction level. 

Note: Addendum icons display only if the transaction contains additional information such as travel ( ), car 

rental ( ), lodging ( ), fleet ( ), or purchase detail ( ). 

 
Figure 300: Transactions Search Results 
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2. From any section of the Transaction Detail page, click the expand icon ( ) in the header to expand a 
section, or the collapse icon ( ) to collapse it. 

 
Figure 301: Transaction Detail page 

3. Expand the Transaction Allocation and Expense Type section to view or add notes for  
a transaction. 

4. When you finish reviewing the detail, click Back to Results to close the Transaction Detail page, and return 
to the Transactions list. 

Important: Do not use your browser's Back button to return to the list of transactions. 
 
 
 

Working with automated allocation tasks 
Automated allocation can take place on two levels: using the default allocation from your financial institution 
(processor) and setting up allocation rules in Online Card Management. 
 

Processor allocation 
Processor allocation takes place at the credit card processor. When transaction data is imported into Online Card 
Management, it associates each account's allocation code with all transactions made on that card. To change this 
code, you must submit a request to your financial institution. 
 

Online card management system allocation 
Online Card Management manages allocation at the site level. Your site setup determines: 
• How to handle the default allocation string from the processor when importing transaction data to Online Card 

Management 
• Whether the organization can edit the allocation codes that were automatically assigned either by the processor 

or by applying the allocation rules set up in Online Card Management 
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• Whether the organization can configure validations to ensure that allocation rules are set up using only 
approved codes 

Organization administrators can set up a series of allocation rules within Online Card Management. These rules 
assign allocation codes to transactions based on any or all of the following allocation types: account, expense type, 
Merchant category codes (MCC), point of sale (POS) codes, and unit. 
Allocation order refers to the order in which allocation rules are applied to transactions. This order is important 
because it determines which allocation string takes precedence over another when the transactions are imported into 
the card management system. Each allocation rule overwrites the allocation string applied by a previous rule. 
 

Working with manual allocation tasks 
If Edit Transactions is enabled at your site and you have permissions set up to edit transactions, you can modify the 
allocation codes that were applied in the automated processes described in the previous section. 
From the Search for Transactions page, with transactions displayed, you can perform the  
following tasks: 
• Split a transaction 
• Allocate a transaction 
• Attach a note to a transaction 
• Flag a transaction as disputed 
• Mark a transaction as personal 
• Change the status of a transaction 

Program administrators can lock or unlock a transaction. 
The following example shows the Search for Transactions page where the display format has been modified to include 
the columns referred to by these tasks. In most cases, there is an alternate method for accomplishing the task in the 
Transaction Detail page. 

 
Figure 302: Transactions Search Results 
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To allocate a transaction 
You can only modify the allocation codes for a transaction if the allocation fields are editable. 

• If valid codes have been assigned to any allocation field, the allocation selector icon ( ) icon displays to the 
right of the entry field in the search results list. If the Selector icon is displayed, you can click the icon to select a 
code from the list. 

• If you enter a code in an editable field that displays the Selector icon, the code you entered is checked against 
the list of valid codes when you save the allocation. If the code you entered is invalid, a message displays 
informing you that the code is not valid and the changes are  
not saved. 

Note: Allocation codes may be case sensitive depending on your site's allocation setup. If you enter a code with one 
or more letters in a case that does not match the code format, the code will be treated as invalid and the changes are 
not saved. 
When you split a transaction, all the default allocation codes from the original (unsplit) transaction are applied to all 
transaction splits. Follow the procedure below to modify the allocation fields. 
If the allocation fields are not included in the display format in the Search for Transactions page, you can edit the 
display format using the task "To edit or create a display format (on page 301), and follow the steps below; or you can 
modify the allocation fields from the Transaction Status and Allocation section of the Transaction Detail page. See the 
task "To view transaction detail (on page 305). 
 

To change allocation codes from the Search for Transactions page 
This task assumes that you have searched for and found a valid list of transactions to which you want to assign 
allocation codes. Read "Searching for transactions (on page 291) for instructions on completing a transaction search. 

1. Run your transaction search. 

 
Figure 303: Split transaction page 
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2. Locate the transaction you want to allocate. The allocation code fields are displayed.  If the code segments 
are not currently displayed on your screen view, you can use the navigation arrow (  ) to display all the 
code segments. 

3. Enter the allocation code in each field. To look up a valid allocation code, click the allocation selector icon      
( ) in each allocation segment field to display a dialog box listing valid codes for that field. 

 
Figure 304: Select allocation code dialog 

4. You can search for codes by both Valid code and Valid code description by selecting the code search 
parameter from the Search by list and specifying additional search information in the Search for field. You 
can use an asterisk (*) as a wildcard character in partial searches. 

5. Click Search. The codes that match your search parameters are displayed. 
6. Select the code for that allocation segment and click OK. The Search Results page is displayed again with 

the selected code in the allocation segment field. 
7. When you have completed the allocation code fields, click Save to save the allocation for that transaction. 

 

To lock or unlock a transaction 
You can also lock or unlock transactions from the transaction search results page. Locked transactions cannot be 
edited so if a transaction is in a locked status, you must unlock it to edit the transaction. 
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1. Run your transaction search 
2. Select the transaction or transactions you want lock or unlock of by selecting the associated check box. The 

Action bar activates. If the transaction is in an unlocked status, fields can be edited. If it is in a locked status, 
no fields are editable. 

 
Figure 305: Action bar Lock or Unlock Transaction 

3. For an unlocked transaction, click the lock icon (  ) to lock the transaction and prevent any further editing. 

For a locked transaction, click the unlock icon (  ) to unlock the transaction so it can be edited. 
4. Click Save. The transaction search results page redisplays with the selected transaction in it’s new status. 

 

To flag a transaction as disputed 
You can flag unlocked transactions to initiate a dispute. 

1. If the Dispute column is not included in the display format in the Search for Transactions page, edit the 
display format using the task "To edit a display format (See "To edit or create a display format" on page 301). 

2. For an unsplit transaction, click the Dispute icon ( ) column. The icon changes when it is selected, 
indicating that the transaction is marked as disputed ( ). 

3. For a split transaction: 
a. Click the Dispute icon. The Split Detail page displays. 

 
Figure 306: Split Detail page 
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b. Select the check box in the Disputed column for the transaction split you want to dispute. 
c. Click Save and Return. The Search for Transactions page re-displays. Note that the icon in the Dispute 

column changes, indicating that either some of the transaction splits are marked disputed, or all 
transaction splits-the entire transaction-is marked as disputed. 

For unsplit transactions, you can mark a transaction as disputed by clicking the Detail icon and selecting the Disputed 
option from the Transaction Status section of the Details page. 
 

To change the status of a transaction 
Administrators and anyone with approval permissions set up can change the status of a transaction to indicate 
whether it has been reviewed and approved (or rejected). You can only change the status for an editable transaction. 
If the transaction you want to change the status for is locked, an administrator can unlock it. For more information on 
unlocking transactions see "To lock or unlock a transaction (on page 309). Complete the following steps to change a 
transaction status. 
From the Search for Transactions page: 

1. Run your transaction search. 
2. Select the transaction or transactions you want to change the status of by selecting the associated check 

box. 

 
Figure 307: Transaction Search Results - Details 
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3. Click the Detail icon for the transaction or a transaction in your multiple selection. The Transaction Detail 
page displays. If you selected multiple transactions, the transaction whose detail icon you clicked displays on 
the Transaction Detail page. 

 
Figure 308: Out-Of-Pocket Detail 

4. Expand the Transaction Section. 

Note:  Remember that you can hover your cursor over a field’s information icon (  ) to display additional 
information about the field 

 
Figure 309: Transaction Status expanded 
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5. Change the status of the transaction. You can mark a transaction as Personal or Disputed or change the 
Transaction Status to one of the following statuses, Reviewed, Approved, or Rejected. You can also 
remove the Personal or Disputed transaction status.  

Note: Administrators can lock or unlock transactions from the Transaction Status section of the Transaction 
Detail page by changing the Locked status. Administrators can also lock or unlock transactions from the 
transaction search results page. See "To lock or unlock a transaction (on page 309) 

6. Click Save to save the status update. If you selected multiple transactions, click Previous or Next to display 
the next transaction in your selection. 

7. When you have completed the status updates, click Back to results (top of page) to return to the the 
transaction search results. The status of your selected transactions is updated. 

8. Click Save to save the updated statuses. 
 

 

Splitting a Transaction 
The primary reason for splitting a transaction is to allocate portions (splits) of the transaction to different accounts. You 
can split transactions as follows: 

• Single transaction by amount 
• Single transaction by percent 
• Single transaction by line item detail (LID) (If addendum information is provided by the merchant) 
• Multiple transactions (batch split) by percent 

You can also: 
• Split a transaction and then dispute a transaction split. 
• Split a transaction and designate a transaction split a personal expense. 
• Attach a description to a transaction split. 
• Apply split parameters to multiple transactions (batch split) 

A transaction's split status is indicated by the Split column icon as shown below. You click the icon to display The Split 
Transactions page. 

   Unsplit transaction 

   Split transaction 

   Split transaction detail 
 

Important: After a transaction has been locked, it cannot be edited. You cannot split that transaction 
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To split a transaction by amount 
When you split a transaction by amount, you assign currency amounts to each split. These split amounts must add up 
to the billing amount. 

1.  Click the transaction's Split icon (  ). The Split Transactions page displays 

 
Figure 310: Split by amount 

2.  Select the Split by amount option. The Split Amount column changes to editable fields. 
3.  The transaction is split into two equal splits by default. If you want additional splits, type the number in the 

Add splits field and click Go. Your additional splits are added to the Split Detail section. 

Important: When you type a number in the Add splits field, it is added to the default two splits. For example, 
if you want three transaction splits, type 1 in the Add splits field. This value is added to the default two to 
give three splits. 

4. You now assign dollar amounts to each split using one of the following procedures. Remember that the 
amounts entered must add up to the billing amount. 

•  If you want the transaction amount to be distributed equally among the splits, click Split Equally. The 
billing amount is divided by the number of splits and this amount is assigned to each split. 

•  If you want to assign different amounts to each split, type the amount in the appropriate field and select 
Update Split Amount. The Split Percent column is updated. 

5. If your site allows editing of allocation codes, you can change the allocation of each split. See “To allocate a 
transaction" on page 308 

6. Type a description in the Description field. You can use up to 250 characters. 
•  Select Disputed if you want to dispute a split.  
•  Select Personal if you want to flag the split as a personal expense.  

•  Click the Remove icon ( ) to remove the split. 

7.  Click Save and Return to save the splits or click Start Over to clear all fields. 
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To split a transaction by percent 
When you split a transaction by percent, you assign a percentage of the billing amount to each split. The split 
percentages must add up to 100.00% 

1.  Click the transaction's Split icon (  ). The Split Transactions page displays. 

 
Figure 311: Split by percent 

2.  Select the Split by percent option. The Split Percent column changes to editable fields. 
3.  The transaction is split into two equal splits by default. If you want additional splits, type the number in the 

Add splits field and click Go. Your additional splits are added to the Split Detail section. 

Important: When you type a number in the Add splits field, it is added to the default two splits. For example, 
if you want three transaction splits, type 1 in the Add splits field. This value is added to the default two to 
give three splits. 

4. You now assign percentages to each split using one of the following procedures. Remember that the split 
percentages must add up to 100.00% 

•  If you want the transaction amount to be distributed equally among the splits, click Split Equally. The 
billing amount is divided by the number of splits and this percentage is assigned to each split. 

• If you want to assign different percentages for each split, type the percentage in the appropriate field and 
select Update Split Amount. The Split Amount column is updated. 

5.  If your site allows editing of allocation codes, you can change the allocation of each split. See “To allocate a 
transaction" on page 308 

6. Type a description in the Description field. You can use up to 250 characters. 
• Select Disputed if you want to dispute a split.  
• Select Personal if you want to flag the split as a personal expense 

• Click the Remove icon ( ) to remove the split. 
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7.  Click Save and Return to save the splits or click Start Over to clear all fields. 
 

To split multiple transactions (completing a batch split) 
You can apply the same split parameters to multiple transactions. When you do a batch split, you can only split the 
transactions by percent. 

1. Select each transaction you want to split. You can select transactions that are already split as well as unsplit 
transactions. 

2. Select Split (  ) from the Action field. The Split Transactions page displays. 

 
3. Transactions are split into two equal splits by default. If you want additional splits, type the number in the 

Add splits field and click Go. Your additional splits are added to the Split detail section. 

Important: When you type a number in the Add splits field, it is added to the default two splits. For example, 
if you want three transaction splits, type 1 in the Add splits field. This value is added to the default two to give 
three splits. 

4. Assign percentages for each split. The percentages entered must add up to 100.00%. If you add additional 
splits, select Update Split Amount to update the Split Amount column. 

5. If your site allows editing of allocation codes, you can change the allocation for the splits. See “To allocate a 
transaction" on page 308 

6. Type a description in the Description field. You can use up to 250 characters. 
• Select Dispute if you want to dispute a split. 
• Select Personal if you want to flag a split as a personal expense. 

•  Click the Remove icon ( ) to remove the split. 

7. Select Save and Return. The split parameters you specified are applied to each transaction. Click Start 
Over to clear all fields. 
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To split a single transaction by line item detail 
If addendum information is provided for the transaction, an Add Splits for Line Items button displays and the default 
two splits are set to zero. These transactions can be split by line item detail. 
Important: The system reports only the addendum information provided by the merchant. This information is not 
standardized and, in many cases, the item amounts or percentages will not equal the transaction total amount or 
percent. You must modify the item amounts or percentages and verify that they total to the transaction total or 
100.00% or the system will not allow the split transaction to be saved. 

1.  Click the transaction's Split icon. The Split Transactions page displays. If addendum information is provided, 
the Number of splits field is set to zero and the Add Splits for Line Items button is visible. 

 
Figure 312: Split by line item 

2.  Click Add Splits for Line Items. The addendum information provided by the merchants displays as editable 
boxes. The Split by Amount field option is selected by default. If you want to split the line items by percent, 
select the Split by percent option. 

3. The transaction is split into the number of line items provided by the merchant plus one additional total tax 
line item. If you want additional splits, type the number in the Add splits field and click Go. Your additional 
splits are added to the Split Detail section. 

Important: When you type a number in the Add splits field, it is added to the default splits. For example, if 
you have four line items plus the additional tax line item and you want seven total splits, type 2 in the Add 
splits field. This value is added to the line item detail five to give seven total splits. 

4. You now assign amounts or percentages to each split. Remember that the split amounts must add up to the 
transaction total or the split percentages must add up to 100.00% 

5. Click Update Split Amount. The Split Amount or Split amount columns are updated. 
6. If your site allows editing of allocation codes, you can change the allocation of each split. 
7. Type a description in the Description field. You can use up to 250 characters. 

•  Select Dispute if you want to dispute a split. 
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• Select Personal if you want to flag the split as a personal expense.  

• Click the Remove icon ( ) to remove the split. 

8. Click Save and Return to save the splits or click Start Over to clear all fields. 
 

 

To edit split information 
1. Click the icon in the Split column to split the transaction or edit the split information. The Split Transaction 

page displays. 
Note: You cannot edit Splits for mapped transactions. 

 
Figure 313: Split transaction page 

2. See the task "Splitting a transaction (on page 313) for the steps to split a transaction. Note that when you 
split a transaction, all the allocation codes from the original (unsplit) transaction apply to all transaction splits. 

3. You can modify the codes for all allocation fields that are editable. See the task "To allocate a transaction (on 
page 308) for instructions. 

4. Select the Personal check box to mark the transaction split as personal, if applicable. 
5. Select Disputed check box to mark the transaction split as dispute, if applicable. 
6. Click Save and Return. 
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Exporting transactions 
After you have selected accounts, found transactions that match your criteria, and selected the export fields from the 
Customize Grid, you can export the transaction information to a file and download the file from the Output Log. 

 
Figure 314: Search results 

 

To export transactions 
Before exporting transactions, you must have the Transactions list displayed in the Search for Transactions page. 

1. Transactions download as they display in the Transactions list. You can select a display format from the 
Format for results list, or define a new format and apply it to the Transactions list. For more information on 
transaction display options see "Working with transaction display formats (on page 301). 

2. Click Export. The Export dialog displays, indicating the selected date range and number  
of transactions. 

 
Figure 315: Run Export dialog 
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3. The default file name is "Transaction Export." To change the file name, click the text in the field to select it, 
and enter a name for the file. 

4. Select a Level of Detail option: 

• Transactions only: Includes only those transaction fields included in the current Transactions list. If the 
Transactions list has been re-sorted, that sort order is applied to the export file. Only the fields you 
selected to display within the View Transaction list are included in the export file. 

• Grand total only: Includes only a summary record showing Start Date, End Date, Total # of 
Transactions, and Total Amount. 

5. From the Delimiter list, select one of the following: Comma, Period, Pipe, Semicolon, or Tab. Online Card 
Management adds the file extension when the export process begins. All file types have a .TXT extension. 

6. Click Run Export. If the list of transactions you are exporting contains more than 200,000 transactions, a 
message displays above the Name field telling you that your request may take longer to process. 

• If you want to redefine your search to reduce the number of transactions, click Yes. 
• If you did not click Yes to the "large number of transactions" message, the export is queued up to run. 

7. The following message displays above the Search Results list column headings: "Export is being processed 
and can be downloaded from the Output Log when completed." 

 
Figure 316: Export processing 

 

Using the Output Log 
You download transactions, reports, or mapper output files from the Output Log and you reset the mapped status of 
mapper output file transactions using the "unmap" feature. 
 

To work with the Output Log 
Important: Online Card Management performs periodic data integrity checks and does not make data available for 
reports or mappers until these procedures are complete. If you run a report or mapper and do not see your latest 
transaction changes, wait for thirty minutes and run the report again. 
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1. Access the Output Log using one of the following methods: 

• From the Expenses menu, select View Output Log.  
• From the Reports menu, select View Output Log.  
The Output Log displays. 

 
Figure 317: Output Log page 

2. To download a file, click the Download icon (  ). The File Download dialog displays. 
3. Select the option to save the file and click OK. The Save As dialog displays. 
4. Select the location for the file to be downloaded to. 
5. Click Save to begin the download. The Save As dialog closes. 
6. When the download is complete, the Download Complete dialog opens. Click Close to close the dialog. 
7. After completing the download, click Refresh Status. The status of the Output Log entry is changed to 

Downloaded, if it does not already have this status. 
8. To delete any files from the Output Log: 

a. Select the file. The check box at the top of the column selects all files, a confirm dialog displays. 

 
Figure 318: Delete file from output log confirmation 

b. Click Yes to close the dialog and delete the item from the list. 
 

To unmap transactions 
After you run a mapper, users can no longer work with the transactions included in the mapper. You can use the 
Output log to reverse a mapper or "unmap" the transactions. Unmapping transactions lets users work with allocation 
information and attach them to expense reports. Complete the following to unmap transactions. 
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1. Open the Output Log.  

2. To unmap the transactions associated with a mapper output file, click the Unmap icon (   ). A 
confirmation dialog displays. 

 
Figure 319: Unmap Confirmation dialog 

3. Click Yes. The transactions are unmapped and the mapper is removed from the Output Log. 
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Managing Expense Reports and Out-of-Pocket 
Transactions 

Expense reports group transactions that have a common purpose. For example, you can create an expense report 
that contains all the transactions for a business trip. Out-of-Pocket transactions document expenditures that account 
holders made without using the card associated with their accounts. Out-of-Pocket transactions are inserted into 
expense reports for submission along with transactions incurred on their card. When an expense report is completed it 
is submitted and  
routed to an approver who can review and approve or reject the expense report. Read the following to understand 
how you can work with expense reports and Out-of-Pocket transactions in  
Online Card Management: 

• Working with expense reports (see topic on page 323) 
• Working with Out-of-Pocket transactions (see topic on page 338) 

 

Working with expense reports 
You can create and submit an expense report for yourself, or as an Approver, you can approve or reject someone 
else's expense report. Users with the appropriate security permissions can also create and submit an expense report 
on the behalf of an account holder. Expense reports are not tied to a particular cycle or month, they can span multiple 
cycles or months, if applicable to the situation. Once the expense report is created, they are submitted for approval 
using the Approver information and approval profile established for the submitting user (see topic on page 92). 
 

Using the Home page to manage your expense reports 
Online Card Management provides users with links to expense report tasks. The links that display on the Home page 
are specific to the user's approval hierarchy assignment and the accounts the user manages. From the Home page, 
the user can jump to the tasks for creating new expense reports, approving or rejecting expense reports. 
The following links can display on the Home page: 
• In Progress-  

Users can click this link to quickly access the Manage Expense Reports page and view their expense reports 
that have an Incomplete, Unsubmitted, Rejected, Pending Approval, or Reopened status. 

• Recently Approved- 
Users can click this link to quickly access the Manage Expense Reports page and view their expense reports 
that have been approved within the last 10 days. 

• Review Transactions to Report-  
Users can click this link to quickly access the Manage Expense Reports page Unattached Transactions tab and 
view their transactions that do not belong to an expense report. 

• Create Expense Report-  
Users can click this link to quickly access the Create Expense Report page to create and submit a new expense 
report. 
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• For Your Approval- 
Approver users can click this link to quickly access the expense reports that are waiting for  
their approval. 

 

Understanding the expense report approval process 
The Approvers listed in your Personal Information determine who approves or rejects your expense reports, and 
whose expense reports you can approve. See "Creating a user (on page 135) for more information on assigning 
expense report approvers to a user. The expense reports that you need to approve or reject display in the Expense 
Reports for Approval section of the Manage Expense  
Reports page. 
Depending on your user approval settings, approvers can approve, edit, or reject expense report that you are 
expected to review. When an expense report is approved, it continues to the next approver until the final approver 
approves and closes the expense report. If an approver rejects an expense report, the expense report is sent back to 
the account holder that submitted it. The submitting user can then edit and re-submit the rejected expense report. 
Approvers can edit the expense report and approve it. Once the expense report receives final approval, all the 
transactions and out-of-pocket transactions in the report are locked and cannot be edited. 
 

Expense report status 
Online Card Management uses Expense Report Status to track where the expense report is in the approval process. 
The following statuses are applied to expense reports: 
• Unsubmitted— 

Expense reports are assigned this status when a user saves a complete report but does not submit it for 
approval. The expense report owner can edit their own expense reports when they are in this status. 

• Incomplete— 
Expense reports are assigned this status when required data is missing from the report and the user has saved 
the report to return to later. Incomplete reports cannot be submitted. The expense report owner can edit their 
own expense reports when they are in this status. 

• Pending Approval— 
Expense reports are assigned this status when it is submitted for approval but their expenses have not received 
final approval. Approvers with appropriate access can edit expense reports in this status. Submitters cannot edit 
their expense reports when they are in this status. 

• Closed— 
Expense reports are assigned this status after the final approver has approved the expense report. Depending 
on your organization site settings, approvers can re-open closed expense reports and edit them or send them 
back to the originator for further action. 

• Rejected— 
Expense reports are assigned this status when any approver rejects the expense report. The creator of an 
expense report can edit and resubmit rejected expense reports. 

• Reopened— 
Expense reports are assigned this status after they have been rejected or closed, and then re-opened for 
modification so they can be re-submitted. 
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Creating an expense report 
Creating a new expense report is a simple four step process. Online Card Management arranges these steps into a 
wizard that makes it easy for account holders to complete. The following procedure is an overview of how expense 
reports are created in Online Card Management, subsequent procedures explain each step in detail. 
Tip: To quickly create an expense report, choose to automatically assign transactions to the envelope when 
specifying general information (step 1) and click Finish. This lets you skip steps 2 and 3. If you want to select 
transactions manually or add out-of-pocket transactions, complete the entire process. 

1. Enter general information about the new expense report (see "Step 1: Enter general expense report 
information (on page 325)). 

2. Attach transactions to the expense report (see "Step 2: Attach transactions to an expense report (on page 
327)). 

3. Create and attach Out-of-Pocket expenses (see "Step 3: Create Out-of-Pocket transactions for the expense 
report (on page 328)). 
Note: This step does not display if your site does not track out-of-pocket transactions. 

4. Attach receipts to the expense reports (if required by your organization) (see Step 4: Attach Receipts (on 
page 330)). 

5. Finalize the expense report and prepare it for submission (see "Step 5: Finalize the expense report (on page 
332)). 

Note: Click Save at anytime to keep the expense report information before you finalize the report. 
 

Step 1: Enter general expense report information 
Note: You can save your work without submitting the report by clicking Save. 

1. Select Expenses >Manage Expense Reports from the menu. The Manage Expense Reports  
page displays. 

2. Click Create Expense Report. The Create Expense Report page displays. 
Tip: You can also access this page by clicking Create Expense Report link from the  
Home page. 
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Figure 320: Create Expense Report- step 1 

3. Type a name in the Expense Report Name field.. 
4. If you have access to multiple accounts, select an account from the Account list, otherwise, your account is 

listed here. If you want to create the expense report with an unlisted account, you can search for an account 
and attach it to the expense report using the following procedure, otherwise proceed to step 5. 
a. Expand the Select Account section or click the Select a different account link. 
b. Select search criteria from the Select Account list and specify additional criteria in the associated field. 

You can use an asterisk (*) as a leading or trailing wildcard character in partial searches. 
c. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 

the search results will include all inactive accounts. 
d. Click Search. The search results display below. 
e. Select the account. The selected account is used by this expense report and is listed in the Account 

field. 

5. Type a description in the Description field. 
6. Type a destination in the Destination field.. 
7. Specify a date range by selecting one from the Date Range list. You can create a custom range by either 

typing a date (mm/dd/yyyy) in the From and To fields or clicking the calendar icon (  ) to display the 
calendar controls that let you select a starting and ending date. 

Note: Select Auto-attach transactions to automatically attach all transactions within the specified date 
range to the expense report. When you proceed to step 2 of the wizard, all transactions within the date range 
you specified will be attached. You can then specify different date ranges to locate additional transactions. 
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You can now perform one of the following actions: 
• Click Next to proceed to Step 2: Transactions, the next step of the wizard. 
• Click Skip to Last Step to open the Finalize Report section which summarizes the report in progress. 

You can then click Save to save the report. 
• Click Save to save the report. The report is listed in the In Progress section of the Expense Reports tab. 

 

Step 2: Attach transactions to an expense report 
This procedure assumes that you have already entered the general information for the expense report. See "Step 1: 
Enter general expense report information (on page 325) 
Note: You can save your work without submitting the report by clicking Save. 

1. After completing the general expense information, step 2 of the Create Expense Report  
process displays. 

 
Figure 321: Create Expense Report- step 2 

2. Select the transactions you want to include in the expense report by selecting the associated check box. The 
check box at the top of the column selects all transactions. You sort listed transactions by clicking on the 
column header to sort ascending by that column. Click the column heading again to sort descending. 

3. If you want to search for additional transaction outside the initially specified date range, specify a date range 
by selecting one from the Date Range list. You can create a custom range by either typing a date 
(mm/dd/yyyy) in the From and To fields or clicking the calendar icon (  ) to display the calendar controls  
that let you select a starting and ending date. 

4. Click Search. The available transactions search results updates. 
You can now perform one of the following actions: 

• Click Next to proceed to Step 3: Out-of-Pocket , the next step of the wizard. Depending on your site 
settings, the Out-of-Pocket step may not be available. 
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• Click Skip to Last Step to open the Finalize Report section which summarizes the report in progress. 
You can then click Save to save the report. 

• Click Save to save the report. The report is listed in the In Progress section of the Expense Reports tab. 
 
 
 
 
 

Step 3: Create Out-of-Pocket transactions for the expense report 
This procedure assumes that you have already attached transactions to the expense report. See "Step 2: Attach 
transactions to an expense report (on page 327) 
Any additional out-of-pocket transactions you attach are created in this section. 

1. Select one of the three out-of-pocket expense types from the Type list. 
2. Specify the number of expense types required in the Number of Transactions field. 
3. Click Add. The number of fields specified are added.. 

You now add out-of-pocket information for each expense type you created: 

Important: If you expand an out-of-pocket section but do not specify any data, click the Remove link to remove the 
section line. Any blank out-of-pocket section lines will generate an error if you try to attach them to the expense report. 

Personal Mileage section 

 
Figure 322: Create Expense Report Step 3 - Personal Mileage 

4. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
5. Specify a description in the Description field, if required. 
6. Specify the distance traveled in the Distance field. This is a number only field. 
7. Select a distance rate from the Rate list. This rate is applied to the distance traveled. 
8. Click Add to add another out-of-pocket type or click Next and all out-of-pocket transactions are added to the 

expense report and you proceed to the next step in the wizard. Out-of-Pocket transactions are denoted by 
the out-of-pocket icon ( ).  
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Meals section 

 

Figure 323: Create Expense Report Step 3 - Meals 

1. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
2. Specify a description in the Description field, if required. 
3. Select a meal type from the Meal Type list. 
4. Specify the Attendees and Purpose in the appropriate fields. 
5. Specify the transaction amount in the Amount field. This is a number only field. Do not type a currency 

symbol. 
6. Specify the Merchant Name, City, State/Province, and Country in the appropriate fields. 
7. Click Add to add another out-of-pocket type or click Next and all out-of-pocket transactions are added to the 

expense report and you proceed to the next step in the wizard. Out-of-Pocket transactions are denoted by 
the out-of-pocket icon ( ).  
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Lodging, Transportation, and Other section 

 
Figure 324: Create Expense Report Step 3 - Lodging, Transportation, Other 

1. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
2. Specify a description in the Description field, if required. 
3. Select an expense type from the Expense Type list. 
4. Specify the transaction amount in the Amount field. This is a number only field. Do not type a currency 

symbol. 
5. Specify the Merchant Name, City, State/Province, and Country in the appropriate fields. 
6. Click Add to add another out-of-pocket type or click Next and all out-of-pocket transactions are added to the 

expense report and you proceed to the next step in the wizard. Out-of-Pocket transactions are denoted by 
the out-of-pocket icon ( ).  

Step 4: Attach Receipts 
The Manage Receipts step is available if your organization requires copies of transaction receipts to be attached to 
the expense report. When you create an expense report the receipt required icon (  ) will display next to an 
unsubmitted expense report. Expense reports that have receipts attached display the receipts attached icon (  ). 
Two tabs will display: Available Receipts and Upload Receipts. The step opens to Available Receipts where you 
can attach previously uploaded receipts.  If you need to upload additional receipts, proceed the following steps. 
You create copies of your receipts, save them in one of the five supported file types (.pdf, .jpeg, .tiff, .gif, .png), and 
store them on your computer.  

Note: Many printer/copiers support saving copies in various file formats. Contact your operations or IT department for 
assistance in creating these and storing them on your computer. Each file must be less than 5 megabytes. 
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Figure 325: Attach Receipts 
1. Click Browse. The Choose File to Upload dialog displays. 
2. Navigate to the folder on your computer that has the receipt files and locate the file you want to attach to the 

expense report. 
3. Click on the file to select it and then click Open. The Choose File to Upload dialog closes and the path and 

filename display in the Browse field of the Receipts page. 
4. Type a description, if desired, and click Upload Receipt. The file is uploaded to the system and displays in 

the File Name column. 
5. Continue adding receipt files to the expense report and then click Next to attach the files, close the Manage 

Receipts step and proceed to the final step. 
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Step 5: Finalize the expense report 
 

 
Figure 326: Create Expense Report- step 5 

You now perform one of the following tasks: 
• Click Submit. A dialog displays which allows you to select approvers. You can also type a note, if desired. 

 
Figure 327: Submit Expense Report - select approvers 

• Click Save to save the report. The report is listed in the In Progress section of the Expense Reports tab. 
• Click Cancel to discard any changes and return to the In Progress section of the Expense Reports tab. 
• Click Print Expense Report to generate Report 3120 - Expense Report in PDF format. You can view the 

report or save it to your local system. 

Note: You can try to submit an expense report that is missing a piece of required data, Online Card Management a 
message displays asking if you want to continue or if you want to correct the expense report. If you choose to continue 
and ignore the data, the expense report is saved and the Incomplete status is assigned to the expense report. 
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Managing expense reports 
The Manage Expense Reports page is divided into three tabs. Each tab lets users perform different expense report-
related tasks. You can access the Manage Expense Reports page by clicking Manage Expense Reports from the My 
Tasks section of the Home page or by selecting Expenses > Manage Expense Reports. 

 
Figure 328: Manage Expense Reports 

Expense Reports tab 
The Expense Reports tab groups your expense reports into sections based on the expense report status. 
If you are a cardholder with one or more accounts directly assigned to you, two sections on the Expense Reports tab 
are displayed. The In Progress tab lists all of your unsubmitted expense reports and the Recently Approved section 
lists all ofyour expense reports that have been approved in the last 10 days. You can select expense reports and 
submit or delete them from the In Progress section. You can also view expense report details and review any notes 
attached to an expense report. 
If you are an approver, the For Your Approval section is also displayed. Approvers can select expense reports and 
approve or reject them. Approvers  can also view expense report details and review any notes attached to an expense 
report. 

Expense Reports Tab – For your approval section 
When expense reports are in the pending approval queue, and the user is an interim approver for certain reports and 
a final approver for others, two buttons will display: Approve & Forward and Approve & Close. 
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Figure 329: Manage Expense Reports—For Your Approval section 

 

• When the approver has only interim permissions, the Approve & Forward button will display. 

• When the approver has only final permissions, the Approve & Close button will display. 

• When the user is the interim approver for some, and final approver for others, expense reports will be 
processed based on which button the user clicked. For example, if the user clicks Approve & Close, reports 
that can be closed will be closed, and the reports for which the user is an interim approver will be skipped 
and remain in the queue. 

1. Select the reports you would to approve. 
2. Click the button according to your approver permissions. 
3. Type a note, if desired. This note will be attached to all expense reports. 
4. The confirmation message will display which reports were processed successfully and which were 

skipped. 
5. Click OK to close the dialog box. 

Expense Reports Tab – Unassigned section 
Automatically generated (autogenerated) and unassigned expense reports are listed in this section. You can review 
expense report details or click the Take Ownership button to assign expense reports to yourself. 
• Click the expense report detail icon ( ) to open the Finalize Report section of the Edit Expense Report page. 

You can manage existing expense reports from the Edit Expense Report page. 
• Select expense reports you want to assign to yourself by selecting the associated check box and clicking Take 

Ownership. A dialog box is displayed asking you to confirm this selection. Click Take Ownership on the dialog 
box to confirm your choice. The expense report is assigned to you and displays in the In Progress section with 
Yes as the System Created status. 
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Expense Reports Tab – In Progress section 
In the In Progess section, you can review unsubmitted expense report details and notes. You also can select expense 
reports you want to submit or delete. 

1.  Click the expense report detail icon ( ) to open the Finalize Report section of the Edit Expense Report 
page. You can manage existing expense reports from the Edit Expense Report page. 

2.  Click the Note icon ( ) to open the Add Expense Report Note pop-up window. Enter a note and click Save 
Note to save the note and attach it to the expense report. The Note icon changes to ( ) to indicate that text 
has been added. Click this icon to reopen the Add Expense Report Note pop-up window and then click the 
Add Note link to add additional notes to the expense report. 

3.  If receipts are required for your organization, click the receipt icon ( ) to open the Manage Receipts dialog. 
You can review, add, or delete receipts in this dialog box. If no receipts are attached, you can attach them by 
clicking the blank receipts icon ( ). 

4. You can now perform the following actions on the expense report: 

• If the expense report is complete, select the report and click Submit Selected to route the expense 
report to your approver. The Submit Expense Report(s) dialog box opens and you can select the 
approvers to whom you want to route this expense report. You also have the option to attach a note to 
this expense report. 

• Click Save to save the expense report for further edits. The expense report is still displayed in the In 
Progress section of the Expense Reports tab. 

•  Click Cancel to return to the Expense Reports tab. Any changes made are discarded. 
•  Click Print Expense Report to generate Report 3120 - Expense Report in PDF format. You can view 

the report or save it to your local system. 
 
 

To submit or delete multiple expense reports: 
Select each expense report check box. The check box at the top of the column selects all expense reports. 

1.  Click Submit Selected. The Submit Expense Report(s) dialog box opens. 
2.  Select the approvers from the list to whom you want to route the expense reports. 
3. Enter an optionalnote. This note is attached to all expense reports. 
4.  Click Submit. The expense reports are routed to the selected approvers. 

Note: Click Delete Selected to delete the selected expense reports. Any attached transactions are available 
for new expense reports and are displayed on the Unattached Transactions tab. 

Expense Report tab - Recently Approved section 
The Recently Approved section lists all your submitted expense reports approved in the last 10 days. You can review 
expense report detail by clicking the Detail icon ( ) or review attached notes by clicking the Notes icon ( ). All 
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fields are visible but are read-only. If changes to an approved expense report are required, an approver with the 
appropriate permissions must re-open it before any changes can be made. 
 

Expense Report tab - For Your Approval section (Approvers only) 
All expense reports that have been routed to you for approval are listed here. 

1.  Click the expense report detail icon ( ) to open the Finalize Report section of the Edit Expense Report 
page. You can review existing expense reports from the Edit Expense Report page. 

2.  Click the note icon ( ) to review notes attached to the expense report . If you see the blank note icon ( ) 
icon, no notes have been attached. 

3.  Select the check box associated with each expense report and apply one of the following actions: 

•  Click Approve Selected. The Note dialog box opens and you can attach a note. The expense report(s) 
are routed to the next approver in the hierarchy. If you are the final approver, the expense report is 
closed. 

•  Click Reject Selected to reject the expense reports. You can attach a note to the expense report before 
it is routed back to the originator 

 

Unattached Transactions Tab 
All transactions that are not assigned to an expense report are listed here. The default date is the last 45 days. If you 
want to search for transactions outside this range, use the following procedure. You can create new expense reports 
using the results of your transaction search. To assign transactions to an existing expense report, you must perform 
that action on the Expense Report tab - In Progress section. 

To search for unattached transactions: 
If you are responsible for multiple accounts, either those directly assigned to you or accounts you are responsible for, 
you must specify which account you want to search for transactions. If you are only responsible for your account, 
proceed to step 4. 
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1. Select the account search criteria from the list in the Select Account section and further refine your search by 
specifying criteria in the associated field. See the quick reference guide, Searching without the wildcard 
character, for examples of these searches. 
 

 
Figure 330: Manage Expense Reports 

• If you select Account Number or Name on Account from the search list, all accounts that match your 
criteria are returned. 

• If you select Unit Name or Unit Number from the search list, all your accounts within the specified unit 
are returned. You must have access to the unit before the unit search works. 

2. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 
the search results include all inactive accounts. 

3.  Click Search. All accounts that meet your criteria are listed in the Search Results section. 
4.  Select the account you want to search. You can select one account. If you want to change that account, 

deselect it and select another from the Search Results section. 
5. Specify a date range by selecting one from the Date Range list. You can create a custom range by either 

typing a date (mm/dd/yyyy) in the From and To fields or clicking the calendar icon (  ) to display the 
calendar controls  that let you select a starting and ending date. 

6. Select a transaction filter from the Filter Search Results By option. 
7. Click Search. Transactions that meet your criteria are listed below. 
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Working with Out-of-Pocket transactions 
Occasionally, an account holder incurs a valid business expense that he or she must pay for without using the card 
account. For example, if an account holder takes a client to a restaurant that does not accept credit cards and he or 
she pays with a cash or a personal check. Such expenses are tracked in the card management system as 
Out-of-Pocket transactions. Out-of-Pocket transactions are added to an expense report and submitted for expense 
report approval for reimbursement. Use the Expense menu to work with Out-of-Pocket transactions. 
 

Entering an Out-of-Pocket transaction 
Use the Create an Out-of-Pocket page to enter an out-of-pocket transaction. Out-of-Pocket transactions must be 
associated with a specific account. Out-of-Pocket transactions cannot be split between multiple accounts. Out-of-
Pocket transactions are divided into expense types. When you are entering an out-of-pocket transaction, it is 
important that you choose the correct expense type to accurately report your expense. Read the following descriptions 
of the available expense types: 
• Lodging- 

Use this expense type to report reimbursable lodging expenses such as a hotel stay on a business trip. Use this 
expense type for lodging if no meals were charged to the  
same transaction. 

• Lodging with meals- 
Use this expense type to report reimbursable business expenses such as a hotel stay on a business trip with 
room service charged to the room. This type provides one form to use to enter both room charges and meal 
expenses. When the Out-of-Pocket is saved, individual  
Out-of-Pocket transactions are generated for the room charge and each of the meals. 

• Meals- 
Use this expense type to report reimbursable business-related meal expenses, such as a lunch taken during a 
business trip or meal expenses incurred for business clients. This expense type is for meals that are separate 
transactions from lodging. 

• Personal Mileage- 
Use this expense type to report reimbursable business-related use of a personal vehicle. For example, if an 
account holder has to drive across town to meet with a client. 

• Transportation- 
Use this expense type to report reimbursable business-related use of transportation such as an airport shuttle, 
taxi rides, or bus fare. 

• Other - 
Use this expense type to report reimbursable business-related expenses that do not belong to any of the 
expense types described above such as office supply purchases. 

 

To select an account for an Out-of-Pocket transaction 
An account holder sometimes incurs a valid business expense that he or she must pay for without using the card 
account. Such expenses are tracked in the card management system as Out-of-Pocket transactions. Once the out-of-
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pocket transaction is created, it will show in transaction searches and can be added to an expense report and 
submitted for approval for reimbursement. 
Select Expenses>Create Out-of-Pocket from the menu to access the Create Out-of-Pocket page. Your account is 
displayed. If you have access to multiple accounts, you first search for an account and then create an out-of-pocket 
expense for that account. 
If you are responsible for multiple accounts you must specify for which account you want to create an out-of-pocket 
exoense. If you are responsible for your account, proceed to step 4. 

 
Figure 331: Select Account - Create Out-of-Pocket 

1. Select the account search criteria from the list in the Select Account section and further refine your search by 
specifying criteria in the associated field. See the quick reference guide, "Searching without the wildcard 
character" for examples of these searches. 

• If you select Account Number or Name on Account from the search list, all accounts that match your 
criteria will be returned. 

• If you select Unit Name or Unit Number from the search list, all your accounts within the specified unit 
will be returned. You must have access to the unit before the unit search works. 
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2. Select one or more account types. If you select Inactive within 45 days and Inactive longer than 45 days, 
the search results will include all inactive accounts. 

3.  Click Search. All accounts that meet your criteria are listed in the Search Results section. Select an account 
and click Next to display the Create Out-of-Pocket Transactions page. 

4.  Your account is listed. Click Next to display the Create Out-of-Pocket Transactions page. 
5. Click Save and Return. The Create Out-of-Pocket page re-displays and the selected account displays in the 

Account field. 

 
Figure 332: Create Out-of-Pocket Transaction 

Any additional out-of-pocket transactions you attach are created on this page. 
1. Select one of the three out-of-pocket expense types from the Type list. 

• Lodging, Transportation and Other 
• Meals 
• Personal Mileage 

2. Specify the number of each expense type required in the Number of Transactions field. 
3. Click Add. The number of fields specified are added.. 

You now add out-of-pocket information for each expense type you created: 

Important: If you expand an out-of-pocket section but do not specify any data, click the Remove icon (  ) to 
remove the section line. Any blank out-of-pocket section lines will generate an error if you try to attach them to the 
expense report. 
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To create a Lodging, Transportation, and Other Out-of-Pocket transaction 
Lodging, Transportation, and Other section 

 
Figure 333: Lodging, Transportation, and Other 

1. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
2. Specify a description in the Description field, if required. 
3. Select an expense type from the Expense Type list. 
4. Specify the transaction amount in the Amount field. This is a number only field. Do not type a currency 

symbol. 
5. Specify the Merchant Name, City, State/Province, and Country in the appropriate fields. 
6. Click Add to add another out-of-pocket type or click Create and all out-of-pocket transactions are added to 

the account. Out-of-Pocket transactions are denoted by the out-of-pocket icon ( ).  
 

To create a Meal Out-of-Pocket transaction 

 

Figure 334: Meals 
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1. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
2. Specify a description in the Description field, if required. 
3. Select a meal type from the Meal Type list. 
4. Specify the Attendees and Purpose in the appropriate fields. 

 

To create a Personal Mileage Out-of-Pocket transaction 
Complete the following to enter a transportation expense type out-of-pocket transaction: 
Personal Mileage 

 
Figure 335: Personal Mileage 

1. Specify a date in the Transaction Date field. You can use the calendar control (  ) to select a date. 
2. Specify a description in the Description field, if required. 
3. Specify the distance traveled in the Distance field. This is a number only field. 
4. Select a distance rate from the Rate list. This rate is applied to the distance traveled. 
5. Click Add to add another out-of-pocket type or click Create and all out-of-pocket transactions are added to 

the account. Out-of-Pocket transactions are denoted by the out-of-pocket icon ( ).  
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Understanding the Hierarchy 
Organizational units are arranged in a hierarchy, or tree structure, that includes the bank, organizations associated 
with the bank, and departments and sub-departments within each organization. Each organizational unit is a single 
node on the hierarchy, and may have parent and child nodes above and below it. The bank administrator and the 
organization administrator work with the card processor to define and create the hierarchy. 
Card accounts, account holders, and administrators are not included in the hierarchy. However, each individual card 
account is associated with a unit on the hierarchy. An account holder, in turn, is associated with one or more individual 
accounts, and can view statements for the account and make payments on the account. An administrator is 
associated with a unit on the hierarchy, and has administrative access to that unit and lower units. The administrator 
may or may not also be an account holder. 
 

Sample hierarchy 
The following is a small cross section of a sample hierarchy, showing one organization with its units, along with 
associated cards and administrators. Refer this sample hierarchy as you read more about what the hierarchy does in 
Online Card Management. 

Bank level ABC Bank of Colorado (01234) 

 Bank administrator: Robert LeRoi 

Organization level  Rocky Mountain Technology, Inc. (00101) 
  Administrator: Sally Admin 

Level 1   Customer Support (1122334) 

   Manager: Sue Cardinal 

   Associated cards: 

    Travel Acct #1234-5678. Acct holder: Sara Secretary 

    Office Expense Acct #4321-2222. Acct holder: Sara 
Secretary 

Level 2    Software Products Support (2233445) 

    Manager: Nick Carraway 

    Associated cards: 

     Joe Support Acct #1234-5678 

     Tina Twaddle Acct #9876-5432 

Level 2    Hardware Products Support (2445566) 

    Associated cards: 
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     Wilmot Proviso Acct #0098-9987 

     Heilige Dankgesang Acct #2222-3333 

Level 1   Development (1234321) 

Level 2    Systems Engineering (2345654) 

Level 2    Technical Communication (2987654) 

Level 1   Human Resources (1357924) 

 
 

Using the Online Card Management hierarchy 
The hierarchy is a tree-structure representation of the bank, the organizations serviced by the bank, and each 
organization's arrangement of regional and departmental units and subunits. The bank is the top-level node on the 
hierarchy. A bank can have one or more organizations attached to it. In turn, each organization can have zero or more 
regional or departmental units attached to it, and subunits below those. 
In the example (see topic on page 343), ABC Bank of Colorado supplies commercial card services to Rocky Mountain 
Technology, among others. That company, in turn, is divided for card administration and reporting purposes into three 
departments (Level 1 nodes), two of which include child nodes (Level 2 node). A hierarchy can include any number of 
organizations, and up to eight node levels below an organization. Conversely, an organization is not required to 
include any lower-level nodes if they are not needed. 
Each node in the example hierarchy also shows the Processor Key (known as a "ProcKey") associated with the node. 
The bank and organization ProcKeys are five-digit numbers. Node levels 1–8 ProcKeys are seven-digit numbers, 
beginning with 1–8 to identify the level. 
The processor or bank can assign ProcKey numbers, or the organization administrator can assign them in accordance 
with organization standards. 
Administrators and Managers: The hierarchy example also shows administrators and managers associated with 
units. The organization administrator Sally Admin has access to administrative tasks and reports for the Rocky 
Mountain Technology organization and all lower-level units, including Customer Support, Development, HR, and 
subunits. Her authority "cascades" down the hierarchy to lower nodes. Any unit in the hierarchy may have an 
administrator, whose authority cascades from that level down the hierarchy. Administrators and managers are created 
and assigned permissions by higher-level administrators. 
Card Accounts: Each card account for the organization is associated with a unit on the hierarchy. This allows 
accurate departmental and organizational transaction reporting. In turn, an account holder is assigned to one or more 
accounts, and can view statements and make payments on each assigned account. For example, in the sample 
hierarchy shown above, for the Rocky Mountain Technology company, Sara Secretary is assigned to two accounts in 
the Customer Support department: the Travel account and the Office Expense account. Similarly, Joe Support is 
assigned to one account, named the Joe Support account. 
Account Holders: Account holders are either created by administrators, and are assigned access to one or more 
card accounts or they are created by the users themselves as they self-register as an account holder. For information 
about creating account holders, see "Creating a user (on page 135). For information about self-registering see 
"Logging On and Self-Registering (see topic on page 17). 
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Setting up the hierarchy: A hierarchy is designed to serve the administrative and reporting needs of the 
organization. Typically, the organization administrator (such as Sally Admin in the sample hierarchy) works with the 
bank administrator to define the hierarchy for the organization. In turn, the bank administrator works with the card 
processor to implement the organization's hierarchy design. 
 

Understanding hierarchy terminology 
As you work with the hierarchy, it is important that you understand some basic concepts that are important to the way 
the hierarchy works in Online Card Management. Familiarize yourself with the following terms: 

Unit 
A single point on the hierarchy. A unit can be a bank, an organization, department, or account holders. In the sample 
hierarchy, all the levels and the associated cards represent a unit on the hierarchy. Hierarchy units are also referred to 
as 'nodes' because the units are graphically represented as nodes on the hierarchy tree. 

Parent 
A unit with sub-units assigned to positions below it on the hierarchy. A parent unit has permission to view the "child" 
units below it. In the sample hierarchy, the Level 1 units are the parents of the Level 2 units, which are the parents of 
the cardholders below it. 

Child 
Any node on the hierarchy that is assigned below a higher node. For security reasons, child nodes do not have 
permission to view information for their parent nodes or the parallel nodes. Almost all nodes are a child of another 
node in the hierarchy. In the sample hierarchy, the Level 1 and Level 2 nodes are Child nodes of the Organization 
level node. 
Note: Most units are both a Child and a Parent. The units at the lowest level of the hierarchy are Child-only units and 
the unit at the top of the hierarchy (the bank) is a Parent-only unit. 

Parallel 
A term that describes units or nodes that are on the same level of the hierarchy. For security reasons, parallel units do 
not have permission to view data for each other. For example, the Level 2 nodes are parallel to each other in the 
sample hierarchy. 

Cascade 
The property that grants Parent nodes the authority to view data and work with cards assigned to the Child nodes 
below it. This authority continues so that Parent nodes can view the Child nodes at any level below the Parent's level 
in the hierarchy. For example, in the sample hierarchy the Organization level has the authority to see Level 1 and 
Level 2 and the cards assigned to the nodes below Level 2. The authority does not cascade up the hierarchy. In the 
sample hierarchy, the Organization level node can not view data for the Bank level node. 

ProcKey 
A term that is short for and interchangeable with Processor Key. The ProcKey is a number assigned to hierarchy 
nodes. Bank and organization level nodes have five-digit ProcKey numbers. Node levels 1–8 ProcKeys are seven-
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digit numbers, beginning with 1–8 to identify the level. The processor or bank can assign ProcKey numbers, or the 
organization administrator can assign them according to organization standards. 
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